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Audience for This Guide

Welcome to Release 11i of the Oracle XML Gateway User’s Guide.

This guide assumes the following:

• You understand the principles of XML messaging and XML
standards

• You know how to read a Document Type Definition (DTD)

• You are familiar with the Oracle Applications graphical user
interface.

To learn more about the Oracle Applications graphical user
interface, read the Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle
Applications product information.

How To Use This Guide

This guide contains the information you need to understand and use
Oracle XML Gateway.

• Chapter 1, ”Oracle XML Gateway Overview,” describes the XML
Gateway features and architecture and provides an introduction
to each of the components: Message Designer, XML Gateway
Setup, and Execution Engine.

• Chapter 2, ”Map Analysis Guidelines,” gives step–by–step
instructions for performing a map analysis.

• Chapter 3, ”Message Designer,”describes how to use the
Message Designer to create XML message maps.

• Chapter 4, ”XML Gateway Setup,” describes the steps required
to set up the XML Gateway.

• Chapter 5, ”Execution Engine,” describes the XML Gateway
envelope and trading partner validation for inbound and
outbound messages.

• Chapter 6, ”Message Queues,” describes the queues used by the
XML Gateway.

• Chapter 7, ”Integration with Oracle Workflow Business Event
System,” describes how XML Gateway integrates with Workflow
BES.
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• Appendix A, ”XML Gateway Seeded Code Categories,” lists the
code categories seeded in XML Gateway.

• Appendix B, ”XML Gateway Supported Actions,” lists the
actions that can be defined as part of the element mapping
process.

• Appendix C, ”XML Gateway Naming Conventions Summary,”
lists references to all of the naming conventions recommended
throughout the guide.

• Appendix D, ”Oracle Transport Agent,” describes the Oracle
Transport Agent.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting
documentation accessible, with good usability, to the disabled
community. To that end, our documentation includes features that
make information available to users of assistive technology. This
documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with
other market–leading technology vendors to address technical
obstacles so that our documentation can be accessible to all of our
customers. For additional information, visit the Oracle Accessibility
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

JAWS, a Windows screen reader, may not always correctly read the
code examples in this document. The conventions for writing code
require that closing braces should appear on an otherwise empty line;
however, JAWS may not always read a line of text that consists solely
of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies
or organizations that Oracle Corporation does not own or control.
Oracle Corporation neither evaluates nor makes any representations
regarding the accessibility of these Web sites.
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Other Information Sources

You can choose from many sources of information, including online
documentation, training, and support services, to increase your
knowledge and understanding of Oracle XML Gateway.

If this guide refers you to other Oracle Applications documentation,
use only the Release 11i versions of those guides.

Online Documentation

All Oracle Applications documentation is available online (HTML or
PDF).

• Online Help – The new features section in the HTML help
describes new features in 11i. This information is updated for
each new release of Oracle XML Gateway. The new features
section also includes information about any features that were
not yet available when this guide was printed. For example, if
your administrator has installed software from a mini–pack or
an upgrade, this document describes the new features. Online
help patches are available on MetaLink.

• 11i Features Matrix – This document lists new features available
by patch and identifies any associated new documentation. The
new features matrix document is available on MetaLink.

• Readme File – Refer to the readme file for patches that you have
installed to learn about new documentation or documentation
patches that you can download.

Related User’s Guides

Oracle XML Gateway shares business and setup information with other
Oracle Applications products. Therefore, you may want to refer to
other user’s guides when you set up and use XML Gateway.

You can read the guides online by choosing Library from the
expandable menu on your HTML help window, by reading from the
Oracle Applications Document Library CD included in your media
pack, or by using a Web browser with a URL that your system
administrator provides.

If you require printed guides, you can purchase them from the Oracle
Store at http://oraclestore.oracle.com.
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Guides Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate
using the graphical user interface (GUI) available with this release of
Oracle XML Gateway (and any other Oracle Applications products).
This guide also includes information on setting user profiles, as well as
running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing ”Getting Started
with Oracle Applications” from any Oracle Applications help file.

User Guides Related to This Product

Oracle Workflow Guide

This guide explains how to define new workflow business processes as
well as customize existing Oracle Applications–embedded workflow
processes.You also use this guide to complete the setup steps necessary
for any Oracle Applications product that includes workflow–enabled
processes.

Installation and System Administration

Oracle Applications Concepts

This guide provides an introduction to the concepts, features,
technology stack, architecture, and terminology for Oracle Applications
Release 11i. It provides a useful first book to read before an installation
of Oracle Applications. This guide also introduces the concepts behind
Applications–wide features such as Business Intelligence (BIS),
languages and character sets, and Self–Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 11i, much of the installation process
is handled using Oracle Rapid Install, which minimizes the time to
install Oracle Applications, the Oracle8 technology stack, and the
Oracle8i Server technology stack by automating many of the required
steps. This guide contains instructions for using Oracle Rapid Install
and lists the tasks you need to perform to finish your installation. You
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should use this guide in conjunction with individual product user’s
guides and implementation guides.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications
Release 10.7 or Release 11.0 products to Release 11i. This guide
describes the upgrade process and lists database and product–specific
upgrade tasks. You must be either at Release 10.7

(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to
Release 11i. You cannot upgrade to Release 11i directly from releases
prior to 10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as
AutoUpgrade, AutoPatch, AD Administration, AD Controller, AD
Relink, License Manager, and others. It contains how–to steps,
screenshots, and other information that you need to run the AD
utilities. This guide also provides information on maintaining the
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle
Applications System Administrator. It contains information on how to
define security, customize menus and online help, and manage
concurrent processing.

Oracle Alert User’s Guide

This guide explains how to define periodic and event alerts to monitor
the status of your Oracle Applications data.

Other Implementation Documentation

Oracle Applications Product Update Notes

Use this guide as a reference for upgrading an installation of Oracle
Applications. It provides a history of the changes to individual Oracle
Applications products between Release 11.0 and Release 11i. It includes
new features, enhancements, and changes made to database objects,
profile options, and seed data for this interval.
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Multiple Reporting Currencies in Oracle Applications

If you use the Multiple Reporting Currencies feature to record
transactions in more than one currency, use this manual before
implementing XML Gateway. This manual details additional steps and
setup considerations for implementing XML Gateway with this feature.

Multiple Organizations in Oracle Applications

This guide describes how to set up and use XML Gateway with Oracle
Applications’ Multiple Organization support feature, so you can define
and support different organization structures when running a single
installation of XML Gateway.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference
information for the XML Gateway implementation team, as well as for
users responsible for the ongoing maintenance of Oracle Applications
product data. This manual also provides information on creating
custom reports on flexfields data.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams
and a detailed description of database tables, forms, reports, and
programs for a specific Oracle Applications product. This information
helps you convert data from your existing applications, integrate
Oracle Applications data with non–Oracle applications, and write
custom reports for Oracle Applications products. Oracle eTRM is
available on Metalink.

Oracle Manufacturing APIs and Open Interfaces Manual

This manual contains up–to–date information about integrating with
other Oracle Manufacturing applications and with your other systems.
This documentation includes API’s and open interfaces found in Oracle
Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual

This manual contains up–to–date information about integrating with
other Oracle Manufacturing applications and with your other systems.
This documentation includes API’s and open interfaces found in Oracle
Order Management Suite.
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Oracle Applications Message Reference Manual

This manual describes all Oracle Applications messages. This manual is
available in HTML format on the documentation CD–ROM for Release
11i.

Training and Support

Training

Oracle offers a complete set of training courses to help you and your
staff master Oracle XML Gateway and reach full productivity quickly.
These courses are organized into functional learning paths, so you take
only those courses appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses
offered by Oracle University at any one of our many Education
Centers, you can arrange for our trainers to teach at your facility, or
you can use Oracle Learning Network (OLN), Oracle University’s
online education utility. In addition, Oracle training professionals can
tailor standard courses or develop custom courses to meet your needs.
For example, you may want to use your organization structure,
terminology, and data as examples in a customized training session
delivered at your own facility.

Support

From on–site support to central support, our team of experienced
professionals provides the help and information you need to keep
Oracle XML Gateway working for you. This team includes your
Technical Representative and Account Manager, and Oracle’s large staff
of consultants and support specialists with expertise in your business
area, managing an Oracle8i server, and your hardware and software
environment.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus,
Oracle Data Browser, database triggers, or any other tool to modify
Oracle Applications data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change,
retrieve, and maintain information in an Oracle database. But if you use
Oracle tools such as SQL*Plus to modify Oracle Applications data, you



 xviiPreface

risk destroying the integrity of your data and you lose the ability to
audit changes to your data.

Because Oracle Applications tables are interrelated, any change you
make using Oracle Applications can update many tables at once. But
when you modify Oracle Applications data using anything other than
Oracle Applications, you may change a row in one table without
making corresponding changes in related tables. If your tables get out
of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle
Applications.

When you use Oracle Applications to modify your data, Oracle
Applications automatically checks that your changes are valid. Oracle
Applications also keeps track of who changes information. If you enter
information into database tables using database tools, you may store
invalid information. You also lose the ability to track who has changed
your information because SQL*Plus and other database tools do not
keep a record of changes.

About Oracle

Oracle Corporation develops and markets an integrated line of
software products for database management, applications
development, decision support, and office automation, as well as
Oracle Applications, an integrated suite of more than 160 software
modules for financial management, supply chain management,
manufacturing, project systems, human resources and customer
relationship management.

Oracle products are available for mainframes, minicomputers, personal
computers, network computers and personal digital assistants,
allowing organizations to integrate different computers, different
operating systems, different networks, and even different database
management systems, into a single, unified computing and information
resource.

Oracle is the world’s leading supplier of software for information
management, and the world’s second largest software company. Oracle
offers its database, tools, and applications products, along with related
consulting, education, and support services, in over 145 countries
around the world.
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Your Feedback

Thank you for using Oracle XML Gateway and this user’s guide.

Oracle values your comments and feedback. At the end of this guide is
a Reader’s Comment Form you can use to explain what you like or
dislike about Oracle XML Gateway or this user’s guide. Mail your
comments to the following address or call us directly at (650) 506–7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc_us@oracle.com.
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Oracle XML Gateway
Overview

his chapter introduces the Oracle XML Gateway.  Specifically, this
chapter describes the

• Oracle XML Gateway features

• Oracle XML Gateway Architecture

• Oracle XML Gateway components: Message Designer, XML
Gateway Setup, and Execution Engine
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Overview of XML Gateway

XML Standards

Many standards bodies (for example, OAG, Rosettanet, SOAP, and iFX)
exist with published Document Type Definitions.  Some standards are
strong at managing the message content while others excel at managing
both the message content and its related processes.

As a provider of broad–based business application solutions to support
all industries, Oracle XML Gateway supports all DTD based XML
standards.  The majority of messages delivered with the Oracle
E–Business Suite are mapped using the Open Application Group
(OAG) standard.  Any prebuilt message can be remapped to any
standard of choice using the XML Gateway Message Designer.

XML Gateway Introduction

Oracle XML Gateway is a set of services that allows easy integration
with the Oracle E–Business Suite to support XML messaging.

The Oracle E–Business Suite utilizes the Oracle Workflow Business
Event System to support event–based XML message creation and
consumption.

Oracle XML Gateway consumes events raised by the Oracle E–Business
Suite and subscribes to inbound events for processing.  Oracle XML
Gateway uses the message propagation feature of Oracle Advanced
Queuing to integrate with the Oracle Transport Agent to deliver
messages to and receive messages from business partners.

Oracle XML Gateway supports both Business–to–Business (B2B) and
Application–to–Application (A2A) initiatives.  B2B initiatives include
communicating business documents and participating in industry
exchanges.  An example of an A2A initiative is data integration with
legacy and disparate systems.

With Oracle XML Gateway services, you are assured consistent XML
message implementation when integrating with the Oracle E–Business
Suite, thereby lowering integration costs and expediting message
implementation while supporting corporate e–business initiatives.
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XML Gateway Features

The Oracle XML Gateway offers the following features and
integrations:

• Message Designer

Use this wizard–guided tool to define message maps containing
the RDBMS–to–XML or XML–to–XML data transformations.

• Robust Execution Engine

The execution engine integrates with the Oracle Workflow
Business Event System for event–based message creation and
consumption.

• Flexible Trading Partner Directory Service

Use this service to define a hub, all trading partners exchanging
on a hub, or a specific business partner.  The definition includes
information on enabled messages, confirmation requests, and
message maps and message transport protocols.

• Flexible message setup

Flexible conversion of Oracle codes to recipient or
standards–based codes, including a cross–reference between the
Oracle internal and external transaction names.

• Integration with Oracle Workflow Error Handling

Oracle Workflow error handling process provides active error
notification to the XML Gateway system administrator or
Trading Partner contact with support for ”retry” and ”reprocess”
for failed processes.

• Integration with Oracle Advanced Queuing

Oracle AQ provides persistent storage and message propagation.

• Utilizes Servlet–Based Transport Agent

The servlet–based Transport Agent delivers and receives XML
messages using SMTP, HTTP, or HTTPS protocols.
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XML Gateway Architecture

XML Gateway Architecture Overview Diagram

The services supported by Oracle XML Gateway are grouped into four
functional areas as follows:

• Message Designer

• XML Gateway Setup

• Execution Engine

• Transport Agent
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XML Gateway Architecture Detail Diagram

Message Designer

The XML Gateway Message Designer is a wizard–guided,
repository–based tool used to define message maps.  A message map
represents the relationship between the source and target data
elements.

Use the XML Gateway Message Designer to perform the following
functions:

Define Data Source and Data Target

Each message map consists of a data source and data target
representing where the data is coming from and where it is mapped to.
The XML Gateway Message Designer supports the following
combinations of source and target data definitions:

• Source RDBMS to Target XML
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• Source XML to Target RDBMS

• Source XML to Target XML

RDBMS–based data definitions can be based on database tables,
database views, Application Open Interface tables, or Application
APIs.

XML–based data definitions can be based on an XML Document Type
Definition or a production XML message.  Using a production XML
message as a data source or data target is the recommended choice if
you are migrating from an existing implementation or legacy system
(where XML messaging is supported) to the Oracle E–Business Suite.

Map Source Data Structure to Target Data Structure

Once the data source and data target are defined, use the Message
Designer to relate the source data structure to the target data structure.

This process is especially important if the data structure of the business
document is different from the data structure of the application data
model.  For example, if an inbound business document is represented
in three levels but the application data model is represented in two
levels, the data in the business document must be collapsed to
accommodate the application data model.  The incoming data is
expanded if the opposite case occurs in which the inbound business
document is represented in two levels but the application data model is
represented in three levels.

The XML Gateway Message Designer supports both expanding and
collapsing hierarchies to ensure that data can be retrieved from or
populated into the Oracle E–Business Suite data model.

Map Source Data Element to Target Data Element

Once the data source, data target, and source–to–target hierarchy are
defined, use the Message Designer to map the source data elements to
the target data elements.

The Message Designer user interface displays the data source and the
data target in adjacent windows.  A simple drag and drop between the
source and target data elements creates a map relationship.  The source
data element name is noted next to the target data element name to
identify the map relationship.
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Identify Data Transformation and Process Control Functions

As part of the element mapping process, use the Message Designer to
identify data transformation and process control functions.  These
functions can be defined at the source or target as follows:

• To be applied at the data element, document, or root level

• To be applied before, during, or after the message is created or
consumed

The function may be qualified by a condition.  If no condition is
defined, the function will always be applied.  See Appendix B for a list
of the functions supported by the XML Gateway.

The common data transformation functions involve math functions and
string manipulation in addition to conversions between the Oracle and
OAG formats representing date, operating amount, quantity, and
amount values.

The common process control functions involve calling procedures or
database functions to extend the integration with the Oracle E–Business
Suite.  Other common process control functions allow you to inquire on
the status of a transaction and manage the process flow based on the
status.  For serious errors, the process may be aborted with error
notifications sent to the XML Gateway system administrator or Trading
Partner contact.

Once the message map is created, it is loaded along with its associated
DTDs into the XML Gateway repository for use by the Execution
Engine to create outbound or to consume inbound XML messages.

XML Gateway Setup

To implement a message with a trading partner, use the XML Gateway
setup features to define the Trading Partner or hub, code conversion
values, and internal–to–external transaction name cross–references.  In
addition, you can identify the XML Gateway system administrator to
notify for system or process errors.

Define Trading Partner or Hub

E–Business may be conducted directly with a business partner,
commonly known as a trading partner, or via a hub, such as Oracle
Exchange, where many buyers and sellers converge to conduct
electronic commerce.
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With Oracle XML Gateway, you can define the hub or the individual
business partner as a trading partner.  If you define the hub as the
trading partner, you can identify all the buyers and sellers who are
conducting business on the hub as Trading Partners to the hub.

Included in the Trading Partner or hub definition are the following:

• Define Trading Partner or Hub name

• Enable XML messages for the partner

• Enable request for message confirmation

• Define the message map to use for message creation or
consumption

• Define the e–mail address of the trading partner contact to notify
for data errors

• Define trading partner–specific code conversion values

• Define transport protocol: SMTP, HTTP, HTTPS with credential
and username and password as necessary

Define Code Conversion

With Oracle XML Gateway, you can cross–reference Oracle codes to
codes that are meaningful to your recipient.  Conversely, you can
cross–reference codes you receive from your partner to codes that are
meaningful to your Oracle Application.  Common examples of Oracle
E–Business Suite codes requiring code conversion are units of measure
and currency code.

Code conversion values can be defined to be applied universally for all
Trading Partners and all messages.  Additionally, code conversion
values can be defined for a specific XML standard or specific to a
Trading Partner.

Define Transaction

Use Oracle XML Gateway to define a cross–reference between the
Oracle transaction name and the external transaction name.  The
external transaction name will be based on what is meaningful per the
XML standard used by the recipient.  The external transaction name
will appear on the message envelope to support message transport.
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Execution Engine

The XML Gateway Execution Engine is responsible for interacting with
several Oracle technologies to process and transport XML messages to
and from Trading Partners for B2B integration, or other information
systems both within and outside the enterprise for A2A integration.

The Oracle technologies involved include the following:

• Oracle Workflow Business Event System

• Oracle E–Business Suite

• Oracle Advanced Queuing

• Oracle Workflow

Oracle Workflow Business Event System

Oracle XML Gateway leverages the Oracle Workflow Business Event
System to publish and subscribe to application business events of
interest to automatically trigger message creation or consumption.

Business events and event subscriptions to send outbound messages or
to consume inbound messages are delivered for all Oracle prebuilt
messages.  The seeded event subscriptions can be configured during
implementation to perform activities to address specific business
requirements.

Oracle E–Business Suite

The XML Gateway Execution Engine interfaces with the Oracle
E–Business Suite via business events and event subscriptions to
retrieve data from or populate data into the Oracle e–Business Suite
tables.

Oracle Advanced Queuing

The XML Gateway Execution Engine interfaces with Oracle Advanced
Queuing to stage outbound XML messages or receive inbound XML
messages for processing.

Oracle Workflow

The XML Gateway Execution Engine interfaces with Oracle Workflow
to actively notify the XML Gateway system administrator regarding
system or process errors, or the Trading Partner contact for data errors.
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The XML Gateway system administrator has the option to ”retry”
failed outbound processes, or ”reprocess” failed inbound processes.

Internal to the XML Gateway Execution Engine are the following functions:

Validate Trading Partner or Hub

Verify that the Trading Partner is defined and the required document is
enabled.

Retrieve Message Map from Repository

Retrieve the message map associated with the Trading Partner and
required document.

Retrieve and Populate Data to and from the Oracle E–Business Suite

For outbound messages, gather the application data from the Oracle
E–Business Suite using the information on the message map.

For inbound messages, process the data into the Oracle E–Business
Suite using the information on the message map.

Apply Data Transformations or Process Control Functions

Apply code conversions, data transformations, and process control
functions defined on the message map.

Validate Message Using the XML Parser

For outbound message, the XML Parser is used to validate the newly
created message to ensure that it is well–formed and valid.  Poorly
formed or invalid messages will not be enqueued for delivery.  An
error notification is sent to the XML Gateway system administrator.

Inbound messages dequeued from the inbound queue are validated
using the XML Parser to ensure that it is well–formed and valid.
Poorly formed or invalid messages will not be processed by the XML
Gateway Execution Engine.  An error notification is sent to the Trading
Partner contact.
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Enqueue and Dequeue XML Messages

Outbound messages are enqueued for delivery by the Transport Agent.
Inbound messages are dequeued for processing by the XML Gateway
Execution Engine.

Send and Receive Message Confirmations

An outbound confirmation is sent in response to an inbound request if
the outbound confirmation is enabled for the Trading Partner.

An inbound confirmation is received in response to an outbound
request if the inbound confirmation is enabled for the Trading Partner.

Direct Interaction with Execution Engine for A2A Integration

Seeded Workflow functions are provided for use in Workflow processes
to interact directly with the Execution Engine to generate outbound or
to consume inbound messages.

The outbound message generated by the XML Gateway Execution
Engine is made available to the downstream Workflow activity for
processing.  The Execution Engine consumes the inbound message
passed to it by a Workflow process.

The XML Gateway Execution Engine begins processing once it detects
the Workflow process to send or generate an XML message or that an
inbound message has arrived on the inbound queue.

Transport Agent

The Transport Agent interfaces with Oracle Advanced Queuing to
deliver outbound and to receive inbound messages.

The Transport Agent server is a Java–based servlet that uses the
Transport Agent Messaging Protocol to support the following:

• Guaranteed delivery, exactly once

• Message encryption

• Server–to–server certificate authentication

XML Messages and EDI Transactions

EDI transactions and XML messages are two forms of electronic
messaging based on their respective standards.  EDI transactions are
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more batch–oriented while their XML counterpart is event–based,
real–time, and tend to be based on a single transaction.

Oracle e–Commerce Gateway integrates with the Oracle E–Business
Suite to extract or to import traditional EDI transactions using a flat
ASCII file.  A third party EDI Translator is required to map the data
between the Oracle E–Business Suite and the EDI standard of choice
such as ASC X12 or EDIFACT.

Oracle XML Gateway  integrates with the Oracle E–Business Suite to
create or to consume XML messages based on application business
events.  Oracle XML Gateway creates and consumes
standards–compliant XML messages without the use of a translator.

Conclusion

Oracle XML Gateway is the XML message enabler for the Oracle
E–Business Suite.  It provides consistent XML message implementation
within and outside the enterprise in support of A2A and B2B
messaging initiatives.

Oracle XML Gateway leverages the publish and subscribe features of
the Oracle Workflow Business Event System to automate message
creation and consumption in addition to using Oracle Workflow to link
key business processes.  This combination enables seamless
collaboration, coordination, and communication of business–critical
data throughout the supply chain.



C H A P T E R

2
B

2 – 1Map Analysis Guidelines

Map Analysis
Guidelines

efore using the Message Designer to create a new message map,
you must first perform a map analysis.  This chapter describes how to
perform a map analysis through the following topics:

• Map Analysis Procedures for Outbound Messages

• Map Analysis Procedures for Inbound Messages

• Identifying Source and Target Document Levels
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Map Analysis Overview

A map analysis is required to determine how to map data between the
Oracle E–Business Suite data model and the required message.  For
outbound messages, this requires a comparison between the Oracle
E–Business Suite database views and the Document Type Definition
(DTD) or a production XML message.

The result of the map analysis is used as input to the XML Gateway
Message Designer.  It is imperative that a complete map analysis is
done before attempting to create the message map.  The map analysis
must resolve all data gaps, identify derivation rules, identify default
values, identity data transformation and process controls via Actions,
and ensure that all required target fields are mapped.
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Map Analysis Guidelines for Outbound Messages

The steps to performing a map analysis for an outbound message are as
follows:

• Compare database views (source) to DTD (target)

• Identify event trigger

• Add XML Gateway required Actions to define selection criteria

• Identify source and target document levels

Map Analysis Guidelines for Outbound Messages Checklist

Use the following checklist to track your progress when analyzing an
outbound message.  Details of each step are provided in the following
sections.  Use the ”Completed” column to check off the step as it is
completed.

Step Completed Description

1 CREATE WORKSHEET: Create a worksheet to identify all data.

2 SETUP SOURCE: Create database views or get database views/table defi-
nitions (source) for the required message from the database schema.

3 SET UP TARGET: Populate the target column of the worksheet with the
DTD or production XML message in the expanded format.

3A Identify the required DTD (target) elements.

3B For DTD elements with ”|” as the occurrence indicator, select one element
from the list.  Make a note of the elements not selected because these must
be removed from the message map to prevent a parser violation.

4 RELATE SOURCE ELEMENT TO TARGET ELEMENT: For each DTD
(target) element, identify the database view (source) column to map from.

4A Identify where code conversion is needed.

4B Identify Derivation Rules

4C Identify Defaulting Rules

4D Identify DTD Attribute Settings

Table 2 – 1  (Page 1 of 2) 
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DescriptionCompletedStep

5 CONVERT FROM ORACLE FORMAT TO OAG FORMAT: For each OAG
DTD (target) DATETIME, AMOUNT, OPERAMT, or QUANTITY element,
identify the database view/table (source) column to map from.  Other XML
standards may have similar elements.

5A Identify and map each DATETIME element.

5B Identify and map each AMOUNT element.

5C Identify and map each OPERAMT element.

5D Identify and map each QUANTITY element.

6 ADD SIBLING FOR DUPLICATE NODES/ELEMENTS: Add Sibling
nodes and elements if needed.

7 ADD CHILD TO EXTEND DTD DEFINITION FOR FLEXFIELDS: If there
is a database view or table column that you wish to map from but no DTD
element is defined to support it, you can use the OAG’s USERAREA.  Map
data to the USERAREA (or corresponding area if using other XML stan-
dards).

8 RESOLVE DATA GAPS:  Any DTD (target) elements that have not been
mapped are data gaps.

9 IDENTIFY APPLICATION EVENT TRIGGER: Identify the application
business events to trigger message creation.

10 IDENTIFY REQUIRED ACTIONS: All outbound messages require the
following Actions to define the selection criteria.  Make a notation on the
worksheet to include them.
Use the Append Where Clause action to bind transaction type and subtype
to ECX_OAG_CONTROLAREA_V

Use the Append Where Clause action to bind document ID to header view
to select the document

Use the Append Where Clause action to bind party site ID and party ID to
header view if party site ID and party ID are selection criteria

Use Assign Next Sequence Value action to assign ECX_REF-
ERENCE_ID.nextval to the REFERENCE_ID element of the CNTROLAREA
data type

11 IDENTIFY SOURCE AND TARGET DOCUMENT LEVELS

Table 2 – 1  (Page 2 of 2) 
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Compare Database Views (Source) to DTD (Target)

Step 1 Create a Worksheet

Create a worksheet with the following columns: Target, Required
(Y/N), Source, Code Category, Derivation Rule, Default Value, and
Action, as shown in the following table:

Target Required
(Y/N)

Source Code
Category

Derivation
Rule

Default
Value

Action

Step 2 Set Up Source

Create database views or get database view and table definitions
(source) for the required message from the database schema.  Include
ECX_OAG_CONTROLAREA_V view to map to the CNTROLAREA
segment of the DTD.

Step 3 Set Up Target

Populate the target column of the worksheet with the DTD or
production XML message in the expanded format.

Note:  You may use third party software to expand the DTD or
use a production XML message.

Step 3A Identify Required Target Elements

Identify the required DTD (target) elements.  An element is required if
there is no special symbol next to the element name.

The XML occurrence indicators are:

”+” implies one or more

”*” implies zero or more

”?” implies zero or 1

”|” implies either one or the other

”,” implies all listed child elements must be used in the order
shown
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Step 3B For Elements with ”|” as the occurrence indicator

For DTD elements with ”|” as the occurrence indicator, select one
element from the list.  Make a note of the elements not selected in order
to remove them from the message map.  They must be removed from
the message map to prevent a parser violation.

Step 4 Relate Source Element to Target Element

For each DTD (target) element, identify the database view (source)
column to map from.

Note:  Use the Open Application Group’s Integration Specification
(available at http://www.openapplications.org)
Appendix C, Field Identifier Descriptions and Appendix D,
Segment Descriptions, to get detailed descriptions of each
element identified on the DTD.

Step 4A

If the DTD (target) element can be sourced from a database view
(source) column, determine if the database view column value requires
code conversion.

• If code conversion is required, identify the code category from
the list in Appendix A.

• Identify the from or to value to determine if the required values
are available in the database.  If the values are not available, they
must be be added.

Step 4B Identify Derivation Rule

If the DTD (target) element cannot be sourced from a database view
(source) column, determine if the value can be derived.  If yes, identify
the derivation rule.  The derivation rule can be, for example, a
combination of several view columns, a procedure call, or a function
call.  Make a notation that an XML Gateway Action may be required
(for example, to get a value from another column, or to combine the
values of several columns).

Refer to Appendix B. for a list of XML Gateway supported Actions.

Determine if the derived value requires code conversion.  If code
conversion is required, identify the code category from the list in
Appendix A.
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Attention:  Identify the from or to value to determine if the
required values are available in the database.  If the values are
not available, they must be added.

Step 4C Identify Defaulting Rule

If the DTD (target) element cannot be sourced from a database view
(source) column or derived, determine if the value can be defaulted.  If
yes, identify the default value.  The default value can be a literal or
based on a value from another database view column.  Make a notation
that an XML Gateway Action may be required.

The default value can be set directly in the map using the Message
Designer or as an XML Gateway Action if the default value is based on
a condition.

Refer to Transaction Map – Actions: page 3 – 64 for a list of XML
Gateway supported Actions.

Determine if the default value requires code conversion.  If code
conversion is required, identify the code category from the list in
Appendix A.

Attention:  Identify the from or to value to determine if the
required values are available in the database.  If the values are
not available, they must to be added.

Step 4D Identify DTD Attribute Setting

For each DTD (target) element containing attributes (lower case tags),
determine the appropriate setting by checking the usage of the
database view or table column and then identifying a valid setting for
the attribute by reviewing the options in OAG’s Appendix D that lists
Segment Descriptions for the DTD element.  The appropriate attribute
setting is set directly in the target definition as a default value using the
Message Designer.

For example, if a view column is used for creation date, the DATETIME
”qualifier” attribute value of ”CREATION” will be set as the default
value using the Message Designer.

Step 5 Convert from Oracle Format to OAG Format

For each DTD (target) DATETIME, AMOUNT, OPERAMT, or
QUANTITY element, identify the database view or table (source)
column to map from.
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Oracle E–Business Suite represents date, amount, operating amount,
and quantity in a single database column.  OAG represents these as a
collection of data.  Oracle XML Gateway provides an Action to convert
the Oracle representation to the OAG representation.  Make a notation
that this column requires an Action for ”Convert to OAG” that will be
defined using the Message Designer.

Step 5A

• For the DATETIME element, identify the database view or table
(source) column for the date.

• Follow Step 4D to set the ”qualifier,” ”type,” and ”index”
attributes

• All other OAG fields are set by the ”Convert to OAG” Action
based on the date value.

• TIMEZONE is defaulted to PST represented as –7 or –8 from
Greenwich Mean Time (GMT).

Note:  OAG DATETIME is made up of the following attributes
and elements: qualifier, type, index, YEAR, MONTH, DAY,
HOUR, MINUTE, SECOND, SUBSECOND, TIMEZONE.

Step 5B

• For the AMOUNT element, identify database view or table
(source) columns for currency code and debit/credit flag if
available.  The XML Gateway ”Convert to OAG” Action can be
defined to use the view or table column values or default to
OAG recommended values if the view or table columns are not
available.

• Follow Step 4D to set the ”qualifier,” ”type,” and ”index”
attributes.

• The OAG fields for NUMOFDEC and SIGN are set by the
”Convert to OAG” Action based on the amount value.

Note:  OAG AMOUNT is made up of the following attributes
and elements: qualifier, type, index, VALUE, NUMOFDEC,
SIGN, CURRENCY, DRCR.

Step 5C

• For the OPERAMT fields, identify database view or table
(source) columns for currency and unit of measure code if
available.  The XML Gateway ”Convert to OAG” Action can be
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defined to use the view or table column values or default to
OAG recommended values if the view or table columns are not
available.

• Follow Step 4D to set the ”qualifier” and ”type” attributes.

• The OAG fields for NUMOFDEC, SIGN, UOMVALUE, and
UOMNUMDEC are set by the ”Convert to OAG” Action based
on the operating amount value.

Note:  OAG OPERAMT is made up of the following attributes
and elements: qualifier, type, VALUE, NUMOFDEC, SIGN,
CURRENCY, UOMVALUE, UOMNUMDEC, UOM.

Step 5D

For the QUANTITY element, identify database view or table (source)
column for the unit of measure code if available. The XML Gateway
”Convert to OAG” Action can be defined to use the view or table
column value or default to the OAG recommended value if the view or
table column is not available.

Follow Step 4D to set the ”qualifier” attribute.

The OAG fields for NUMOFDEC and SIGN are set by the ”Convert to
OAG” Action based on the quantity value.

Note:  OAG QUANTITY is made up of the following attributes
and elements: qualifier, VALUE, NUMOFDEC, SIGN, UOM.

Step 6 Add Sibling for Duplicate Nodes/Elements

A DTD defines a single occurrence of a node or element.  If you have
multiple occurrences from the database view or table (source) to map
from, make a notation on your worksheet showing the duplicate node
or element and then map the element and attributes of the duplicate
node or element.  Make a notation to ADD SIBLING using the Message
Designer.

An example is the DTD element for PARTNER used to map SHIP–TO,
BILL–TO, and REMIT–TO from the Oracle E–Business Suite.  You will
need to add two PARTNER sibling nodes (same hierarchy level) to map
BILL–TO and REMIT–TO.

Step 7  Add Child to Extend DTD Definition for Flexfields

If there is a database view or table column you wish to map from but
no DTD element is defined to support it, you can use the USERAREA.
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You can add a USERAREA as a sibling (same hierarchy level) of
another USERAREA or extend an existing USERAREA by adding a
child (next level of hierarchy) element and then mapping the element.
Make a notation to ADD CHILD using the Message Designer.

This approach is necessary to support all the flexfields included in the
database views and tables.  Since we do not know which flexfields are
implemented at a user’s site, all flexfields must be mapped.

Refer to How to Extend DTDs: page 3 – 109 for details.

Note:  The only updates allowed for a DTD are to the
USERAREA.  Any other changes will invalidate the DTD.

Step 8  Resolve Data Gaps

At this point, you have identified database view and table (source)
columns for as many DTD (target) elements as possible.  Any required
DTD (target) element that has not been mapped represents a data gap.

Consider resolving the data gap using an application flexfield that is
included in the database view or table.  If this is a valid option, you
must implement the designated flexfield by defining and populating it
in the Oracle E–Business Suite.  Consider carefully which flexfield to
implement as you do not want to overwrite a flexfield implemented by
the user.

Consider resolving the data gap using an application column not
included in the database view.  If this is a valid option, you must
modify the database view to include the application column as
opposed to referencing the table and column directly.  Load the
modified database view into the database schema.  Remember to map
the field.

If neither of the above considerations resolves the data gap, then you
must add functionality to your application module, create new
database views, load the new views into the database schema, and then
create the message map.

Step 9  Identify Application Event Trigger

Identify the application business events to trigger message creation.
The common trigger points are when the document is created,
updated, or deleted.

Use the Oracle Workflow Business Event System to publish the
business event to automatically trigger message creation once the event



2 – 11Map Analysis Guidelines

is detected.  Use the Concurrent Request within XML Gateway to
manually trigger message creation during the unit test phase.

See: Integrating Oracle XML Gateway with Oracle Workflow Business
Event System: page 7 – 2 for details on how to publish and subscribe to
application business events.

Step 10  Identify Required Actions

All outbound messages require the following Actions to define the
selection criteria.  Make a notation on your worksheet to include them.

• Use the Append Where Clause action to bind transaction type
and subtype to ECX_OAG_CONTROLAREA_V

• Use the Append Where Clause action to bind document ID to
the header view to select the document

• Use the Append Where Clause action to bind party site ID and
Party ID to the header view if party site ID and party ID are
selection criteria

• Use the Assign Next Sequence Value action to assign
ECX_REFERENCE_ID.nextval to the REFERENCE_ID element
of the CNTROLAREA data type

Step 11  Identify Source and Target Document Levels

See: Identifying Source and Target Document Levels: page 2 – 21.
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Map Analysis Guidelines for Inbound Messages

The map analysis process for inbound messages consists of the
following steps:

• Compare DTD (source) to Application Open Interface tables
(target)

• Add XML Gateway required Actions

• Identify source and target document levels

Map Analysis Guidelines for Inbound Messages Checklist

Use the following checklist to track your progress when analyzing an
inbound message.  Details of each step are provided in the following
sections.  Use the ”Completed” column to enter completion data or to
check off the step when completed.

Step Completed Description

1 CREATE WORKSHEET: Create a worksheet to identify all data.

2 SET UP SOURCE: Get the DTD (source) for the required message or use a
production XML message.

3 SET UP TARGET: Populate the target column of the worksheet with the
Application Open Interface table definitions or Application API parameter
list.

3A Identify the required Application Open Interface (target) table columns or
Application API parameters.

4 RELATE SOURCE ELEMENT TO TARGET ELEMENT: For each Applica-
tion Open Interface (target) table column, identify the DTD (source) ele-
ment to map from.

4A Identify where code conversion is needed.

4B Identify Derivation Rules

4C Identify Defaulting Rules

5 CONVERT FROM OAG FORMAT TO ORACLE FORMAT: For each OAG
DTD (source) DATETIME, AMOUNT, OPERAMT, or QUANTITY element,
identify the Application Open Interface (target) column or Application API
parameter to map to.  Other XML standards may have similar elements.

5A Identify and map each DATETIME element.

Table 2 – 2  (Page 1 of 2) 



2 – 13Map Analysis Guidelines

DescriptionCompletedStep

5B Identify and map each AMOUNT element.

5C Identify and map each OPERAMT element.

5D Identify and map each QUANTITY element.

6 ADD SIBLING FOR DUPLICATE NODES/ELEMENTS: Add Siblings
nodes/elements if needed.

7 REVIEW DTD USERAREA: Review all OAG’s USERAREA definitions
and determine whether they should be mapped to the Application Open
Interface table column or Application API parameter.  Other XML stan-
dards may have similar elements.

8 RESOLVE DATA GAPS: The DTD (source) elements for as many Applica-
tion Open Interface (target) table columns or Application API parameters
have been identified, and identify any data gaps.

9 OPTIONAL Actions: For Application products that use Application Open
Interface tables to stage incoming data and utilize an Application Open
Interface API to validate the staged data

Use Insert to Database Table action to insert data into Application Open
Interface tables

Use Procedure Call action to execute Application Open Interface API

For Application products that use application APIs that combine staging
tables and the validation API.

Use Procedure Call action and map source (DTD) data to the Application
API parameter list.

11 IDENTIFY SOURCE AND TARGET DOCUMENT LEVELS.

Table 2 – 2  (Page 2 of 2) 

Compare Database Views (Source) to DTD (Target)

Step 1 Create a Worksheet

Create a worksheet with the following columns: Target, Required
(Y/N), Source, Code Category, Derivation Rule, Default Value, and
Action, as shown in the following table:
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Target Required
(Y/N)

Source Code
Category

Derivation
Rule

Default
Value

Action

Step 2 Set Up Source

Get the DTD (source) for the required message or use a production
XML message.

Include the the Field Identifier and Segment Descriptions, from the
Open Applications Group Integration Specification Appendixes C and D,
respectively.

Note:  You may use third party software to expand the DTD or
use a production XML message.

Step 3 Set Up Target

Populate the target column of the worksheet with the Application Open
Interface table definitions or Application API parameter list.

Note:  You may use third party software to expand the DTD or
use a production XML message.

Step 3A Identify Required Target Elements

Identify the required Application Open Interface (target) table columns
or Application API parameter list as follows:

• NOT NULL columns defined in the data model

• Application Open Interface API or Application API code to
enforce required columns that are not defined as NOT NULL

• Open Interface or Application API documentation (for the
product) identifying the required columns and associated
derivation and defaulting rules.

Step 4 Relate Source Element to Target Element

For each Application Open Interface (target) table column, identify the
DTD (source) element to map from.

Note:  Use the Open Applications Group Integration Specification
Appendix C (Field Identifier Descriptions) and D (Segment
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Descriptions) to get detailed descriptions of each element
identified on the DTD.

If the target column is for an internal ID, you must resolve this using a
derivation or defaulting rule as outlined in steps 4B and 4C below.  The
sender cannot send an ID as they do not know what the valid internal
IDs are.  XML Gateway provides derivation actions to derive address
and organization ID.

DTD attributes (lowercase tags) are not stored in the Oracle E–Business
Suite, and therefore are not mapped.  However, the value of the
attribute can be used to determine the exact Application Open Interface
table column or Application API parameter to map to.

Step 4A

If the Application Open Interface (target) table column can be sourced
from a DTD (source) element, determine if the DTD (source) element
value requires code conversion so the resulting value is meaningful to
the Oracle E–Business Suite.

If code conversion is required, identify the code category from the list
in Appendix A.

Identify the from/to value to determine if the required values are
available in the database you are using.  If the values are not available,
they must be added.

Step 4B Identify Derivation Rule

If the Application Open Interface (target) table column cannot be
sourced from a DTD (source) element, determine if it can be derived.
Refer to your product’s Application Open Interface documentation for
any predefined derivation rules.  If a derivation rule is defined, make
sure the incoming message provides the data to support the derivation
rule because the Application Open Interface API will use the data to
derive the value for the target column.  Make a notation of the
derivation rule on your worksheet so that you can verify this during
unit testing.

If no derivation rule is defined, you can define one.  The derivation rule
can be based on several DTD elements or some default values.  Make a
notation of the derivation rule on your worksheet.  Make a notation
that an Action may be required.

Refer to Transaction Map – Actions: page 3 – 64 for a list of XML
Gateway supported Actions.
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Determine if the derivation rule (element or literal) requires code
conversion for the trading partner.  If code conversion is required,
identify the code category from the list in Appendix A.

Identify the from/to value to determine if the required values are
available in the database.  If the values are not available, they must be
added.

Step 4C Identify Defaulting Rule

If the Application Open Interface (target) table column cannot be
sourced from a DTD (source) element or derived, determine if it can be
defaulted.  Refer to your product’s Application Open Interface
documentation for any predefined defaulting rules.  If a defaulting rule
is defined, make sure the incoming message provides the data to
support the defaulting rule.  The Application Open Interface API will
use the data as the default value for the target column.  Make a
notation of the defaulting rule on your worksheet so that you can verify
this during unit testing.

If no defaulting rule is defined, you can define one.  The default value
may be set directly in the target definition using the Message Designer
or as an XML Gateway Action if the default value is based on a
condition.  See Appendix B – XML Gateway Supported Actions.

Determine if the defaulting rule (element or literal) requires code
conversion for the trading partner.  If code conversion is required,
identify the code category from the list in Appendix A.

Identify the from/to value to determine if the required values are
available in the database.  If the values are not available, they must be
added.

Step 5 Convert from OAG Format to Oracle Format

For each DTD (source) DATETIME, AMOUNT, OPERAMT, or
QUANTITY element, identify the Application Open Interface (target)
column or Application API parameter to map to.

Oracle E–Business Suite represents date, amount, operating amount,
and quantity in a single database column.  OAG represents these as a
collection of data.  Oracle XML Gateway provides an Action to convert
the OAG representation to the Oracle representation.  Make a notation
that this column requires an Action for ”Convert from OAG” that will
be defined using the Message Designer.
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Step 5A

For the DATETIME element, identify the Application Open Interface
(target) table column for date.

Values for attributes ”qualifier,” ”type,” and ”index” are not mapped
because the meaning is implied in the Application Open Interface table
column for date.

All other values (except TIMEZONE) are represented in the
Application Open Interface table column for date.

Oracle E–Business Suite does not support TIMEZONE.

Note:  OAG DATETIME is made up of the following attributes
and elements: qualifier, type, index, YEAR, MONTH, DAY,
HOUR, MINUTE, SECOND, SUBSECOND, TIMEZONE.

Step 5B

For the AMOUNT element, identify the Application Open Interface
(target) table columns for currency code and debit/credit flag if
available.  The XML Gateway ”Convert from OAG” Action can be
defined to store the OAG currency code and debit/credit flag in the
columns identified, or ignored if the columns are not available.

Values for attributes ”qualifier,” ”type,” and ”index” are not mapped
because the meaning is implied in the Application Open Interface table
column.

Values for NUMOFDEC and SIGN are implied in the Oracle
representation of the amount value.  The values are not mapped unless
your application supports it.  If so, you will need to map them using
the Message Designer.

Note:  OAG AMOUNT is made up of the following elements
and attributes: qualifier, type, index, VALUE, NUMOFDEC,
SIGN, CURRENCY, DRCR.

Step 5C

For the OPERAMT element, identify the Application Open Interface
(target) table columns for the currency code and unit of measure code if
available.  The XML Gateway ”Convert from OAG” Action can be
defined to store the OAG currency code and unit of measure code in
the columns identified, or ignored if the columns are not available.

Values for attributes ”qualifier” and ”type” are not mapped because the
meaning is implied in the Application Open Interface table column.
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Values for NUMOFDEC, SIGN, UOMVALUE, and UOMNUMDEC are
implied in the Oracle representation of the operating amount value.
The values are not mapped unless your application supports it.  If so,
you will need to map them using the Message Designer.

Note:  OAG OPERAMT is made up of the following attributes
and elements: qualifier, type, VALUE, NUMOFDEC, SIGN,
CURRENCY, UOMVALUE, UOMNUMDEC, UOM.

Step 5D

For the QUANTITY element, identify the Application Open Interface
(target) table column for the unit of measure code if available. The XML
Gateway ”Convert from OAG” Action can be defined to store the OAG
unit of measure code in the column identified, or ignored if the column
is not available.

The value for the ”qualifier” attribute is not mapped because the
meaning is implied in the Application Open Interface table column.

Values for NUMOFDEC and SIGN are implied in the Oracle
representation of the quantity value.  The values are not mapped unless
your application supports it.  If so, you will need to map them using
the Message Designer.

Note:  OAG QUANTITY is made up of the following attributes
and elements: qualifier, VALUE, NUMOFDEC, SIGN, UOM.

Step 6 Add Sibling for Duplicate Nodes/Elements

A DTD defines a single occurrence of an element, but additional
occurrences can be added during message implementation to
accommodate the business data.  Map the duplicate node to the
appropriate Application Open Interface table columns.

An example is the DTD element for PARTNER used to identify the
trading party.  If the Application Open Interface requires a SHIP–TO,
BILL–TO, and REMIT–TO, then two PARTNER sibling nodes (same
hierarchy level) were added to the original DTD to accommodate the
BILL–TO and REMIT–TO.  Map these entities to the appropriate
Application Open Interface table columns.

Step 7 Review DTD USERAREA

Consider that the original DTD may have been extended to support
additional data required by the message.  Review all USERAREA
definitions and determine whether they should be mapped to the
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Application Open Interface table column or to an Application API
parameter.

For outbound messages, all application flexfields were mapped to
USERAREA fields.  If the outbound message is being processed as an
inbound message to another Oracle application module, the values
may be meaningful.  If so, they must be mapped to Application Open
Interface table columns or Application API parameters.

Step 8  Resolve Data Gaps

At this point, you have identified DTD (source) elements for as many
Application Open Interface (target) table columns or Application API
parameters as possible.  Any required Application Open Interface
(target) table column or Application API parameter that has not been
mapped represents a data gap.

• If the required column is an internal ID, you must resolve this
using a derivation or defaulting rule as described in Steps 4B and
4C, or use the Address or Organization Derivation Actions.

• Consider resolving the data gaps by extending the DTD to
include the required data.  You can extend the DTD by adding
sibling (same hierarchy level) or child (next level hierarchy)
USERAREA elements or by adding new elements to an existing
USERAREA.  Refer to How to Extend DTDs: page 3 – 109 for
information on how to define these.

• Consider creating new Application Open Interface tables and
associated API.  If this is a valid option, create and load the new
table definitions into the database schema and create the
message map.

Note:  The only updates allowed for a DTD are to the
USERAREA.  Any other changes will invalidate the DTD.

Step 9  Optional Actions

For Application products that use Application Open Interface tables to
stage incoming data and utilize an Application Open Interface API to
validate the staged data:

• Use the Insert to Database Table action to insert data into
Application Open Interface tables.

• Use the Procedure Call action to execute Application Open
Interface API.
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For Application products that use application APIs that combine the
staging tables and the validation API:

• Use the Procedure Call action and map source (DTD) data to the
Application API parameter list.  Refer to How to Map to an API:
page 3 – 112 for additional instructions.

Step 10  Identify Source and Target Document Levels

See Identify Source and Target Document Levels: page 2 – 21.
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Identifying Source and Target Document Levels

After completing the map analysis, identify the document levels for
both the source and target data.

A document level represents a collection of data that repeats.  For the
Application Open Interface tables or database views, each table
represents a document level.  A level is the parent in a parent–child
relationship.

DTDs do not use document levels because the levels are implied based
on usage.  Refer to the tree diagram in the OAG definitions to get a
sense of how the data is grouped.  The tree diagram will also give you
an idea of where additional occurrences of a datatype may be required.

Once you have identified the document levels for the source and target,
proceed to relate the source data structure to the target data structure.
This task is straightforward if the number of data levels in the source
and target are identical, but can be difficult if the numbers are different.
If the number of levels of the source is greater than the target number,
you must collapse levels.  If the number of levels of the source is less
than the target number, you must expand levels.

Collapsing Levels

Collapsing levels is the mapping of multiple source levels to the same
target level.  For example, if your source is 3 levels and your target is 2
levels you can collapse the levels as shown in the following figure:

Correct Way to Collapse Levels Incorrect Way to Collapse Levels

In the correct example above, the result of collapsing levels is that the
data in Source Levels 2 and 3 are consolidated and mapped to Target
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Level 2.  If there are two rows in Source Level 2 and three rows in
Source Level 3, a total of six rows will be created in Target Level 2.

The incorrect example shows the collapsing of Source Levels 1 and 3 to
Target Level 1, causing Source Level 3 to cross over Target Level 2.

Another option is to relate Source Levels 1 and 2 to Target Level 1 and
relate Source Level 3 to Target Level 2, as shown in the correct example
below.  (Do not map Source Level 3 to Target Level 1, crossing over
Target Level 2.)

Correct Way to Collapse Levels Incorrect Way to Collapse Levels

Whichever option you choose, consider what it means to promote
lower level detail data to a higher level.  The source data may need to
be aggregated to be meaningful at the higher level.
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Expanding Levels

Expanding levels is the mapping of one source level to multiple target
levels.  For example, if your source is 2 levels and your target is 3 levels
you can expand the levels as shown in the following figure:

Correct Way to Expand Levels Incorrect Way to Expand Levels

The result of expanding levels, as shown in the correct example above,
is that the data in Source Level 2 is distributed and mapped to Target
Levels 2 and 3.  If there are two rows in Source Level 2, two rows will
be created in Target Level 2 and Target Level 3.

Do not expand Source Levels across Target Levels, as shown in the
incorrect example above.  Source Level 1 is incorrectly expanded to
Target Levels 1 and 3, crossing over Target Level 2.

Another option, as shown in the correct example below, is to distribute
Source Level 1 to Target Levels 1 and 2 and map Source Level 2 to
Target level 3.  (Do not map Source Level 1 to Target Levels 1 and 3,
crossing over Target level 2, as shown in the incorrect example.)

Correct Way to Expand Levels Incorrect Way to Expand Levels
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Whichever option you choose, consider what it means to demote data
from a higher level to a lower level of detail.  The source data may need
to be deaggregated to be meaningful at the lower level.

Another way to accommodate the data structure mismatch is to
collapse or expand the database views or Application Open Interface
tables and use the modified database views or application open
interface table definitions to create the message map.

The resulting hierarchy mapping is defined using the Message Designer
Level Mapping Tab.



2 – 25Map Analysis Guidelines

Recommending DTD Additions or Changes to OAG

Oracle is a member of the Open Application Group’s standards
committee chartered with developing industry–independent XML
standards.  This group meets periodically to review recommendations
and is responsible for publishing standards changes and additions.

During the map analysis process, you may discover that the needed
fields are not represented in a DTD or that a needed DTD is not
supported by OAG.

Whether you are recommending the creation of a brand new Business
Object Document (BOD) and Document Type Definition (DTD) or
additions or changes to an existing DTD, please present your
recommendation in the OAG format and be prepared to identify the
business case and justification.  If you are making a recommendation to
add or change an existing DTD, identify the DTD and version you are
using.  Please make sure your proposed DTD or DTD changes supports
both the Application–to–Application (A2A) and Business–to–Business
(B2B) scenarios.

If you would like Oracle to submit the request to OAG for you, enter an
enhancement request.  We will make the proposals to the OAG
committee and report back to you.  If you want to present your case
directly to OAG, please let us know and we will include you in the
meeting.
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Special Considerations for Custom Messages

Once a document is extracted from the Oracle E–Business Suite,
consider updating the application tables to indicate the document has
been extracted.  This may require adding columns to the appropriate
tables.  This may be important to the Oracle E–Business Suite for
document status reporting or to manage the supply and demand data.

Updating the Oracle E–Business Suite application tables was necessary
in the EDI world to prevent a document from being extracted more
than once.  In the XML Gateway model, documents are extracted based
on an event trigger in the Oracle E–Business Suite (as the documents
are created) as opposed to batch processing used in the EDI model.

For inbound messages, consider adding calls to application procedures
(as an Action) to link the Application Open Interface API process to the
downstream process.
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Message Designer

his chapter describes how to create an XML message map using
the XML Gateway Message Designer.  Specifically, this chapter
describes how to do the following:

• Create Message Maps and Data Definitions using the Map
Creation Wizard and the Data Definition Creation Wizard

• Perform mapping from the source data definition to the target
data definition using the Transaction Map Window

• Apply actions using the Map Action Editor
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Message Designer Overview

The Message Designer is a wizard–guided, repository–based tool used
to create XML message maps.  Map creation consists of defining the
data source and data target, defining hierarchy and data maps between
the source and target data, and defining actions for data transformation
and process control.

The Message Designer is independent of XML standards. It complies
with version 1.0 of the W3C XML specifications.

Note:  Information regarding the W3C XML Standards can be
found at www.w3.org/XML/Activity.

The Message Designer can support map creation for any business
document as long as the document conforms to a Document Type
Definition (DTD).

The Message Designer can be used to:

• Modify the Oracle prebuilt message maps

• Create new message maps

If you are using the Message Designer to create new message maps,
you must complete a map analysis before attempting to use the
Message Designer.  Refer to Map Analysis Guidelines: page 2 – 2 for
the details.  The thoroughness of your map analysis will impact the
success of your map creation.

Completed message maps and associated DTDs are loaded into the
XML Gateway repository.  The XML Gateway Execution Engine and
the XML Parser use the maps to create outbound messages and to
consume inbound XML messages.

Message Designer Menus

The Message Designer has the following menus: File, View, and Help.
Some of the menu functions can also be accessed by toolbar icons.

See: Message Designer Toolbar: page 3 – 8.

File Menu

Use the Message Designer to create new data definitions and
transaction maps or to modify existing data definitions and transaction
maps.
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The Message Designer supports the following file types:

• .XGD for source or target data definitions

• .XGM for transaction maps

The .XGD and .XGM files are XML files that can be opened and read
using a browser or any XML editor.  The .XGD and .XGM files are used
to describe the structure and content of a message.  The XML message
produced or consumed using the transaction map (.XGM) contains the
actual business data.

The File menu options are listed in the following table:

Menu Option Description

New Create a new data definition file or a new transaction map
file.

Open Open an existing file.  Files can be either data definition
files with a .XGD extension, or transaction map files with
a .XGM extension.

Close Close the open transaction map or data definition file.

Save Save an open file.  Save the data definition files as .XGD
files.  Save the transaction map files as .XGM files.

Properties Provides access to key property values entered using the
Data Definition Creation or Map Creation Wizard.  Use
this menu option to change any of the original key values
presented.  
See File > Properties Menu Option: page 3 – 4 for more
details regarding this menu option.

View Menu

Use the View Menu to view the source or target definitions in tree
format only, table format only, or both tree and table formats.

The View menu options are listed in the following table:

Menu Option Description

Tree View source or target definition in tree format only.

Table View source or target definition in table format only.

View Both View source or target definition in both tree and table
formats.  This is the default viewing option.
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Help Menu

The Help menu options are listed in the following table:

Menu Option Description

Help Topics Displays Message Designer help.

About Displays the Message Designer version installed.

File > Properties Menu

The File > Properties menu option provides access to key property
values entered using the Data Definition Creation Wizard or the Map
Creation Wizard.  Use the Properties window to change any of the key
property values presented.

The File > Properties menu option is available in the following
windows:

• Main Message Designer

• Data Definition Window

• Transaction Map Window

The Property Tabs and fields associated with each Tab vary depending
on where the File > Properties menu option is invoked.

Main Message Designer File Properties

General Tab

The General Tab allows you to update the Output Directory.  This is the
default directory used to store the data definition and message map
files created using the Message Designer.

Use the Browse button to select a default directory
or enter a valid directory name.

Click OK or Cancel as appropriate.

Output Directory
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Data Definition File Properties

The Data Definition window displays the General Tab and the Data
Tab.

See Main Message Designer File Properties: page 3 – 4 for a
description of the General Tab.

Data Tab

The Data Tab allows you to update data values originally entered using
the Data Definition Creation Wizard.  The fields on the tab vary
depending on the type of data definition.

The fields in the following table display for all data definitions:

Field Description

Data Definition Name Update the name entered.  Observe the naming conven-
tions recommended in the Data Definition and Map Cre-
ation Wizards.
See Select/Create a Source/Target Data Definition Name
and Type: page 3 – 26 for the naming convention details.

Data Definition Description Update the description.

The fields in the following table display when the data definition type
is XML:

Field Description

Root Element Update the Root Element entered.  The root element en-
tered must match the root element of the DTD entered
below.

Runtime DTD Location Update the Runtime DTD Location with the new subdi-
rectory name.  Observe the naming conventions recom-
mended in the Data Definition and Map Creation Wiz-
ards.
See Identify the Runtime Location of a DTD: page 3 – 40
for naming convention details.

DTD File Name Use the Browse button to select a DTD or enter a valid
DTD file name.  This will replace the file name originally
entered.  The root element defined in the DTD must match
the root element value entered above.

Attention:  If the data definition changes affect any existing
maps, the maps must be changed and reloaded.  If the DTD
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reference is changed, the new DTD must be reloaded.  Refer to
How to Load Message Maps and DTDs: page 3 – 118.

Transaction Map File Properties

Invoking the File > Properties menu option from the Transaction Map
window displays the General Tab, the Map Tab, the Source Tab, and the
Target Tab.

See Main Message Designer File Properties: page 3 – 4 for a
description of the General Tab.

Map Tab

This tab displays only if you are viewing a map transaction file (.XGM).

Field Description

Map Name Update the name entered.  Observe the naming conven-
tions recommended in the Map Creation Wizard.
See  Specify a Map Name: page 3 – 24 for naming conven-
tion details.

Map Description Update the description.

Attention:  If the map name change affects any existing
Trading Partner definitions, update the Trading Partner
definition with the new map name.  Refer to Trading Partner
Setup: page 4 – 24 for the details.

Attention:  The map containing the new name must be
reloaded into the XML Gateway repository.  Refer to How to
Load Message Maps and DTDs: page 3 – 118 for the details.

Source Tab

The fields in the following table display for all data definitions:
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Field Description

Data Definition Name Update the name entered.  Observe the naming conven-
tions recommended in the Data Definition and Map Cre-
ation Wizards.
See Specify Source/Target Data Definition Name and
Type: page 3 – 28 for naming convention details.

Data Definition Description Update the description.

The fields in the following table display when the data definition type
is XML:

Field Description

Root Element Update the Root Element entered.  The root element en-
tered must match the root element of the DTD entered
below.

Runtime DTD Location Update the Runtime DTD Location with the new subdi-
rectory name.  Observe the naming conventions recom-
mended in the Data Definition and Map Creation Wiz-
ards.
See Identify the Runtime Location of a DTD: page 3 – 40
for naming convention details.

DTD File Name Use the Browse button to select a DTD or enter a valid
DTD file name.  This will replace the file name originally
entered.  The root element defined in the DTD must match
the root element value entered above.

Attention:  Changes to any of these property values require
the message map to be reloaded.  Changing the DTD
associated with the message map requires the DTD to be
reloaded.  Refer to How to Load Message Maps and DTDs:
page 3 – 118 for details.

Target Tab

The fields in the following table display for all data definitions:



☞

3 – 8 Oracle XML Gateway User’s Guide

Field Description

Data Definition Name Update the name entered.  Observe the naming conven-
tions recommended in the Data Definition and Map Cre-
ation Wizards.
See Specify Source/Target Data Definition Name and
Type: page 3 – 28 for naming convention details.

Data Definition Description Update the description.

The fields in the following table display when the data definition type
is XML:

Field Description

Root Element Update the Root Element entered.  The root element en-
tered must match the root element of the DTD entered
below.

Runtime DTD Location Update the Runtime DTD Location with the new subdi-
rectory name.  Observe the naming conventions recom-
mended in the Data Definition and Map Creation Wiz-
ards.
See Identify the Runtime Location of a DTD: page 3 – 40
for naming convention details.

DTD File Name Use the Browse button to select a DTD or enter a valid
DTD file name.  This will replace the file name originally
entered.  The root element defined in the DTD must match
the root element value entered above.

Attention:  Changes to any of these property values require
the message map to be reloaded.  Changing the DTD
associated with the message map requires the DTD to be
reloaded.  Refer to How to Load Message Maps and DTDs:
page 3 – 118 for details.

Message Designer Toolbar

The Message Designer toolbar uses the following icons to duplicate the
noted menu options:

Create New Map icon.  Invokes the Map Creation Wizard
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Open Map icon.  Opens an existing map.

Save Map Icon.  Saves the data definition as a .XGD file.  Saves the
transaction map as a .XGM file.

View Tree icon.  Displays the tree format only.

View Table icon.  Displays the table format only.

View Both Tree and Table icon.  Displays both the tree and table
formats.

Help icon.  Invokes Message Designer Help.

Message Designer Buttons

The Add Sibling button allows you to add new fields required to
complete the map.

For additional information for using this function see the following:

For Source Data Definitions see (Source Definition Tab) Add
Sibling: page 3 – 47.

For Target Data Definitions see (Target Definition Tab) Add Sibling:
page 3 – 55.

The Add Child button adds child elements to an existing sibling or
child.

For additional information for using this function see the following:

For Source Data Definitions see (Source Definition Tab) Add Child:
page 3 – 48.

For Target Data Definitions see (Target Definition Tab) Add Sibling:
page 3 – 55.

The Delete button deletes any sibling or child element that has not
been mapped.

If a sibling or child has child elements associated with it, a warning
is displayed before the delete occurs.
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Attention:  If you are deleting any DTD extensions, be sure to
remove the DTD extensions from the corresponding extension
file created for the application or user.  The extra information
will not cause a parser violation, but it is a good practice to
ensure the extension files match the message maps.  Refer to
How to Extend DTDs: page 3 – 109 for the details.
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Message Designer Wizards

The Message Designer contains two wizards to guide you through the
map creation process.  The two wizards are:

• Data Definition Creation Wizard

• Map Creation Wizard

The Data Definition Creation Wizard is used to define the data
definitions.

A data definition is a collection of data used to describe a business
object such as a customer profile or an invoice document.  A data
definition may be based on database views, database tables, application
open interface tables, an application API, an XML Document Type
Definition (DTD), or a production XML message.

A message map consists of a source data definition and a target data
definition graphically represented as follows:

The data definitions created using the Data Definition Creation Wizard
are used to create a preliminary message map.  The Data Definition
Creation Wizard is ideal for creating a master definition to use as the
basis for creating trading partner–specific message maps.

Three combinations of source and target data definitions are supported
by the Message Designer as described in the following table:
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Source Target Purpose

Database XML Outbound XML message

XML Database Inbound XML message

XML XML Pass–through XML message
   Refer to How to Map a Pass–Through 
   Message: page 3 – 111.

Mapping to an Application API
   Refer to How to Map to an API: page 3 – 112.

Database–based data definitions represent a description of the Oracle
data model required to support the XML message.

XML–based data definitions are based on an XML Document Type
Definition (DTD) or a production XML message.

The Map Creation Wizard is used to define the following:

• Source Definition

• Target Definition

• Preliminary Message Map

The source and target data definitions may be new or based on
definitions previously created using the Data Definition Wizard.  The
source and target data definitions form the basis of a preliminary
message map.

The Message Designer is used to define the following to complete the
message map:

• Level Mapping

• Element Mapping

• Actions

Level mapping is the process of relating the source data structure to the
target data structure.  Element mapping is the process of relating a
source data element to a target data element.  Actions are data
transformation or process control functions that can be applied at the
data element, document, or root level.

Data Definition Creation Wizard Process Flow

Creating a Data Definition consists of two general steps:
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Step 1: Name the data definition and select the type

Step 2: Identify data definition details

The tasks required to complete Step 2 vary depending on your
selections in Step 1.

The illustration below displays the flow of the screens presented to you
in the Data Definition Creation Wizard.  After you specify the data
definition name and type (Step 1), you are prompted to provide the
details based on whether you chose a type of database or XML.

When you have completed Step 2, you are taken to a summary screen
where you can either finish or return to previous steps to make edits.
Clicking Finish will close the Wizard and open the Message Designer
Data Definition tab.

Map Creation Wizard Process Flow

There are three general steps to creating a map.  Each Step consists of a
variable number of tasks depending on the selections you make in the
Wizard:
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Step 1: Specify a Map Name

Step 2: Select/Create a Source Data Definition

Step 3: Select/Create a Target Data Definition

The illustration below displays the flow of the screens presented to you
in the Map Creation Wizard.  After you specify a map name (Step 1),
you are prompted to select or create a source data definition (Step 2).  If
you choose to create the data definition, you are guided through the
data definition creation steps (identical to the Data Definition Creation
Wizard steps).

After you create your source data definition, or if you chose to select
an existing data definition, you are prompted to select or create a target
data definition (Step 3).  The target data definition steps are identical to
the source data definition steps.

When you have completed Step 3, you are taken to a summary screen
where you can either finish or return to previous steps to make edits.



Figure 3 – 2
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Map Creation Wizard Process Flow
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Using the Data Definition Creation Wizard

The Data Definition Creation Wizard guides you through the data
definition creation process.  The data definition is saved as a .xgd file
and can be selected as a target or a source when you create a map.

Attention:  It is not necessary to create your data definitions
before you begin the map creation process.  The Map Creation
Wizard gives you the option of choosing an existing data
definition or creating a new one.  If you choose to create a new
one, you will be guided through the data definition creation
steps as part of your map creation process.  See Map Creation
Wizard: page 3 – 23.

Launch the Data Definition Creation Wizard by selecting

(M) File > New > Data Definition

The first window welcomes you to the wizard.
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The following buttons are available for all Wizard steps:

• Cancel

Exit the Wizard and cancel all completed Wizard steps.

• Help

Invoke Help information for the Wizard step.

• Back

 Return to the previous Wizard step.

• Next

Advance to the next Wizard step.  The Next button is enabled
only after the required information for the current Wizard step
has been entered.

Data Definition Creation Wizard Steps

Follow the instructions presented for the Map Creation Wizard to
complete each of the Data Definition Creation Wizard steps:

Specify Data Definition Name and Type

See Specify Source/Target Data Definition Name and Type: page 3 – 28.

If you selected Database...

Complete the following steps:

Specify Database Information

See Specify Source/Target Database Information: page 3 – 30.

Select Tables or Views

See Select Source/Target Tables or Views: page 3 – 32

Select Columns

See Select Source/Target Columns: page 3 – 34
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Specify Source/Target Levels

See Specify Source/Target Levels: page 3 – 36.

If you selected XML...

If you selected XML as the data definition type, you will be prompted
for the XML information.

See Specify Source/Target XML File and Root Element: page 3 – 38.

Data Definition Creation Wizard: Summary

Click Finish to complete the Wizard steps.  If you wish to change any
selections you have made in defining your data definition, you can
used the Back button to return to the appropriate Wizard window.
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Message Designer Data Definition Window

The data definition you just created is displayed in the Data Definition
tab.  You can extend the definition using the Data Definition window to
perform the following:

• Provide default values

• Create duplicate nodes and elements using the Add Sibling
button

• Add fields using the Add Child button

Once the data definition is complete, use the File > Save (Data
Definition) menu option or the Toolbar equivalent.  Use the File >
Properties menu to change the default directory if necessary.
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Field

Field identifies the name of the element, document, or root.  The names
are based on the Application Open Interface table column names or
DTD element names.

The field name can be changed if necessary, however, consider what
this change implies.  Because the field is based on the database column
name or a DTD element name, corresponding changes may be
necessary in Oracle Applications or the DTD.  The only changes
allowed to a DTD are to the USERAREA.  Refer to How to Extend
DTDs: page 3 – 109 for details.

The first row is reserved for the Data Definition name (if the data
definition is based on Application Open Interface) or DTD root element
name (if the data definition is a DTD).

Additional field names are displayed when sibling or child elements
are added using the Add Sibling or Add Child buttons.

See Message Designer Buttons: page 3 – 9.

Item Type

Item type identifies the field as either a Level or an Element.  Level
represents the parent in a parent–child relationship.  Element represents
the child in a parent–child relationship.

The Item Type of the first row is defaulted to Level.  The default value
cannot be changed.

If the data definition is based on Application Open Interface tables, the
Item Type for the tables is defaulted to ”Level”.  The Item Type for the
columns is defaulted to ”Element”.

If the data definition is based on a DTD or a production XML message,
the default Item Type is ”Element”.  DTDs do not support levels and
therefore the levels must be explicitly defined by setting the Item Type
to ”Level”.

Any node that represents a collection of data that repeats (for example,
PO lines or shipment lines) represents a level.  The Item Type for the
node must be set to ”Level”.

For the OAG standard, change the Item Type of the following to
”Level” to support Level Mapping:

• Root

• CNTROLAREA
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• DATAAREA

Make the same change for all other DTD data types identified as data
levels during the map analysis process.

The Item Type for a new sibling or child element is defaulted to
”Element”.  Change the Item Type setting where appropriate.

Default

Enter a default value for the field as appropriate.  This value is used
only if the incoming value is null.

If the data definition is a DTD, use the Default column to set the DTD
attribute values.  The values will be displayed with the corresponding
attribute tags when the message is created.

Set the default using a conditional action if the default value is based
on a condition.  See Transaction Map – Actions: page 3 – 64 for details
on setting a default using a conditional action.

If Item Type is ”Level”, the Default column is disabled.

Data Type

Each field is defined with a data type.  The data types supported by the
XML Gateway Execution Engine are VARCHAR2, DATE, NUMBER,
and CHAR.

If the data definition is based on database views or tables, the data type
is defaulted to the data type defined for the database column.

If the data definition is based on a DTD or a production XML message,
the data type is defaulted to VARCHAR2.

Attention:  There is no need to change the DTD element’s data
type until XML schemas are supported by the XML standards
bodies which will make data types more meaningful.

The Data Type for a new sibling or child element is defaulted to
VARCHAR2.  Change the Data Type if necessary.

If Item Type is ”Level”, the Data Type column is disabled.

DB Column

DB Column is available only when the data definition is based on
views or tables.
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A check mark indicates the column is defined in the Oracle Application
data model.  This setting informs the XML Gateway Execution Engine
whether to validate the element against the Oracle Application data
model or not.

If the Item Type is ”Level”, the DB Column is disabled.

Node Type

Node Type is available only when the data definition is a DTD.  The
default is the DTD setting.

The valid values are Element or Attribute.  Elements contain the
business data.  Attributes contain qualifiers for the business data to
indicate the intended meaning of the business data.

The Node Type for a new sibling or child element is defaulted to
”Element”.  Change the Node Type setting where appropriate.

If Item Type is ”Level”, the Node Type column is disabled.
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Using the Map Creation Wizard

The Map Creation Wizard guides you through the map creation
process.  A series of windows are presented to create a map based on
the source and target definitions.

Launch the Map Creation Wizard by selecting

(M) File > New > Transaction Map

or by clicking the Create New Map icon on the toolbar.  The first
window welcomes you to the wizard.

The following buttons are available for all Wizard steps:

• Cancel

Exit the Wizard and cancel all completed Wizard steps.

• Help
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Invoke Help information for the Wizard step.

• Back

 Return to the previous Wizard step.

• Next

Advance to the next Wizard step.  When data is required to
advance to the next step, the Next button is disabled until you
supply the necessary data.

Click Next to continue.  The Wizard will display the Specify a Map
Name window.

Specify a Map Name
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Specify a unique map name.  This is the name assigned to the message
map you are creating.  It is also the name to be used when associating a
message map to a Trading Partner.

Enter Map Name

Enter a unique map name.  This name is stored as the map code in the
map definition file.

In addition to being unique, the name should describe the intended use
of the map for easy identification.  The recommended naming
convention is as follows:

• Product mnemonic or user ID

• Transaction subtype as entered in the Define Transactions form

• XML standard and version used (for example, OAG, Rosettanet,
iFX)

• Inbound or outbound message

Examples of map names using the recommended naming convention
are:

• AR_INVO_OAG70_OUT_INVOICE

This map name is used for an Oracle Receivables outbound
invoice message that uses the OAG standard, version 7.0 DTD.

• USER_ACK_OAG70_IN

This name represents a user–developed map for an inbound
acknowledgment message that uses the OAG standard, version
7.0 DTD.

Enter Map Description

Enter a description for the map.

Note:  You can use the File > Properties menu option to change
the Map Name and Map Description as necessary.

Click Next to continue.  The Wizard will display the Select/Create a
Source Data Definition window.
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Select/Create a Source/Target Data Definition

Select an existing data definition file or create a new data definition file.

Create a new source/target data definition

Select this option to create a new data definition.  The Wizard will
guide you through creating your new .XGD file.

Select an existing data definition

Existing definition files are stored on the file system as <filename>.XGD.
Use the Browse button to view the available data definition files.
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Click Next to continue

• If you are defining your Source data definition and you
selected...

– Create a new source data definition, proceed to  Specify
Source/Target Data Definition Name and Type: page 3 – 28.

– Select an existing Source data definition, repeat this step for
your Target Data Definition.

• If you are defining your Target data definition and you
selected...

– Create a new target data definition, proceed to  Specify
Source/Target Data Definition Name and Type: page 3 – 28.

– Select an existing Target data definition, proceed to Map
Creation Wizard Summary: page 3 – 41.
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Specify Source/Target Data Definition Name and Type

For a new data definition, enter a data definition name, description,
and type.

Enter Data Definition Name

Enter a name that describes the contents of the data definition to allow
easy identification.

This name is displayed in the Transaction Map window as the root
node, if you select database as the data definition type.  If you select
XML as the data definition type, the DTD root element is displayed in
the Transaction Map window as the root node instead of the data
definition name entered here.

The recommended naming convention is as follows:
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• Product mnemonic or User ID

• Transaction subtype as entered in the Define Transactions form

• XML standard and version used (for example, OAG, Rosettanet,
iFX)

• Database or XML data definition type

Examples of data definition names using the recommended naming
convention are:

• AR_INVO_OAG70_DB

This name describes an Oracle Receivables–developed outbound
invoice message that uses the OAG standard, version 7.0 DTD.
This data definition is for the Database data definition type
intended for use as the source data definition for an outbound
message.

• USER_ACK_OAG70_XML

This name describes a user–developed inbound
acknowledgement message that uses the OAG standard, version
7.0 DTD.  This data definition is for the XML data definition type
intended for use as the source data definition for an inbound
message.

• ECX_CBOD_OAG70

This name is a general–use data definition for an OAG
confirmation using version 7.0 DTD.  It can be used as a source
or target data definition.

Use the File > Properties menu option to change the Data Definition
Name as necessary.

Enter Data Definition Description

Enter a description for the data definition.

Use the File > Properties menu option to change the Data Definition
Description as necessary.

Select Data Definition Type

Select a data definition type from the following list of values:

• Database

• XML
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Click Next to continue.

The wizard steps to follow will vary based on the data definition type
selected.

• If you selected Database, proceed to Specify Source/Target
Definition Database Information: page 3 – 30.

• If you selected XML, proceed to Specify Source/Target XML File
and Root Element: page 3 – 38.

Specify Source/Target Definition Database Information

Enter the database access information.  Contact your Database
Administrator for the appropriate values if you do not know them.

This step does not apply if the source/target is a DTD because database
access is not required.
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User Name

Enter the user name for the database schema to be accessed.

Password

Enter the password for your User Name.

Connect String

Enter the connect string for the database.

Host

Enter the host name for the database.

Port

The default value of ”1521” is displayed.  Enter another valid port
value (if necessary) for the database to be accessed.

Click Next to continue.  The Wizard will display the Select
Source/Target Tables or Views window.
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Select Source/Target Tables or Views

If you selected a Data Definition Type of Database, you will be
prompted for the database views and tables required by the message.

All application database views are defined in the APPS schema. The
associated database tables are defined in the application–specific
database schema.  Access to application–specific database tables must
be granted by defining a synonym in the APPS schema.

For applications with database views or tables shared across multiple
hierarchical levels of the data model representing the business
document, a database view or table alias is required for the second and
each subsequent use of the view or table.  This is necessary because this
wizard step deletes a database view or table from the Available
Tables/Views list once it has been selected.
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This step does not apply if the source/target is a DTD, because
database information is not necessary.

Available Tables/Views

Expand the APPS database schema tree to view all the available
database tables and views.

Selected Tables/Views

Select the desired database views and tables from the left window, click
on the right shuttle to move the selected database view or table from
Available Tables/Views to Selected Tables/Views.  Continue this
process until you have selected all the required database views and
tables.

Once you have selected all the database views and tables required by
the message, select any special XML Gateway database views you may
have defined to support the specific requirements of the XML standard
you are using.

For example, select the ECX_OAG_CONTROLAREA_V database view
to map to the OAG CNTROLAREA data type.

To deselect a selected database view or table, select the desired
database view/table from the right window, click on the left shuttle
button to move the selection from the Selected Tables/Views back to
Available Tables/Views.

Click Next to continue.  The Wizard will display the Select
Source/Target Columns window.
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Select Source/Target Columns

This window prompts you for the columns required from each of the
database views or tables selected in the previous step.

This step does not apply if the source/target is a DTD because database
information is not necessary.

Available Columns

Expand each of the database views and tables to view all the available
database view and table columns.

Selected Columns

Select the desired database view or table column from the left window,
click on the right shuttle button to move the selected database view or
table column from Available Columns to Selected Columns.  To move
all the columns from a view or table, select the table or view and click
the double right shuttle button to move all its columns from Available
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Columns to Selected Columns.  Continue this process until all the
required database view and table columns are selected.

You cannot proceed to the next wizard step until you have selected at
least one column from each of the selected database views and tables.
If necessary, return to the previous wizard step to deselect a database
view or table and then resume the column selection process.

To deselect a selected database view or table column, highlight the
desired column from the right window and click the left shuttle button
to move the highlighted column from Selected Columns back to
Available Columns.  To deselect all the columns from a table or view,
highlight the table or view name under Selected Columns and click the
double left shuttle button to move all the columns back to the Available
Columns area.

Click Next to continue.  The Wizard will display the Specify
Source/Target Levels window.
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Specify Source/Target Levels

If you selected a Data Definition Type of Database, you will be
prompted to identify the hierarchy of the source or target data
definition.  This step is necessary only if your source/target data
definition contains more than one level.

A level represents a collection of data that repeats.  For example,
Purchase Order lines represent a level within a Purchase Order because
there are multiple PO lines to a single PO.

The purpose of this step is to identify the parent and child relationships
of each database view.  The source hierarchy will be used to relate to
the target hierarchy as part of the map creation process.

This step does not apply if the source/target is a DTD because database
information is not necessary.
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Available Tables/Views

The available database views and tables are displayed for your
selection.

Selected Tables/Views

This window allows you to define the parent and child relationships of
the selected database views and tables along with the special database
views necessary to relate the database data model to the DTD data
model.

Start by identifying the parent node.  For OAG, the parent node is the
ECX_OAG_CONTROLAREA_V view.  Related to the parent node are
sibling or child nodes.

Sibling and child relationships are defined by first identifying the
parent node in the Selected Tables/Views window (right).  The
database view or table you move from the the Available window to the
Selected window will always be added as the last child of the parent
node selected.

Therefore, to specify a sibling relationship to a specific node, select its
parent node in the Selected Tables/Views column (right window).
Next select the database view or table in the Available Tables/Views
(left window) that you want to define as its sibling.  Click on the right
shuttle.  The selected database view or table will be displayed as the
last child of the parent node selected, or as a sibling to the desired
node.

To specify a child relationship to a specific node, select the node in the
Selected Tables/Views column (right window).  Next select the
database view or table in Available Tables/Views (left window) that
you want to define as its child, and click on the right shuttle.  The
selected database view or table will be displayed as the last child of the
selected parent node.

Continue this process until all available database views and tables have
been moved to Selected Tables/Views.

This completes the data definition process.

Click Next to continue

If you have just finished your Source Data Definition, return to
Select/Create a Source/Target Data Definition: page 3 – 26 to define
your Target Data Definition.
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If you have just finished your Target Data Definition, proceed to Map
Creation Wizard Summary: page 3 – 41.

Specify Source/Target XML File and Root Element

If you selected XML as the data definition type, you will be prompted
for the XML information.  You can use a DTD or a production XML
message as the data definition.

XML Standard

Enter the XML standard used.

”OAG” (Open Application Group XML Standard) is the default.
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Select a DTD/XML File

Select the DTD from the list of available DTDs presented when you
click on the Browse button, or enter a specific DTD including the file
path.  The selected DTD and its file path are displayed.

To base the data definition on a production XML message, enter the file
path and file name of the XML message.

The DTD or production XML message is used to create the definition
tree for the Message Designer.

This step assumes that the required DTD and the associated external
reference DTD files are available on the file system and are accessible
by the Message Designer.  For example, the OAG definition files are

– oagis_domains.dtd

– oagis_resources.dtd

– oagis_fields.dtd

– oagis_segments.dtd

Identify the XML Root Element

Enter the XML root element.  Open the DTD or production XML
message using a browser or XML editor to determine the root element
name if you do not know it.

Note:  Because  the representation of root element varies by
XML standard, this step is required to inform the Execution
Engine where to begin reading the DTD.

Use the File > Properties menu option to change the Root Element as
necessary.

Enter DTD File Name

If you entered a DTD above, the DTD file name will display
automatically.

If you entered a production XML message above, click the Browse
button to select the corresponding DTD from the list of available DTDs,
or enter a specific DTD if available.

The DTD file name entered is used to validate a message to ensure that
it is well–formed and valid before placing an outbound message on
Oracle Advanced Queuing or processing a message dequeued from
Oracle Advanced Queuing.
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In addition, the primary DTD and its associated definition files must be
loaded into the XML Gateway database for access by the XML
Gateway Execution Engine.

Note:  Refer to How to Load Message Maps and DTDs: page
3 – 118 for more details.

Use the File > Properties menu option to change the DTD File Name as
necessary.

Identify the Runtime Location of a DTD

Enter the subdirectory name using the following naming convention:

<application code>/xml/<standard><standards version>

Examples:

ar/xml/oag62

ap/xml/oag70

Note:  Do not use a period (.) when referencing a standards
version.

The combination of the runtime DTD location and the DTD file name
provides a unique identifier for the DTD required.

Use the File > Properties menu option to change the Runtime Location
of a DTD as necessary.

Click Next to continue

If you have just finished your Source Data Definition, return to
Select/Create a Source/Target Data Definition: page 3 – 26 to define
your Target Data Definition.

If you have just finished your Target Data Definition, proceed to Map
Creation Wizard Summary: page 3 – 41.
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Map Creation Wizard Summary

Click Finish to exit the Map Creation Wizard.  If you wish to change
any selections you have made in defining your map, use the Back
button to return to the appropriate Wizard window.

The following validations will be performed before proceeding to the
level and element mapping process:

• When the DOCTYPE tag is present in an XML message, verify
that the DTD referenced is accurate.

• Verify that the XML root element matches the DTD identified.
When a production XML message is identified, verify that the
root element and DTD identified match the production XML
message.

• Verify that external DTDs referenced by the primary DTD are
available.
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• Check for circular DTD references.  Process the first occurrence,
truncate the remainder and warn user to manually add the
necessary repeating occurrences.
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Transaction Map Window

Once you exit the Map Creation Wizard, the source and target
definitions are presented in the Transaction Map window.  The
Transaction Map window is divided into four tabs as follows:

• Source Definition

• Target Definition

• Level Mapping

• Element Mapping (this tab appears only after a Level has been
mapped)

Source Definition

The source definition selected or created using the Map Creation
Wizard is displayed in the Source Definition tab.  You can extend the
source definition to perform the following:

• Provide default values

• Enable code conversion

• Create duplicate nodes or elements using the Add Sibling button

• Add fields using the Add Child button

• Define conditional node mapping rules for duplicate nodes or
elements (if the source is a DTD)

• Implement optional Confirmation Business Object Document
(BOD)

Once the source data definition is complete, it can be saved for reuse in
other message maps.  Use the File > Save (Data Definition) menu
option or the Toolbar equivalent.  Use the File > Properties menu to
change the default directory or data definition property values if
necessary.

If you do not wish to save the source data definition as an entity
independent of the message map, then continue with the mapping
process and save the transaction map at the end of the Element
Mapping process.
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Source Definition Considerations

1. Refer to How to Map a Pass–Through Message: page 3 – 111, for
guidelines related to developing a pass–through transaction.

2. Refer to How to Implement the OAG Confirmation Business Object
Document: page 3 – 113, for details on how to implement the
optional confirmation message.

Source Definition Tab

Field

Field identifies the name of the element, document, or root.  The names
are based on the database column names or DTD element names.

The field name may be changed if necessary, however, consider what
this change implies.  Because the field is based on the database column
name or a DTD element name, corresponding changes may be



3 – 45Message Designer

necessary in Oracle Applications or the DTD.  The only changes
allowed to a DTD are to the USERAREA.  Refer to How to Extend
DTDs: page 3 – 109 for details.

The first row is reserved for the Data Definition name (if the source is
based on database views or tables) or root element name (if the source
is a DTD).

Additional field names are displayed when sibling or child elements
are added using the Add Sibling or Add Child buttons.

Item Type

Item type identifies the field as either a Level or an Element.  Level
represents the parent in a parent–child relationship.  Element represents
the child in a parent–child relationship.

The Item Type of the first row is defaulted to ”Level”.  You cannot
change this value.

If the source is based on database views or tables, the Item Type for the
database view or table is defaulted to ”Level”.  The Item Type for each
database view or table column is defaulted to ”Element”.

If the source is based on a DTD or a production XML message, the
default Item Type is ”Element”.  DTDs do not support levels, therefore
any levels must be explicitly defined by setting the Item Type to
”Level”.

Any node that represents a collection of data that repeats (for example,
Purchase Order lines or shipment lines) represents a level.  The Item
Type for the node must be set to Level.

For the OAG standard, change the Item of the following to ”Level” to
support Level Mapping:

• Root

• CNTROLAREA

• DATAAREA

Make the same change for all other DTD data types identified as data
levels during the map analysis process.

The Item Type for a new sibling or child element is defaulted to
”Element”.  Change the Item Type setting where appropriate.
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Default

Enter a default value for the field as appropriate.  This value is used
only if the incoming value is null.

Set the default using a conditional action if the default value is based
on a condition.  See Transaction Map – Actions: page 3 – 64 for details
on setting a default using a conditional action.

If Item Type is ”Level”, the Default column is disabled.

Category

Enable the field for code conversion by entering a valid code category.
Refer to Appendix A for a list of seeded code categories.

Master code conversion values are defined using the Define Code
Conversion Values form.  Trading Partner–specific code conversion
values are defined using the Trading Partner Code Conversion form.

The code conversion process searches the trading partner–specific code
conversion values and then searches the master code conversion list.
Use the Get Predefined Variable Value action to determine the status of
the code conversion process for the source column enabled for code
conversion.

See Get Predefined Variable Value: page 3 – 97 for details regarding the
code conversion return status and possible actions to take if the code
conversion cross–reference value is not found.

Code conversion is applied before any Actions are applied.  Consider
the code conversion return status when you define Actions for the
source column enabled for code conversion.  Actions are applied to the
code–converted value only when the code conversion process is
successful.

If Item Type is Level, the Category column is disabled.

Data Type

Each field is defined with a data type.  The data types supported by the
XML Gateway Execution Engine are VARCHAR2, DATE, NUMBER,
and CHAR.

If the source is based on database views or tables, the data types are
defaulted to the data types defined for the view or table columns.

If the source is based on a DTD or a production XML message, the data
type is defaulted to VARCHAR2.
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Attention:  There is no need to change the DTD element’s data
type until XML schemas are supported by the XML standards
bodies which will make data types more meaningful.

The Data Type for a new sibling or child element is defaulted to
VARCHAR2.  Change the data type if necessary.

If the Item Type is Level, the Data Type column is disabled.

DB Column

The DB Column is available only when the source is based on database
views or tables.

A check mark indicates the column is defined in the Oracle Application
data model.  This setting informs the XML Gateway Execution Engine
whether to validate the element against the Oracle Application data
model or not.

If Item Type is Level, the DB Column is disabled.

Node Type

Node Type is available only when the source is a DTD.  The default is
the DTD setting.

The valid values are Element or Attribute.  Elements contain the
business data.  Attributes contain qualifiers for the business data to
indicate the intended meaning of the business data.

The Node Type for a new sibling or child element is defaulted to
Element.  Change the Node Type setting where appropriate.

If Item Type is Level, the Node Type column is disabled.

Add Sibling (button)

The Add Sibling button allows you to add new fields required to
complete the map.  This feature is also used to create duplicate DTD
nodes such as PARTNER.

The same can be done if the source is database views or tables.

When the source is based on a DTD or production XML message, and
you are adding a sibling between two attributes, set the Node Type for
the new field to ”Attribute”.  The default Node Type of ”Element” will
cause a parser violation.

Attention:  You cannot add a sibling to the root node.
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Note:  Refer to How to Extend DTDs: page 3 – 109 for details on
how to extend a DTD.  Included are the naming conventions
that must be followed for the XML Parser to recognize the DTD
extensions.

Add Child (button)

The Add Child button adds child elements to an existing sibling or
child.

This function may be used if the source is database views or tables or a
DTD.

If Node Type is ”Attribute”, the Add Child button is disabled.  You
cannot define an attribute for an attribute.

Note:  Refer to How to Extend DTDs: page 3 – 109 for details on
how to extend a DTD.  Included are the naming conventions
that must be followed for the XML Parser to recognize the DTD
extensions.

Delete (button)

The Delete button allows you to delete any sibling or child element that
has not been mapped.

If a sibling or child has child elements associated with it, a warning is
displayed before the delete occurs.

Attention:  If you are deleting any DTD extensions, be sure to
remove the DTD extensions from the corresponding extension
file created for the application or user.  The extra information
will not cause a parser violation, but it is a good practice to
ensure the extension files match the message maps.  Refer to
How to Extend DTDs: page 3 – 109 for the details.
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Conditional Node Mapping Window

Condition.../Delete Condition

If the source definition is based on a DTD with duplicate nodes or
elements of the same name, use Conditional Node Mapping to ensure
that the source–to–target mappings are performed correctly.  This is
required because the sequence of duplicate nodes and elements is not
fixed.

Examples of duplicate nodes that occur frequently in a DTD are
DATETIME, AMOUNT, OPERAMT, and QUANTITY.  Using a
purchase order as an example, the first DATETIME occurrence is for
the Order Date and the second occurrence is for the Promise Date.

Conditional node mapping allows you to define the relationship of the
source node to the target node based on the value of key elements.  The
key elements are identified by the Tag Name and Node Value
combination.  For the purchase order example above, the Tag Name is
”qualifier” and the Node Value is ”PO” for the first DATETIME
occurrence representing the order date.  The Tag Name for the second
DATETIME occurrence is also ”qualifier” with a Node Value of
”PROMDELV” for promise date.

To define the key values, select the source DTD node and click the right
mouse button to invoke the Conditional Node Mapping window.  You
will be prompted for the following:

Select Tag Name from the list of values.

Using the above example, this is the ”qualifier”
attribute associated with the DATETIME segment
that uniquely identifies the node and its intended
meaning.

Tag Name
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Enter the node value.

Using the above example, this is either ”PO” or
”PROMDELV”.

Repeat this process for each of the duplicate nodes and elements.
Message Designer supports one condition per node or element.

To delete the Conditional Node Mapping instruction for a node, select
the node and click the right mouse button to invoke the Delete
Condition function.

Conditional node mapping is applicable to source data definitions that
are based on a DTD or a production XML message.  It does not apply
when the source data definitions are based on database views or tables.

Transaction Map – Target Definition

The target definition selected or created using the Map Creation
Wizard is displayed in the Target Definition Tab.  The target definition
can be extended to perform the following:

• Provide default values

• Create duplicate nodes and elements using the Add Sibling
button

• Add fields using the Add Child button

• Delete unused and unmapped DTD elements to prevent parser
violations

• Implement optional Confirmation Business Object Document
(BOD)

Once the target data definition is complete, it can be saved for reuse in
other message maps.  Use the File > Save (Data Definition) menu
option or the toolbar equivalent.  Use the File > Properties menu option
to change the default directory or data definition property values if
necessary.

If you do not wish to save the target data definition as an entity
independent of the message map, then continue with the mapping
process and save the transaction map at the end of the Element
Mapping process.

Node Value
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Target Definition Considerations

1. Refer to How to Map a Pass–Through Message: page 3 – 111, for
guidelines related to developing a pass–through transaction.

2. Refer to How to Map to an API: page 3 – 112 for guidelines for
mapping an inbound message to an Application API (as opposed to
mapping to Application Open Interface tables).

3. Refer to How to Implement the OAG Confirmation Business Object
Document: page 3 – 113, for details on how to implement the
optional confirmation message.

4. For DTD elements defined using ”|” as the occurrence indicator,
make sure you select one element from the choice list and delete
the unused elements.  The parser will validate that only one
element is used.

5. Delete DTD data types and elements that are not used and
therefore not mapped.  If not deleted, these elements will appear as
empty tags in the resulting message.

6. If you decide not to delete DTD data types and elements that are
not used and not mapped, default the data type or element
attribute to ”OTHER”.  The parser requires the attribute even
though the data type or element is optional.
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Target Definition Tab

Field

Field identifies the name of the element, document, or root.  The names
are based on the Application Open Interface table column names or
DTD element names.

The field name can be changed if necessary, however, consider what
this change implies.  Because the field is based on the database column
name or a DTD element name, corresponding changes may be
necessary in Oracle Applications or the DTD.  The only changes
allowed to a DTD are to the USERAREA.  Refer to How to Extend
DTDs: page 3 – 109 for details.

The first row is reserved for the Data Definition name (if target is based
on Application Open Interface) or DTD root element name (if target is a
DTD).
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Additional field names are displayed when sibling or child elements
are added using the Add Sibling or Add Child buttons.

Item Type

Item type identifies the field as either a Level or an Element.  Level
represents the parent in a parent–child relationship.  Element represents
the child in a parent–child relationship.

The Item Type of the first row is defaulted to Level.  The default value
cannot be changed.

If the target is based on Application Open Interface tables, the Item
Type for the tables is defaulted to ”Level”.  The Item Type for the
columns is defaulted to ”Element”.

If the target is based on a DTD or a production XML message, the
default Item Type is ”Element”.  DTDs do not support levels and
therefore the levels must be explicitly defined by setting the Item Type
to ”Level”.

Any node that represents a collection of data that repeats (for example,
PO lines or shipment lines) represents a level.  The Item Type for the
node must be set to ”Level”.

For the OAG standard, change the Item Type of the following to
”Level” to support Level Mapping:

• Root

• CNTROLAREA

• DATAAREA

Make the same change for all other DTD data types identified as data
levels during the map analysis process.

The Item Type for a new sibling or child element is defaulted to
”Element”.  Change the Item Type setting where appropriate.

Default

Enter a default value for the field as appropriate.  This value is used
only if the incoming value is null.

If the target is a DTD, use the Default column to set the DTD attribute
values.  The values will be displayed with the corresponding attribute
tags when the message is created.
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Set the default using a conditional action if the default value is based
on a condition.  See Transaction Map – Actions: page 3 – 64 for details
on setting a default using a conditional action.

If Item Type is Level, the Default column is disabled.

Data Type

Each field is defined with a data type.  The data types supported by the
XML Gateway Execution Engine are VARCHAR2, DATE, NUMBER,
and CHAR.

If the target is based on Application Open Interface tables, the data
type is defaulted to the data type defined for the database column.

If the target is based on a DTD or a production XML message, the data
type is defaulted to VARCHAR2.

Attention:  There is no need to change the DTD element’s data
type until XML schemas are supported by the XML standards
bodies which will make data types more meaningful.

The Data Type for a new sibling or child element is defaulted to
VARCHAR2.  Change the data type if necessary.

If Item Type is Level, the Data Type column is disabled.

DB Column

DB Column is available only when the target is based on Application
Open Interface tables.

A check mark indicates the column is defined in the Oracle Application
data model.  This setting informs the XML Gateway Execution Engine
whether to validate the element against the Oracle Application data
model or not.

If the Item Type is Level, the DB Column is disabled.

Node Type

Node Type is available only when the target is a DTD.  The default is
the DTD setting.

The valid values are Element or Attribute.  Elements contain the
business data.  Attributes contain qualifiers for the business data to
indicate the intended meaning of the business data.

The Node Type for a new sibling or child element is defaulted to
”Element”.  Change the Node Type setting where appropriate.
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If Item Type is Level, the Node Type column is disabled.

Add Sibling (button)

The Add Sibling button allows you to add new fields required to
complete the map.  This feature is also used to create duplicate DTD
nodes such as PARTNER.

The same can be done if the target is Application Open Interface tables.

When the target is based on a DTD or production XML message, and
you are adding a sibling between two attributes, set the Node Type for
the new field to ”Attribute”.  The default Node Type of ”Element” will
cause a parser violation.

Attention:  You cannot add a sibling to the root node.

Note:  Refer to How to Extend DTDs: page 3 – 109 for details on
how to extend a DTD.  Included are the naming conventions
that must be followed for the XML Parser to recognize the DTD
extensions.

Add Child (button)

The Add Child button adds child elements to an existing sibling or
child.

This function can be used if the target is Application Open Interface
tables or a DTD.

If Node Type is ”Attribute”, the Add Child button is disabled.  You
cannot define an attribute for an attribute.

Note:  Refer to How to Extend DTDs: page 3 – 109 for details on
how to extend a DTD.  Included are the naming conventions
that must be followed for the XML Parser to recognize the DTD
extensions.

Delete (button)

The Delete button deletes any sibling or child element that has not been
mapped.

If a sibling or child has child elements associated with it, a warning is
displayed before the delete occurs.

Attention:  If you are deleting any DTD extensions, be sure to
remove the DTD extensions from the corresponding extension
file created for the application or user.  The extra information
will not cause a parser violation, but it is a good practice to
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ensure the extension files match the message maps.  Refer to
How to Extend DTDs: page 3 – 109 for the details.

Transaction Map – Level Mapping Tab

In the Level Mapping tab, the source definition is presented in the left
window and the target definition in the right window.  Use the Level
Mapping tab to relate the source hierarchy to the target hierarchy.

Select the source level and drag it to the desired target level.  The
source level name and the mapped icon will appear to the right of the
target level name indicating the level is mapped.
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If this does not occur as described, you have not set the DTD entity
Item Type to ”Level”.  Return to the Source or Target Definition tab and
set the Item Type accordingly, then resume with Level Mapping.

To unmap a mapped level, simply select the mapped level on the target
window and drag it back to the source level.

Level Mapping Guidelines for OAG DTDs

1. For the outbound messages using the OAG standard, map the
ECX_OAG_CONTROLAREA_V view to the DTD CNTROLAREA
data type.  This step is not required for inbound messages because
the content of the DTD CNTROLAREA is not stored in the Oracle
E–Business Suite.

2. If you anticipate multiple documents in a message, map the
database header view to the OAG document header data type.  If
you anticipate a single document in a message, map the database
header view to the OAG DATAAREA data type.

Level Mapping Guidelines to Collapse Levels

Multiple source levels can be mapped to the same target level.  This is
commonly referred to as collapsing levels.  For example, if your source
is 3 levels and your target is 2 levels you can collapse the levels as
shown in the following figure:

Correct Way to Collapse Levels               Incorrect Way to Collapse Levels

In the correct example above, there are three source levels and two
target levels.  Source Level 1 is mapped to Target Level 1.  Source
Levels 2 and 3 are mapped to Target Level 2.  The result of collapsing
levels is that the data in Source Levels 2 and 3 are consolidated and
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mapped to Target Level 2.  If there are two rows in Source Level 2 and
three rows in Source Level 3, a total of six rows will be created in Target
Level 2.

In the example showing the incorrect collapsing of levels, Source Level
3 is mapped over Target Level 2 to Target Level 1.

Another option shown below is to relate Source Levels 1 and 2 to
Target Level 1 and relate Source Level 3 to Target Level 2.  (Do not map
Source Levels 1 and 3 to Target Level 1, crossing over Target Level 2.)

Correct Way to Collapse Levels               Incorrect Way to Collapse Levels

Whichever option you choose, consider what it means to promote
lower level detail data to a higher level.  The lower level data may need
to be aggregated to be meaningful at the higher level.

Level Mapping Guidelines to Expand Levels

One source level can be mapped to multiple target levels.  This is
commonly referred to as expanding levels.  For example, if your source
is two levels and your target is three levels you can expand the levels as
shown in the following figure:
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Correct Way to Expand Levels                 Incorrect Way to Expand Levels

In the correct example above, Source Level 1 is mapped to Target Level
1 and Source Level 2 is mapped to Target Levels 2 and 3.  The result of
expanding levels is that the data in Source Level 2 is distributed and
mapped to Target Levels 2 and 3.  If there are two rows in Source Level
2, two rows will be created in Target Level 2 and Target Level 3.

In the example showing the incorrect expansion of levels, Source Level
1 is mapped to Target Level 1 and Target Level 3, crossing over Target
Level 2.

Another option, shown below, is to distribute Source Level 1 to Target
Levels 1 and 2 and map Source Level 2 to Target Level 3.  (Do not map
Source Level 1 to Target Levels 1 and 3, crossing over Target Level 2.)

Correct Way to Expand Levels                Incorrect Way to Expand Levels

Whichever option you choose, consider what it means to demote data
from a higher level to a lower level of detail.  The higher level data may
need to be deaggregated to be meaningful at the lower level.
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Transaction Map – Element Mapping

If the Element Mapping tab is not available, it is an indication that you
have not completed at least one level mapping in the Level Mapping
process.  Return to the Level Mapping tab to complete the process and
then resume with Element Mapping.

Once the Level Mapping process is complete, the source definition is
presented on the left window and the target definition is presented on
the right window.  The source and target hierarchies defined in the
Level Mapping tab are displayed.  Use the Element Mapping tab to
create the message map.

Select the source element and drag it to the target element.  Pay special
attention to any predefined node conditions (such as Conditional Node
Mapping) to ensure that duplicate nodes are mapped to the correct
target entities.  The source element name and mapped icon will appear
next to the target element name indicating the element is mapped.
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To unmap a mapped element, select the mapped element on the target
window and drag it back to the source element.

Element Mapping Guidelines

1. Do not map a lower level element to a higher level element.  The
lower level element values are not available until the header level
elements are completely processed.

2. A higher level element can be mapped to a lower level element.
However, you may need to manipulate the higher level element
value to make it meaningful in the context of a detail level element.

For example, if the the header level element is invoice total and the
line level element is invoice line total, the header invoice total must
be distributed across the invoice lines based on the line quantity for
it to be meaningful in the context of invoice lines.

3. One source element can be mapped to multiple target elements.

4. Review the source elements containing Conditional Node Mapping
instructions.  Map the source element to the target element
associated with the condition.

For the outbound messages (where the source is the database and
the target is a DTD) using the OAG standard, map the
ECX_OAG_CONTROLAREA_V view columns to the DTD
CNTROLAREA data type elements.  This step is not required for
inbound messages (where the source is a DTD and the target is the
database) because the content of the DTD CNTROLAREA is not
stored in the Oracle E–Business Suite.

The view column names are similar to the DTD CNTROLAREA
data type element names, so this is one–to–one mapping.  Add the
following required Actions to complete the map:

• Use the Convert to OAG DATETIME action to convert the
Oracle date to the CNTROLAREA DATETIME element.

• Use the Assign Next Sequence Value action to assign the next
sequence value from ECX_REFERENCE_ID to the
CNTROLAREA REFERENCE_ID element.

• Use the Append Where Clause action to bind the transaction
type and transaction subtype to the
ECX_OAG_CONTROLAREA_V view.

Use the Define Transactions form to define the transaction and
transaction subtype that represent the Oracle name for the message.
Associated with the internal name for the message are the external type



3 – 62 Oracle XML Gateway User’s Guide

and subtype that represent the message name in the XML standard of
choice.

For OAG, the external subtype corresponds to the BSR VERB and the
external type corresponds to the BSR NOUN.  The names entered on
the Define Transactions form are stored in the database and accessed
by the ECX_OAG_CONTROLAREA_V view.  The values are displayed
in the Message Designer as default values for the BSR VERB and BSR
NOUN elements.

Refer to the Define Transactions Form: page 4 – 12 for the details and
observe the recommended naming conventions.

Element Mapping Icons

Message Designer uses an icon group to help you determine the status
of a map at a glance.  The components of the icon group are as follows:

Mapped Element icon. 

Action Defined icon. 

Code Conversion Enabled icon. 

The components will be displayed as on or off (grayed out) within the
group icon to indicate the status of the element.  The possible
combinations of features and the corresponding appearance of the icon
group are shown below:

Element is only mapped.

Element is mapped and has an action defined.

Element is mapped, has an action defined, and is enabled for code
conversion.

Element only has an action defined.

Element is only enabled for code conversion.

Element has an action defined and is enabled for code conversion.
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Element is mapped and is enabled for code conversion.

Note:  Icons showing ”enabled for code conversion” will be
implemented in a future release.

Element Mapping and Actions

As part of the element mapping process, Actions for data
transformation and process control can be defined.

The following three sections are available for your reference.  First time
users should read all three sections.  Experienced users should use the
Map Action Editor section and reference the action type of interest.

• Transaction Map – Actions: page 3 – 64

– Summary of XML Gateway Supported Actions: page 3 – 64

– Source or Target Action: page 3 – 64

– Action Levels: page 3 – 65

– XML Gateway Execution Engine processing sequence: page
3 – 65

• Map Action Editor – Overview: page 3 – 67

– How to Invoke the Map Action Editor: page 3 – 67

– Map Action Editor Components: page 3 – 68

• Map Action Editor – Available Actions: page 3 – 69

At the completion of the element mapping process, use the File > Save
(Transaction Map) menu option or the Save icon to save the map onto
the file system.  The name of the map (.xgm) file should be the same as
the map name for easy reference.  Follow the map naming conventions
as follows:

• Product mnemonic or user ID

• Transaction subtype as entered in the Define Transactions form

• XML standard and version used (such as OAG, Rosettanet, iFX)

• Outbound or inbound message

Given a map name of:

AR_INVO_OAG70_OUT

the map file name is:

AR_INVO_OAG70_OUT.xgm



3 – 64 Oracle XML Gateway User’s Guide

Use the File > Properties menu option to change the default directory
or map name if necessary.

The transaction map and the associated DTDs are now ready to load
into the XML Gateway repository.  The message maps will be used by
the XML Gateway Execution Engine to create or to consume XML
messages.

Refer to How to Load Message Maps and DTDs: page 3 – 118 for details
on loading a message map created by the Message Designer and its
associated DTDs into the XML Gateway repository.

Transaction Map – Actions

As part of the element mapping process, Actions for data
transformation or process control can be defined.

Actions are similar to prebuilt functions in that they may be called to
perform a specific activity.

Oracle XML Gateway supports actions for data transformation
involving math functions, string manipulation, and data conversion
between Oracle’s data format and OAG’s data format.

Oracle XML Gateway supports a set of predefined actions for process
control.  This includes user–defined procedure and function calls to
extend the integration with the Oracle E–Business Suite.  Other
common process control actions allow you to inquire on the status of a
transaction and to manage the process flow based on the status.  For
serious errors, the transaction can be aborted with error messages
returned to the sender via an Oracle Workflow process.

The actions supported by Oracle XML Gateway are listed in Appendix
B.

Source or Target Action

Most Actions are defined on the target side of the Element Map with
the exception of the Append Where Clause action type, which is
defined on the source side of the Element Map if the source is based on
database views or tables.

See Map Action Editor – Append Where Clause: page 3 – 76 for a
detailed description of this action and how to define it.
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Action Levels

An Action may be defined for any of the following entities:

• Element

An element is the smallest unit of a message.  An action defined
at the element level is applied to that element only.

• Document

A document is a collection of elements representing a business
document.  An action defined at the document level is applied to
the document.

• Root

A root represents a collection of documents.  An action defined
at the root level is applied to all documents contained by the
root.

Some actions are designed to be applied to the element only, while
others are intended for the document only.

XML Gateway Execution Engine Processing Sequence

The processing sequence of a three–level document by the XML
Gateway Execution Engine is described in the following table.

Refer to Pre Process, In Process, and Post Process Tabs: page 3 – 69, for
a description of process stages.
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Level Stage

Root Pre–Process

Root In–Process

Header Pre–Process

Header In–Process

Header Post–Process

Line Pre–Process

Line In–Process

Line Post–Process

Line Detail Pre–Process

Line Detail In–Process

Line Detail Post Process

Root Post–Process

Given the processing sequence described above, header data is
processed before line data and line data is processed before detail data.
Any upper level data element that has a dependency on lower level
data elements (for example, sum of invoice lines) must be processed
using an API call at the upper level.  Once the upper level data is
processed, it cannot be updated, although it can always be accessed.
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Map Action Editor

How to Invoke the Map Action Editor

In the Element Mapping tab, select the entity (element, document,
level) and click the right mouse button to invoke the Map Action Editor
popup window.  The prompts presented by the Map Action Editor will
vary based on the Action type selected.
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Overview

The Map Action Editor has the following common components:

• Pre Process, In Process, Post Process Tabs

• Available Actions (left window)

• Selected Actions (right window)
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• Right and Left Shuttle Buttons

• Up and Down Arrows for the Selected Actions Window

• Optional Conditional Expression

• Action Operands

• Window Buttons: OK and Cancel

Pre Process, In Process and Post Process Tabs

An Action can be applied at any of the following stages of message
creation or consumption:

• Pre Process

A preprocess action is executed before the message is created or
consumed.

The Create Global Variable action is an example of a preprocess
action.  The variable must be defined before you can use it.

• In Process

An in–process action is executed during message creation or
consumption.

The Math and String Functions are examples of in–process
actions that are used to manipulate a value.

• Post Process

A postprocess action is one that is executed after the message is
created or consumed.

The Insert into Database Table action is an example of a
postprocess action: The row cannot be inserted into the database
until all the data for the row has been processed.

Select the appropriate Map Action Editor Window Tab for the map
entity (element, document, root) selected.

Available Actions (left window)

The available action categories for the selected process stage and
selected map entity are displayed.  Expand each category to view all
the available action types.

The following table summarizes all action types sorted by Action Level
and Action Stage.  A ”Y” indicates the action type is available for the
Action Level and Action Stage Combination.  An ”N” indicates the
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action type is not available for the Action Level and Action Stage
combination. 

Action Category & 
Description

Element 
In Process

Document
Pre Process

Document
In Process

Document
Post Process

Root 
Pre Process

Root 
In & Post
Process

Assignment: Assign variable
value

Y Y Y Y Y Y

Assignment: Create global
variable

N N N N Y N

Database Function: Assign
next sequence value

Y Y Y Y Y Y

Database Function: Append
where clause

N DB Source N N N N

Database Function: Insert into
database table

N N N Y N N

Derivations Y N N N N N
Function Call Y Y Y Y Y Y
Math Functions Y Y Y Y Y Y
OAG Standard Conversions Y N N N N N

Other: Exit Program Y Y Y Y N Y

Predefined Variable Y Y Y Y Y Y
Procedure Call Y Y Y Y Y Y

Return Error Message Y Y Y Y Y Y
String Functions Y Y Y Y Y Y

XSLT Transformation N N N N N Y(Post)

Selected Actions (right window)

To move an action type from Available Actions to Selected Actions,
select the desired action type from the left window and click the right
shuttle button.

To deselect a selected action type, select the desired action type from
the right window and click the left shuttle button to move the selected
action type from Selected Actions back to Available Actions.

Up and Down Arrows for the Selected Actions Window

A given entity (element, document, root) may have one or more
Actions defined for it.  The XML Gateway Execution Engine processes
the Actions in the sequence defined, from the beginning of the list
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proceeding downward to the last action type on the list.  Use the up
and down arrows within the Selected Actions Window to change the
sequence of the Actions defined for a given entity.  Use the left shuttle
button to deselect a Selected Action if necessary.

Optional Condition Expression: 
If <Operand 1><Operator><Operand 2>

Each Action may be defined as a conditional action.  The condition is
expressed as two operands.  An operand may be a variable (source,
target, or global variable) whose value is determined at runtime, or a
literal value.

For each condition operand, click on the (...) icon to the right of the
operand field to invoke the Element window.  The Element window
allows you to select a variable or provide a literal value.

Refer to Action Operands – Element Window: page 3 – 72 for details
regarding the Element window.

The operators supported by Oracle XML Gateway are listed in the
following table:

Operator Description

= Equal

!= Not Equal

> Greater Than

< Less Than

>= Greater Than or Equal To

<= Less Than or Equal To

Is NULL Null

Is NOT NULL Not Null

Enter the two operands and select the operator if a condition
expression is required.

Compound conditions can be defined by comparing two operands and
storing the result in a variable (source, target, or global).  You then
compare the value in the variable with the next condition operand.
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Result Variable

Some Actions have result variables defined and some do not.  Those
that do not have a result variable defined will use one of the action
operands as the result variable.

The result variable is the left–most field of the action operand.  The
only exception occurs in the Convert To actions where the result
variable is the right–most field.  Per User Interface standards, the result
variable field is greyed, but is enabled for data entry.

For element–level Actions, the selected source or target variable is
displayed as the default result variable.  You can change the variable
name as necessary.

For document–level or root–level actions, the result variable is blank.
Click on the (...) icon to the right of the field to invoke the Element
window.  Select the source, target, or global variable as the result
variable.  The value of the result variable is determined at runtime.

The result variable cannot be a literal value.

Refer to Action Operands – Element Window: page 3 – 72 for details
regarding the Element window.

Action Operands – Element Window

An Action may or may not have operands associated with it.

For Actions that do have operands associated with them, the number
of operands varies by action type.  Click on the (...) icon to the right of
the operand field to invoke the Element window.
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The Element window allows you to select a variable or provide a literal
value.  The Element window is presented in four parts as follows:

• Radio button for Literal, Variable, or Global Variable

• Field for literal value (available only when Literal radio button is
selected)

• Window display for source and target variables

• Element window Buttons: OK, Cancel, Clear

The default radio button setting is Variable.  You can change the default
by selecting a Literal (if available for the action type selected), or Global
Variable (if defined).

The Literal radio button is enabled only if a literal value is applicable
for the action type selected.  Enter the literal value and click OK.

When the Variable radio button is enabled, you are presented with the
source and target variables.  Select the source or target variable name
and click OK.  The value for the selected variable is determined at
runtime.

The Global Variable radio button is enabled only if global variables are
defined for the message map.  Select the Global Variable from the list of
values and click OK.  The value for the selected global variable is
determined at runtime.
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Map Action Editor Window Buttons: OK, Cancel, Clear

The OK button is disabled until all required operand values are
available.

The Cancel button cancels any activity and closes the window.

The Clear button is used to remove the source variable, target variable,
global variable, or literal entered for the operand.

Map Action Editor – Assignments: Assign Variable Value

The Assign Variable Value action assigns a value to the result variable
identified.  The value may be based on another variable (source, target,
or global variable) or a literal value.

If you are assigning a literal value as a default value to be applied
universally (without a condition expression), you have the option to set
the default value in the Transaction Map form using the Source or
Target Definition tab.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the assigned value.

Action Operands

Select the variable (source, target, or global variable) or enter the literal
value to assign to the result variable.
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Map Action Editor – Assignments: Create Global Variable

The Create Global Variable action allows you to define a variable
available to both the source and target.  A default value may be
assigned to the variable or the variable may get its value from the
Assign Variable Value action.

Once a global variable is defined, it is included in the Element window
as another option in addition to the existing options for Literal values
or Variables (source or target).  The Element window appears for any
Action that requires you to identify the operands.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Global Variable Name

Enter a global variable name and select the data type for the variable.
The valid data types supported by the XML Gateway Execution Engine
are VARCHAR2, NUMBER, DATE, and CHAR.

Attention:  Define a unique and meaningful name that does
not contain a reserved word and is not a predefined variable.
Once the variable name is defined and stored for the map, it
cannot be changed.

However, if necessary, you can delete the Create Global
Variable action containing the incorrect variable name and then
add a new action containing the correct name.

Default Value

Enter a default value if applicable.
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Map Action Editor – Database Functions: Assign Next Sequence Value

Oracle Applications defines database sequences to maintain counters
for document numbers such as PO or invoice number.  When inserting
documents into the Oracle Application Open Interface tables, the next
available document number is required.

The Assign Next Sequence Value action retrieves the next available
sequence number from the database sequence identified and assigns it
to the result variable.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the next value of the
sequence identified.

Next Value of Sequence

Identify the database sequence name.  The function will assign the next
value from the sequence to the result variable.

Map Action Editor – Database Functions: Append Where Clause

The Append Where Clause action is used for outbound messages only.
It is used to pass the document selection criteria to the database views
used in the transaction map.

The Append Where Clause action is defined in the source at the
document level as a preprocess activity.  The bind variables and bind
values are set up in advance of the document being processed.  The
actual bind to the database views occurs as an in–process activity when
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the data becomes available.  The default where clause of ”where 1=1” is
appended at runtime to dynamically construct the where clause based
on the selection criteria provided.

Each Append Where Clause action accepts one set of a bind variable
and a bind value.  To pass multiple selection criteria, you must define
multiple Append Where Clause actions.

The document selection criteria are based on parameters used in the
triggering process.  The parameters are as listed in the following table:

Parameter Description

transaction_type Document identifier.  This identifier is defined using the
Define Transactions form.

transaction_subtype Document subtype identifier.  This identifier is defined
using the Define Transactions form.

party_id Trading partner identifier.  This identifier is defined using
the Define Trading Partner form.

parameter1 – parameter5 Reserved for future use.

debug_mode Indicates which debug mode to use.  Valid settings are:
Off
Low
Medium
High
High level offers the greatest amount of trace detail and is
meant for use by technical analysts.

A bind variable is required for each parameter used as a selection
criterion.  In most cases, this would include transaction_type,
transaction_subtype, and document_id.  If party_site_id and party_id
are available in the database view and you wish to use them as
selection criteria, then define a bind variable for each.

The following table shows an example:

Where Clause Bind
Variable

Bind Value

and ECX_OAG_CONTROLAREA_V.TRANSACTION_TYPE
=:TTYPE

TYTPE transaction_type

and ECX_OAG_CONTROLAREA_V.TRANSACTION_SUB-
TYPE =:SUBTYPE

SUBTYPE transaction_sub-
type

and <APPS_HEADER_V>.<document id> =:DOCID DOCID document_id
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Note:  For this method, use the Create Global Variable action to
define variables to store the bind value.  The global variables
must be defined with the exact spelling of the parameters.  In
this example, the global variables are transaction_type,
transaction_subtype, and document_id.

Other source variables not related to the triggering process can be used
as bind values to ensure that the correct document is selected from the
Oracle Application database.

An alternate way to define the where clause if you know the key values
is as follows:

Where Clause Bind
Variable

Bind Value

and ECX_OAG_CONTROLAREA_V.TRANSACTION_TYPE
=’POO’

Blank Blank

and ECX_OAG_CONTROLAREA_V.TRANSACTION_SUB-
TYPE =’POOB’

Blank Blank

and ECX_PO_HEADERV.PO_NUMBER =’A754739’ Blank Blank

Note:  Literal strings must be bound by single quotes.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Where Clause

Identify the where clause to bind the database views used for the
outbound message.  This where clause will be appended to the default
where clause of ”where 1=1”.
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Bind Variable

Identify the bind variable to be used by the where clause.

Bind Value

Identify the bind value to be assigned to the bind variable used by the
where clause.

The bind value is a global variable whose value is determined at run
time, or a literal value.

Map Action Editor – Database Functions: Insert into Database Table

The Insert into Database Table action is used for inbound messages to
insert the data into Application Open Interface tables identified in the
message map.

This action must be executed once for each target level identified in the
Transaction Map – Level Mapping tab.  If the target has three levels
(header, line, and line detail), then it must be executed three times.

You can identify a condition for the Insert into Database Table action,
but the action can have no additional operands.

The inserts are performed by the XML Gateway Execution Engine but
are not committed to the database until the entire document is
processed.  This eliminates the possibility of inserting a partial
document into the database.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Map Action Editor – Derivations: Derive Address ID from Location Code

The Derive Address ID from Location Code action is used for inbound
messages only.  It uses the source location code and associated address
type to derive the address and organization ID meaningful to the target
Oracle Application.  The IDs are meaningful in the context of Oracle
Applications only.  The sender is not expected to know a valid address
or organization ID.

If the parent table ID for the customer or supplier site is also required
by the Application Open Interface, use the Derive Parent ID from
Location Code action to derive it.
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Location code is commonly used to refer to the address site represented
by the physical address.  Using location codes eliminates the need to
include the physical address in an XML message.  For OAG messages,
the location code is commonly found in the PARTNRID element of the
PARTNER data type.

The Derive Address ID from Location Code action will access all
trading partner locations across all organizations to derive the address
ID.  If the source location code is found in multiple organizations, the
action will produce an error because it cannot uniquely identify an
address ID.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Derive Target Address ID

Identify the target variable to store the address ID derived from the
source location code.  The value for the target variable is determined at
runtime.

The target variable cannot be a global variable unless you are using it
as a temporary variable to populate multiple application columns with
the same value.  The target variable cannot be a literal value.

Derive Target ORG ID

Identify the target variable to store the organization ID derived from
the source location code.  The value for the target variable is
determined at runtime.

The target variable cannot be a global variable unless you are using it
as a temporary variable to populate multiple application columns with
the same value.  The target variable cannot be a literal value.
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From Source Location Code

Identify the source variable containing the location code.  The source
variable can be a global variable, whose value is determined at
runtime, or a literal value.

With the Address Type of

Select the address type from the list of values.  The valid address types
are as follows:

• Customer

• Supplier

• Internal Location

• Bank Branch

This address type is used by the XML Gateway Execution Engine to
determine the appropriate Oracle address data model to access to
derive the address ID.

Map Action Editor – Derivations: Derive Parent ID from Location Code

The Derive Parent ID from Location Code action is used for inbound
messages only.  It derives the Parent ID associated with the site level
source location code.

For example, given a SOLD–TO site in the XML message, this action
will derive the parent customer associated with it.

Keep in mind that IDs are meaningful in the context of Oracle
Applications only.  The sender is not expected to know a valid parent
ID.
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See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Derive Target Parent ID

Identify the target variable to store the parent ID derived from the site
level source location code.  The value for the target variable is
determined at runtime.

The target variable cannot be a global variable unless you are using it
as a temporary variable to populate multiple application columns with
the same value.  The target variable cannot be a literal value.

From Source Location Code

Identify the source variable containing the location code.  The source
variable can be a global variable, whose value is determined at
runtime, or a literal value.

With the Address Type of

Select the address type from the list of values.  The valid address types
are as follows:

• Customer

• Supplier

• Internal Location

• Bank Branch

This address type is used by the XML Gateway Execution Engine to
determine the appropriate Oracle address data model to access to
derive the address ID.

Map Action Editor – Function Call: Execute Function Call

The Execute Function action calls a system function (for example,
FND_GLOBAL.USER_ID) or any application function to perform an
activity and return the result to the result variable.

Function calls with parameters are not supported by the Execute
Function Call action.

Procedure calls are not supported by the Execute Function Call action.
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Note:  See Map action Editor – Procedure Call: Execute
Procedure: page 3 – 100 for details on how to enable a
procedure.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the function return
value.

Value Returned by Function

Identify the name of the Function.  The value returned by the function
will be assigned to the result variable.

Map Action Editor – Math Functions

Oracle XML Gateway supports the four basic math functions: addition,
subtraction, multiplication, and division.

Each math function supports two operands.  The example below shows
the division function.  The Add, Subtract, and Multiply functions will
display the appropriate operators.
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If the mathematical expression requires more than two operands,
compute the expression two operands at a time, store the result in a
temporary variable (source, target, or global), and then join the values
in the temporary variables.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the result of the
mathematical computation.

Action Operands

Identify the two operands and the math function desired.

Each operand may be a variable (source, target, or global variables if
defined) whose value is determined at runtime, or a numeric literal
value.

Map Action Editor – Convert to OAG DATETIME

The Convert To OAG DATETIME action converts the Oracle
Application representation for date to the OAG representation for date.

The OAG representation for date is as follows:

DATETIME (qualifier, type, index, YEAR, MONTH, DAY, HOUR,
MINUTE, SECOND, SUBSECOND, TIMEZONE)

The Convert to OAG DATETIME action converts the single column
Oracle Application date to the OAG DATETIME segment as follows:
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• The DATETIME attributes for qualifier, type, and index must be
set as default values in the Target Definition tab of the
Transaction Map window.

• The DATETIME elements for YEAR, MONTH, DAY, HOUR,
MINUTE, SECOND, and SUBSECOND are derived based on the
Oracle Application date value.

• The DATETIME element for TIMEZONE is defaulted to –7 or –8
from GMT to represent Pacific Standard Time.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Convert Source Datetime

Identify the source date/time element to be converted into the OAG
DATETIME format.  The source can be a literal value defined using the
Oracle Application date format.

Target and global variables do not apply although they are available in
the Element window.

The converted value will be assigned to the target DATETIME element
selected when the action was invoked.

Map Action Editor – Convert to OAG OPERAMT

The Convert To OAG OPERAMT action converts the Oracle application
representation for operating amount to the OAG representation for
operating amount.
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The OAG representation for operating amount is as follows:

OPERAMT (qualifier, type, VALUE, NUMOFDEC, SIGN, CURRENCY,
UOMVALUE, UOMNUMDEC, UOM)

The Convert to OAG OPERAMT action converts the single column
Oracle Application operating amount to the OAG OPERAMT segment
as follows:

• The OPERAMT attributes for qualifier and type must be set as
default values in the Target Definition tab of the Transaction Map
window.

• The OPERAMT elements for VALUE, NUMOFDEC, SIGN,
UOMVALUE, and UOMNUMDEC are derived based on the
Oracle Application operating amount value.

• The OPERAMT elements for CURRENCY and UOM are
prompted for.  If the appropriate Oracle Application columns are
available, the values from the columns can be mapped to the
CURRENCY and UOM elements.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Convert Source Operating Amount

Identify the source operating amount element to be converted into the
OAG OPERAMT format.  The source can be a literal value.

Target and global variables do not apply although they are available in
the Element window.

The converted value is assigned to the target OPERAMT element
selected when the Action was invoked.
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Source Currency

Identify the source currency code element if available or a literal value
to be used by the Convert To OAG Action.

If an Oracle Application column is available, the value from the column
can be mapped to the CURRENCY element.

If no Oracle Application column is available, the XML Gateway
Execution Engine will leave the element blank.

Target and global variables do not apply although they are available in
the Element window.

Source Unit of Measure

Identify the source unit of measure code element if available or a literal
value to be used by the Convert To OAG Action.

If an Oracle Application column is available, the value from the column
can be mapped to the UOM element.

If no Oracle Application column is available, the XML Gateway
Execution Engine will default the unit of measure code to EACH as
recommended by OAG.

Target and global variables do not apply although they are available in
the Element window.

Map Action Editor – Convert to OAG QUANTITY

The Convert To OAG QUANTITY action converts the Oracle
Application representation for quantity to the OAG representation for
quantity.

The OAG representation for quantity is as follows:

QUANTITY (qualifier, VALUE, NUMOFDEC, SIGN, UOM)

The Convert to OAG QUANTITY action converts the single column
Oracle Application quantity to the OAG QUANTITY segment as
follows:

• The QUANTITY attribute for qualifier must be set as a default
value in the Target Definition tab of the Transaction Map
window.

• The QUANTITY elements for VALUE, NUMOFDEC, and SIGN
are derived based on the Oracle Application quantity value.
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• The QUANTITY element for UOM is prompted for.  If the
appropriate Oracle Application column is available, the value
from the column can be mapped to the UOM element.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Convert Source Quantity

Identify the source quantity element to be converted into the OAG
QUANTITY format.  The source can be a literal value.

Target and global variables do not apply although they are available in
the Element window.

The converted value is assigned to the target QUANTITY element
selected when the action was invoked.

Source Unit of Measure

Identify the source unit of measure code element if available, or a literal
value to be used by the Convert To OAG Action.

If an Oracle Application column is available, the value from the column
can be mapped to the UOM element.

If no Oracle Application column is available, the XML Gateway
Execution Engine will leave the element blank.

Target and global variables do not apply although they are available in
the Element window.
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Map Action Editor – Convert to OAG AMOUNT

The Convert To OAG AMOUNT action converts the Oracle
Application representation for amount to the OAG representation for
amount.

The OAG representation for amount is as follows:

AMOUNT (qualifier, type, index, VALUE, NUMOFDEC, SIGN,
CURRENCY, DRCR)

The Convert to OAG AMOUNT action converts the single column
Oracle Application amount to the OAG AMOUNT segment as follows:

• The AMOUNT attribute for qualifier, type, and index must be
set as default values in the Target Definition tab of the
Transaction Map window.

• The AMOUNT elements for VALUE, NUMOFDEC, and SIGN
will be derived based on the Oracle Application amount value.

• The AMOUNT element for CURRENCY and DRCR are
prompted for.  If the appropriate Oracle Application columns are
available, the values from the columns can be mapped to the
CURRENCY and DRCR elements.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Convert Source Amount

Identify the source amount element to be converted into the OAG
AMOUNT format.  The source can be a literal value.
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Target and global variables do not apply although they are available in
the Element window.

The converted value is assigned to the target AMOUNT element
selected when the action was invoked.

Source Currency

Identify the source currency code element if available or a literal value
to be used by the Convert To OAG Action.

If an Oracle Application column is available, the value from the column
can be mapped to the CURRENCY element.

If no Oracle Application column is available, the XML Gateway
Execution Engine will leave the element blank.

Target and global variables do not apply although they are available in
the Element window.

Source Credit/Debit

Identify the source credit/debit flag if available or a literal value to be
used by the Convert To OAG Action.

If an Oracle Application column is available, the value from the column
can be mapped to the DRCR element.

If no Oracle Application column is available, the XML Gateway
Execution Engine will derive the setting based on the amount value.

Target and global variables do not apply although they are available in
the Element window.

Map Action Editor – Convert from OAG DATETIME

The Convert From OAG DATETIME action converts the OAG
representation for date to the Oracle Application representation for
date.

The OAG representation for date is as follows:

DATETIME (qualifier, type, index, YEAR, MONTH, DAY, HOUR,
MINUTE, SECOND, SUBSECOND, TIMEZONE)

The Convert From OAG DATETIME action converts the OAG
DATETIME segment to the single Oracle Application date column as
follows:
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• The DATETIME qualifier attribute can be used to determine the
appropriate Oracle Application date column to use.

• The DATETIME attributes for type and index are not used by
Oracle Applications.

• The DATETIME elements for YEAR, MONTH, DAY, HOUR,
MINUTE, SECOND, and SUBSECOND are used to construct the
Oracle Applications date value.

• The DATETIME element for TIMEZONE is not used by Oracle
Applications.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Convert OAG Datetime

Identify the source DATETIME element to be converted into the Oracle
Application format.  The source can be a literal value.

Target and global variables do not apply although they are available in
the Element window.

The converted value is assigned to the application (target) date element
selected when the action was invoked.
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Map Action Editor – Convert from OAG OPERAMT

The Convert From OAG OPERAMT action converts the OAG
representation for operating amount to the Oracle Application
representation for operating amount.

The OAG representation for operating amount is as follows:

OPERAMT (qualifier, type, VALUE, NUMOFDEC, SIGN,
CURRENCY, UOMVALUE, UOMNUMDEC, UOM)

The Convert From OAG OPERAMT action converts the OAG
OPERAMT segment to the single Oracle Application operating amount
column as follows:

• The OPERAMT qualifier attribute can be used to determine the
appropriate Oracle Application operating amount column to use.

• The OPERAMT type attribute is not used by Oracle
Applications.

• The OPERAMT elements for VALUE, NUMOFDEC, SIGN,
UOMVALUE, and UOMNUMDEC are used to construct the
Oracle Applications operating amount value.

• The OPERAMT elements for CURRENCY and UOM can be
stored in Oracle Applications if the appropriate columns are
available.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Convert OAG Operating Amount

Identify the source OPERAMT element to be converted into the Oracle
Application format.  The source can be a literal value.
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Target and global variables do not apply although they are available in
the Element window.

The converted value is assigned to the application (target) operating
amount element selected when the action was invoked.

Target Currency

The source OPERAMT value is represented as a collection of
subcomponents.  Identify the application (target) element to store the
currency code.  Literal values are not allowed.

If an application (target) element is identified, the Convert From OAG
Action will move the source currency code to it.

If no application (target) element is identified, the source currency code
will be ignored.

Target Unit of Measure

The source OPERAMT value is represented as a collection of
subcomponents.  Identify the application (target) element to store the
unit of measure code.  Literal values are not allowed.

If an application (target) element is identified, the Convert From OAG
Action will move the source unit of measure code to it.

If no application (target) element is identified, the source unit of
measure code will be ignored.

Map Action Editor – Convert from OAG Quantity

The Convert From OAG QUANTITY action converts the OAG
representation for quantity to the Oracle Application representation for
quantity.

The OAG representation for quantity is as follows:

QUANTITY (qualifier, VALUE, NUMOFDEC, SIGN, UOM)

The Convert From OAG QUANTITY action converts the OAG
QUANTITY segment to the single Oracle Application quantity column
as follows:

• The QUANTITY qualifier attribute can be used to determine the
appropriate Oracle Application quantity column to use.
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• The QUANTITY elements for VALUE, NUMOFDEC, and SIGN
are used to construct the Oracle Applications quantity value.

• The QUANTITY element for UOM may be stored in Oracle
Applications if an appropriate column is available.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Convert OAG Quantity

Identify the source QUANTITY element to be converted into the Oracle
Application format.  The source can be a literal value.

Target and global variables do not apply although they are available in
the Element window.

The converted value is assigned to the application (target) quantity
element selected when the action was invoked.

Target Unit of Measure

The source QUANTITY value is represented as a collection of
subcomponents.  Identify the application (target) element to store the
unit of measure code.  Literal values are not allowed.

If an application (target) element is identified, the Convert From OAG
Action will move the source unit of measure code to it.

If no application (target) element is identified, the source unit of
measure code will be ignored.
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Map Action Editor – Convert from OAG AMOUNT

The Convert From OAG AMOUNT action converts the OAG
representation for amount to the Oracle Application representation for
amount.

The OAG representation for amount is as follows:

AMOUNT (qualifier, type, index, VALUE, NUMOFDEC, SIGN,
CURRENCY, DRCR)

The Convert From OAG AMOUNT action converts the OAG
AMOUNT segment to the single Oracle Application amount column as
follows:

• The AMOUNT qualifier attribute can be used to determine the
appropriate Oracle Application amount column to use.

• The AMOUNT attributes for type and index are not used by
Oracle Applications.

• The AMOUNT elements for VALUE, NUMOFDEC, and SIGN
are used to construct the Oracle Applications amount value.

• The AMOUNT elements for CURRENCY and DRCR can be
stored in Oracle Applications if appropriate columns are
available.

Note:  The source and target elements are implicitly mapped
via the Action.  Additional element mapping will overwrite the
original Action instructions.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.
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Convert OAG Amount

Identify the source AMOUNT element to be converted into the Oracle
Application format.  The source can be a literal value.

Target and global variables do not apply although they are available in
the Element window.

The converted value is assigned to the application (target) amount
element selected when the action was invoked.

Target Currency

The source AMOUNT value is represented as a collection of
subcomponents.  Identify the application (target) element to store the
currency code.  Literal values are not allowed.

If an application (target) element is identified, the Convert From OAG
Action will move the source currency code to it.

If no application (target) element is identified, the source currency code
will be ignored.

Target Credit/Debit

The source AMOUNT value is represented as a collection of
subcomponents.  Identify the application (target) element to store the
credit/debit flag.  Literal values are not allowed.

If an application (target) element is identified, the Convert From OAG
Action will move the source credit/debit flag to it.

If no application (target) element is identified, the source credit/debit
flag will be ignored.

Map Action Editor – Other: Exit Program

The Exit Program action can be executed based on the result of
executing a Procedure call, Function call, or retrieving the value of a
Predefined Variable.

The Exit Program action rolls back the current transaction and exits the
XML Gateway Execution Engine.

The Exit Program action has no additional operands.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.
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Map Action Editor – Get Predefined Variable Value

The Get Predefined Variable Value action maintains predefined
variables for the following:

• Inbound message envelope

• Code conversion status

• Transaction status

The values of these predefined variables are maintained by the XML
Gateway Execution Engine and are available for inquiry and mapping
to the Application Open Interface table column or Application API
parameter.

You can control the process flow based on the values found in the
predefined variables.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the value of the
predefined variable selected.

Predefined Variables

Select the predefined variable whose value you are interested in.  The
variables exposed by the XML Gateway Execution Engine are as
follows:

Code Conversion Return Status for

Select the source column enabled for code conversion.  The code
conversion process will search the trading partner–specific code
conversions and then search the master code conversion list.
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The status of the code conversion is assigned to the result variable.  The
return status codes are shown in the following table:

Return
Status Code

Description

0 Code conversion was successful.

1 Code conversion process failed to find a match for the source value, the
source value is copied to the target column.    

This is a warning only.  It will not stop the XML Gateway Execution En-
gine.  However, you may wish to take some action to control the process
flow based on this failure.    

The possible causes of this failure are: invalid code category passed to the
code conversion API or code conversion cross–reference not found.    

Verify that the code category identified for the source column is valid
(Refer to Appendix A) and that a code conversion cross–reference is de-
fined in the master list or trading partner–specific list.  Make the neces-
sary corrections to prevent this error from occurring again.

2 Code conversion process encountered unexpected error.

Check the process log file for the details, make the necessary correction,
and reprocess the message.

Internal Control Number

The Internal Control Number is a system–generated number that
uniquely identifies the XML message being processed.  This number is
useful for sending acknowledgments, for document audits, for
document archival, and for troubleshooting.

The value for the Internal Control Number is assigned to the map
result variable.

Return Code

The Return Code is the error code associated with the error message.
The error message may be returned to the trading partner contact or
the XML Gateway system administrator using the Return Error
Message action.

Multiple return codes are concatenated in a single predefined variable.
The value for the the Return Code is assigned to the result variable.

The possible return codes are shown in the following table:
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Return Code Description

0 Success

1 Warning.  The XML Gateway Execution Engine will not be stopped.

2 Failure.  Check the process log file for the details, make the necessary
corrections, and reprocess the message.

Return Message

The Return Message is the text associated with the error code.  The
error message may be returned to the trading partner contact or the
XML Gateway system administrator using the Return Error Message
action.

Multiple return messages can be concatenated in a single predefined
variable.  The value for the Return Message is assigned to the result
variable.

Receiver Trading Partner ID

The Receiver Trading Partner ID is a unique identifier for the receiver
of the XML message.  The ID can be used to derive the trading partner
name and other pertinent data.

The Receiver Trading Partner ID is maintained for outbound messages
and pass–through messages.

The value for the Receiver Trading Partner ID is assigned to the result
variable.

Use the ecx_trading_partner_pvt.get_receivers_tp_info
procedure to derive the Party ID, Party Site ID, Organization ID, and
Administrator e–mail Address associated with the Receiver Trading
Partner ID.  Refer to Procedure Call: Execute Procedure: page 3 – 100 for
more details.

Sender Trading Partner ID

The Sender Trading Partner ID is a unique identifier for the sender of
the XML message.  The ID may be used to derive the trading partner
name and other pertinent data.

The Sender Trading Partner ID is maintained for inbound messages
and pass–through messages.

The value for the Sender Trading Partner ID is assigned to the result
variable.
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Use the ecx_trading_partner_pvt.get_receivers_tp_info
procedure to derive the Party ID, Party Site ID, Organization ID, and
Administrator e–mail Address associated with the Sender Trading
Partner ID.  Refer to Procedure Call: Execute Procedure: page 3 – 100 for
more details.

Organization ID

The Execution Engine derives the organization ID associated with the
Sender or Receiver Trading Partner ID.  The combination of the
organization ID and the Sender or Receiver Trading Partner ID
uniquely identifies a trading partner in the Oracle E–Business Suite.

Map Action Editor – Procedure Call: Execute Procedure

The Execute Procedure action calls a procedure to perform an activity.
Some procedures have input (send) parameters as well as output
(return) parameters, while others have no parameters at all.

The Execute Procedure action connects to the database to provide a list
of available procedures for selection.  Once you select the procedure,
you will be prompted for the parameter values.

Function calls are not supported by the Execute Procedure action.

Special Uses of the Execute Procedure Action

1. Call Application Open Interface validation API

The Execute Procedure action can be used to call an Application
Open Interface API to validate data previously inserted using the
Insert to Database Table action.

This approach is used for inbound messages involving Application
Open Interface tables.  For inbound messages involving an
application API (as opposed to Application Open Interface tables),
refer to How to Map to an API: page 3 – 112 for additional
instructions.

2. Call XML Gateway API to get Sender’s Trading Partner
Information

The Execute Procedure action can be used to call an XML Gateway
API to get the sender’s Trading Partner information.  The XML
Gateway package and procedure name are as follows:

• Package:  ecx_trading_partner_pvt



3 – 101Message Designer

• Procedure:  get_senders_tp_info

The procedure does not require any input parameters.  It will use
the Sender Trading Partner ID from the message envelope
(available in the Sender Trading Partner ID predefined variable) to
derive and return the following:

• Party ID

• Party Site ID

• Organization ID

• Administrator e–mail address

The return parameter values can be mapped to the desired
Application Open Interface table column or Application API
parameter.

3. Call XML Gateway API to get Receiver’s Trading Partner
Information

The Execute Procedure action can be used to call an XML Gateway
API to get the receivers’ Trading Partner information.  The XML
Gateway package and procedure name are as follows:

• Package:  ecx_trading_partner_pvt

• Procedure:  get_receivers_tp_info

The procedure does not require any input parameters.  It will use
the Receiver Trading Partner ID from the message envelope
(available in the Receiver Trading Partner ID predefined variable)
to derive and return the following:

• Party ID

• Party Site ID

• Organization ID

• Administrator e–mail address

The return parameter values can be mapped to the desired
Application Open Interface table column or Application API
parameter.

4. Raise Business Event

The Execute Procedure action is used for inbound message maps as
the last action to set Event Details signalling the successful
completion of the inbound process.  A corresponding event
subscription defined in the Oracle E–Business Suite application
module consumes this event.
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Refer to Integrating Oracle XML Gateway with Oracle Workflow
Business Event System: page 7 – 2.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Procedure Name

Procedure name identified in the Assign Parameter Value window will
be returned here.

Assign Parameters/View Parameters

Click the Assign Parameter Value button to invoke the Get Procedure
Parameters window.  Enter the database access information and
identify the package and procedure name.  The database access
parameters are shown in the following table:

Parameter Description

Username Enter the user name for the database schema to be accessed.

Password Enter the password associated with the user name.

Connect to Database Enter the connect string for the database to be accessed.

Host Enter the host name for the database to be accessed.

Port A default port will be displayed, change it if necessary.

Schema Name Enter the schema name containing the required procedure.
Procedures can be selected from any schema.

Package Name Enter the package name for the procedure.

Procedure Name Enter the procedure name.
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After connecting to the database, the parameters for the selected
procedure will be prompted for in the Get Procedure Parameters
window.

If the procedure identified is defined with one signature (also known as
the parameter list), enter the parameter values in the Get Procedure
Parameters window.

For overloaded procedures, all available procedures with that name are
presented.  Expand all the procedures by clicking on the + to review the
signatures.  Select the procedure and click OK to invoke the Get
Procedure Parameters window.

Regardless of how the parameters are defined in the procedure, a value
is required (by the XML Gateway Execution Engine) for each parameter
with a Parameter Type of IN unless a default value is provided by the
procedure.  The value can be based on a source variable, target
variable, global variable (if defined), or a literal value.  The value for
the source, target, or global variable is determined at run time.
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For parameters defined with default values, you can provide another
variable or literal value if you wish to overwrite the default value.

Once you have entered all the required parameter values, click OK to
return to the Map Action Editor window.  The procedure selected is
displayed in the Procedure Name field.  Click on the View Parameters
button to review the parameter values entered.  Verify the parameter
values, make any necessary corrections, and click OK to exit.

For procedures with return variables (Parameter Type of OUT), define
temporary variables or use existing variables (source, target, or global)
to store the return values.  Status return values can be used to redirect
the process flow based on severity.  Return error codes and messages
can be sent to the XML Gateway system administrator or Trading
Partner contact using the Send Error Message action.

The XML Gateway Execution Engine supports parameters with a data
type of VARCHAR2, DATE, and NUMBER.  If the required procedure
contains parameters of unsupported data types, the parameter values
must be converted to a supported data type in order to utilize this
action.

Map Action Editor – Return Error Message: Send Error Message

The Send Error Message action sends an error message to either the
Trading Partner contact or the XML Gateway system administrator
identified in the ECX_SYS_ADMIN_EMAIL system profile.

Error messages can be obtained from the following sources:

• Return parameter of a procedure call

• Status of a function call

A Workflow e–mail notification containing the error message is sent to
the party identified in the To prompt.
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See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Send Error Message

Identify the variable containing the error message to be sent.  The error
message can be represented as a literal.

When using this action in conjunction with the Procedure Call action,
the variable may be a return parameter or a literal value.

When using this action in conjunction with the Function Call action,
the variable may be the function return value or the value contained in
the RETURN_MESG variable maintained by the XML Gateway
Execution Engine.

You can concatenate several strings such as the value in
RETURN_MESG with a literal value to form a complete message.

To

Identify the recipient of the error message.  The valid options are the
Trading Partner contact or the XML Gateway System Administrator
identified in the System Profile identified in the
ECX_SYS_ADMIN_EMAIL system profile.

Map Action Editor – String Functions: Perform Concatenation

The Perform Concatenation action concatenates the values in two
operands.  The operands can be based on variables whose values are
determined at runtime, or based on literal values.

To concatenate more than two operands, start with the first two
operands and store the result in a variable (source, target, or global).
Then concatenate the value in the variable with the next operand.

The Perform Concatenation action can be applied to fields of any data
type because the XML Gateway Execution Engine will convert the
value to VARCHAR2 before performing the action.
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See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the resulting
concatenated string.

First Operand

Identify the first operand.

The operand can be a variable (source, target, or global variable if
defined) whose value is determined at runtime, or a literal value.

Concatenated With

Identify the second operand to be concatenated with the first operand.

The operand can be a variable (source, target, or global variable if
defined) whose value is determined at run time, or a literal value.

The concatenated value is assigned to the result variable.

Map Action Editor – String Functions: Perform Substring

The Perform Substring action parses a given string from a start position
and includes the characters within the length specified.  The resulting
substring is returned.

The Perform Substring action can be applied to fields of any data type
because the XML Gateway Execution Engine will convert the value to
VARCHAR2 before performing the action.
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See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

Result Variable

Select the source, target, or global variable to store the resulting
substring.

Element

Identify the operand requiring substring action.

The operand can be a variable (source, target, or global variable if
defined) whose value is determined at runtime, or a literal value.

Start Position

Enter a start position greater then 0 but less than the maximum length
of the Element.

With Length

Enter a length greater than 0 but less than or equal to the maximum
length of the Element minus the start position.

The substring function will process the element identified from the
start position up to the length specified and assign the resulting
substring to the result variable.

Map Action Editor – XSLT Transformation

XML Gateway supports XSLT transformations for outbound messages
by allowing you to apply an XSLT style sheet to the XML message
before it is sent to the message delivery provider for transmission to
the trading partner.
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The file containing the XSLT style sheet must be stored in the DTD
directory defined by the ECX_UTL_XSLT_DIR system profile.  The
XML Parser applies the transformation as the last activity performed
before the message is sent.

See Map Action Editor – Overview: page 3 – 67 for details on the
common components of the window.

XSLT Style Sheet

Enter the name of the style sheet containing the transformation
instructions.
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How to Extend DTDs

The XML Gateway Message Designer supports mapping to and from a
DTD or an existing XML message.  The use of an existing production
XML message provides visibility to all the DTD extensions as well as
duplicate nodes and elements necessary to support the actual business
document.  The use of a DTD is necessary if an existing XML message
is not available.  Using a DTD may require adding duplicate nodes,
new segments, or elements to accommodate additional data.

When modifying an Oracle built message map or when creating a new
message map where DTD extensions are necessary, follow the DTD
extension guidelines outlined below.  The Open Applications Group
(OAG) has very strict guidelines regarding DTD extensions.

The only DTD extensions allowed are in the USERAREA.  You can add
elements in the appropriate OAG defined USERAREA or create new
USERAREAs under the OAG defined USERAREA.

Refer to the OAG guidelines section 2.11 titled ”USERAREA
Extensions” in the Open Application Group’s Integration Specification
(available at http://www.openapplications.org).

Use USERAREAs to support descriptive flexfields as well as other
extensions not related to flexfields.

The OAG guidelines are as follows:

Top Level Name <vendor.transaction.context.USERAREA>

Element Name <vendor.elementname>

Reference File Name <vendor prefix>_<product>_<version>.dtd

Oracle’s adaptation of the OAG guidelines is as follows:

Top Level Name for
Descriptive Flexfield
Extensions

<Oracle.transaction.name of flexfield.USERAREA>
 Example: Oracle.ARInvoice.ARLINES.USERAREA

Element Name <Oracle.attribute*>
where * is the number of attributes defined for the table

Top Level Name for other
Extensions

<Oracle.transaction.product_prefix.USERAREA>
Example: Oracle.ARInvoice.AR.USERAREA

Element Name <Oracle.elementname>

Reference File Name Oracle_<application shortname>DTDExtensions_<ver-
sion>.dtd
Example: Oracle_ARDTDExtensions_001.dtd
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XML Gateway provides a template to be used as the basis to create the
application–specific DTD extensions.  The template contains a
definition for the generic flexfields named ”attribute*” where * is the
number of attributes defined for the table.  The application–specific
DTD extension files are source–controlled with the specific application.

The application–specific DTD extension file can be updated as follows:

• Top level USERAREA names representing the application table
containing the descriptive flexfields

• Descriptive flexfield names

• Top level USERAREA names for other extensions

• Element names for other extensions

The updates must be added after the existing USERAREA tag.

Use Conditional Node Mapping and key on Top Level USERAREA
name to ensure that you are mapping from and to the correct group of
flexfields or application extensions.

Be sure to remove extension definitions from the reference file if you
are removing them from the message map.

Update the message map to incorporate the new fields introduced as a
DTD extension.  The updated message map and DTD extension files
must be loaded in the XML Gateway repository for access by the XML
Gateway Execution Engine.  Refer to How to Load Message Maps and
DTDs: page 3 – 118 for the details.
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How to Map a Pass–Through Message

Pass–through messages are messages that are received by Oracle
Exchange for code conversion (if required) and then routed to their
final destination.  Oracle Exchange acts as a routing hub for these
messages.

The map for a pass–through message is defined as follows:

• Map the highest level only.  The CNTROLAREA is the highest
level in an OAG DTD.

• Load the message map into the XML Gateway repository for
processing.  Refer to How to Load Message Maps and DTDs:
page 3 – 118 for details.

• Define the Exchange hub as the trading partner and enable the
XML message as a pass–through transaction.

• Define the necessary code conversions in Oracle XML Gateway
or Oracle Exchange.
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How to Map to an API

This section describes how to map to an API instead of an Application
Open Interface Table.  Data for an inbound XML message is copied to a
set of staging tables known as Application Open Interface tables.  The
data in these staging tables are validated using an Application Open
Interface API containing the business rules.  Valid data is moved to the
Application base tables.  Invalid data is marked for review.

In the case where the staging table and the validation rules are
embedded in the same code (commonly referred to as the Application
API), data for an inbound XML message is mapped to the parameters
of the Application API.

To map directly to an Application API, the map must be defined as
follows:

• The data definition type for the source and target is XML.

• The source and target DTD and version are the same.  Refer to
How to Load Message Maps and DTDs: page 3 – 118 to load the
DTDs into the XML Gateway database.

• Map the source levels to the target levels.

• Define a target action for Execute Procedure referencing the
Application API as the procedure name.  The action is defined at
the document level as a postprocess activity.  Map the source
variables to the API parameters.  Include an action to check the
API return status.

Apply this approach for each level of the document.  If the
document has three levels, this approach is applied three times.

• Load the message map into the XML Gateway repository for
processing.  Refer to How to Load Message Maps and DTDs:
page 3 – 118 to load the maps into the XML Gateway repository.

• Define the trading partner and enable the XML message.

• Define any necessary code conversions.

Message Designer does not support Application APIs consisting of
multiple document levels.  Message Designer is designed to process
data one document level at a time.
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How to Implement the OAG Confirmation Business Object
Document

Inbound Confirmation Message

An outbound XML message may include a request for a confirmation
to be returned by the trading partner.  Perform the following to
implement an inbound confirmation message:

• In the Define Trading Partner form, enable the inbound
confirmation message for the Trading Partner.  Set the Document
Confirmation flag to zero (0) (for no) for the inbound
confirmation message to prevent an infinite loop.

The XML Gateway map name for the seeded inbound
confirmation message map is ECX_CBODI_OAG62_IN.

• In the outbound OAG message map, set the CNTROLAREA
CONFIRMATION element per your requirements:

1 = Send back a confirmation Business Object Document (BOD)
only if an error has occurred.

2 = Always send a confirmation Business Object Document
(BOD)

When the inbound confirmation arrives, it will be processed by the
XML Gateway Execution Engine per your map instruction.  Depending
on your business requirements, the map instruction may be one of the
following:

• Insert the data into the base application using the Application
Open Interface API or Application API.

• After the data has been inserted into the base application, trigger
an API to update the base application tables to indicate that the
original outbound message has been processed.

• After the data has been inserted into the base application,
integrate with an existing Workflow process to continue the
application flow.

• After the data has been inserted into the base application, raise a
Workflow Business Event to indicate that the confirmation has
been processed.  Optionally, define a subscription to consume
this event.
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Inbound Confirmation Message Map

ECX_CBODI_OAG62_IN is the name of the seeded map for the
inbound confirmation message.  This map is based on the OAG version
6.2 standards.

The main CNTROLAREA contains information about the inbound
confirmation.  The CNTROLAREA in the DATAAREA contains
information about the original outbound message.

Review the values in the following tags to determine the status of the
original outbound message.  This information may be included in the
map instructions on how to process an inbound confirmation
suggested above.

• CONFIRM_BOD/CONFIRM

STATUSLVL

DESCRIPTN

ORIGREF

USERAREA

• CONFIRM_BOD/CONFIRMMSG

DESCRIPTN

REASONCODE

USERAREA

Outbound Confirmation Message

There are four ways to implement an outbound confirmation message
as follows:

1. Automatically send an outbound confirmation to the trading
partner upon successful insert of data into the Application Open
Interface tables or Application API.  The required XML Gateway
actions must be defined in the inbound message map to trigger the
outbound confirmation.

2. Include in an existing Workflow process a call to raise a Workflow
Business Event to send the confirmation.  This assumes the Internal
Document ID maintained by the XML Gateway Execution Engine
for the original inbound message is available in your application.
Subscribe to the appropriate XML Gateway seeded Workflow
activity to send the document.
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3. Raise a Workflow Business Event to send the outbound
confirmation.  This assumes the Internal Document ID maintained
by the XML Gateway Execution Engine for the original inbound
message is stored in your application.  Subscribe to the appropriate
XML Gateway seeded Workflow activity to send the document.

4. Use the XML Gateway Concurrent Request to trigger the outbound
confirmation.  Provide the same values to the Concurrent Request
as though you are raising the Workflow Business Event.

Deciding which method is appropriate for your environment will
depend on the level of control desired plus the document tracking
information required by your application.

The outline below supports option 1 to automatically send the
outbound confirmation upon successful processing of the inbound
message.

• In the Define Trading form, set the Document Confirmation flag
for the Trading Partner and associated inbound message.  Set the
flag to 1 for send confirmation if error detected, or 2 for always
send confirmation message.

• In the Define Trading Partner form, enable the outbound
confirmation message for the Trading Partner.  Set the Document
Confirmation flag to zero (0) (for no) for the outbound
confirmation message to prevent an infinite loop.

The XML Gateway map name for the seeded outbound
confirmation message map is ECX_CBODO_OAG62_OUT.

• In the inbound OAG message map, add the following actions:

Refer to Map Action Editor – Overview: page 3 – 67 for details
regarding the action types identified below.

– Use the Get Predefined Variable action to determine the
status of the Insert to Database Table action.  The valid
values are as follows:

0 = Success

2 = Failure

• Get the value of the CONFIRMATION flag in the
CNTROLAREA.  The valid values are as follows:

0 = No confirmation Business Object Document requested

1 = Send back a confirmation Business Object Document
(BOD) only if an error has occurred.
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2 = Always send a confirmation Business Object Document
(BOD)

Do not proceed further if the CONFIRMATION flag is set to
0 for ”no confirmation requested.”

• If the Insert to Database Table action was successful (Return
Code = 0) and the CONFIRMATION flag was set to 2 for always,
return a confirmation message indicating the inbound message
was processed successfully.

If the Insert to Database Table action failed (Return Code = 2)
and the CONFIRMATION flag was set to 1 or 2 for error or
always, return a confirmation message indicating XML Gateway
was not able to process the inbound message successfully.

– Use the Get Predefined Variable action to get the Internal
Document ID maintained by the XML Gateway Execution
Engine.  This is the unique identifier for the inbound
message.  This value is used in the outbound message to
relate the outbound confirmation to the original inbound
message.

– Use the Execute Procedure action to raise the Workflow
Business Event to trigger the outbound confirmation.

See Integrating Oracle XML Gateway with Oracle Workflow
Business Event System: page 7 – 2.

The XML Gateway Execution Engine validates the trading
partner and verifies that the outbound confirmation
message is enabled for the trading partner.  If the
confirmation is requested on the inbound message, but this
is inconsistent with the trading partner definition, the
confirmation will be sent.  The seeded
ECX_CBODO_OAG62_OUT map is used to create the
outbound confirmation message.

– Check the return parameter values for the event procedure
call:

RETCODE

ERRMSG

If the procedure failed, check the procedure call and
parameter values, make the necessary corrections, and
reprocess the message.
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Outbound Confirmation Message Map

ECX_CBODO_OAG62_OUT is the name of the seeded map for the
outbound confirmation message.  This map is based on the OAG
version 6.2 standards.

The main CNTROLAREA contains information about the outbound
confirmation.  The CNTROLAREA in the DATAAREA contains
information about the original inbound message.

Review the map to determine if the default setting is appropriate for
your implementation.  The following fields were not mapped as they
relate to your specific implementation.  Adjust the map accordingly
and reload the updated map.

Refer to How to Load Message Maps and DTDs: page 3 – 118 for details.

• CONFIRM_BOD/CONFIRM

STATUSLVL

DESCRIPTN

ORIGREF

USERAREA

• CONFIRM_BOD/CONFIRMMSG

DESCRIPTN

REASONCODE

USERAREA
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How to Load Message Maps and DTDs

Loading a Map

Oracle message maps are delivered and installed on the $APPLTOP.
They are automatically loaded into the XML Gateway repository using
the LoadMap program.  A map can be deleted using the DeleteMap
program.

If you modified an Oracle prebuilt message map or created a new
message map using the Message Designer, these maps are saved on
your local file system.  Perform the following steps to load the maps
into the XML Gateway repository for use by the XML Gateway
Execution Engine:

1. Move <mymap>.xgm file from the local file system to the middle
tier.  The apps.zip file containing the maps that were installed on
the $APPLTOP is installed on the middle tier.

2. Execute java LoadMap<DB username><DB
password><Hostname>:<Port>:<SID><mymap.xgm> to load
the message map into the XML Gateway repository.  LoadMap will
replace existing maps with the same name.

Example: java LoadMap User1 welcome
ap222sun.us.oracle.com:1521:ORA1151<mymap.xgm>

A map can be deleted using the DeleteMap program as follows:

1. Execute java DeleteMap <DB username><DB
password><Hostname><:<Port>:<SID><mapcode> to delete a
message map from the XML Gateway repository.  LoadMap will
replace existing maps with the same name, but obsolete maps with
a different name must be deleted manually.

<mapcode> is the map name entered in the Message Designer.

Example: java DeleteMap User1 welcome
ap222sun.us.oracle.com:1521:ORA1151<mapcode>

Loading a DTD

Each message map is associated with a set of DTDs: the main and its
reference DTDs.  Similar to message maps, the DTDs associated with
the Oracle prebuilt message maps are delivered and installed on the
$APPLTOP.  They are automatically loaded into the XML Gateway
database using the LoadDTDToClob program.  A DTD can be deleted
using the DeleteDTDFromClob program.
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To change a DTD referenced in an existing message map, use the File >
Properties menu option of the Message Designer to make the necessary
change.  The updated message map must be loaded into the XML
Gateway repository using LoadMap (refer to Loading a Map: page
3 – 118).  In addition, the new DTD used must be loaded into the XML
Gateway database as follows:

1. Move <mydtd>.dtd file from the local file system to the middle tier.
The apps.zip file containing the DTDs that were installed on the
$APPLTOP is on the middle tier.

2. Execute java LoadDTDToClob<DB username><DB
password><Hostname>:<Port>:<SID><mydtd.dtd><RootEl
ementName><Location> to load the DTD into the XML Gateway
database.  LoadDTDToClob will replace existing DTDs with the
same name.

<RootElementName> is the XML Root Element entered in the
Message Designer.

<Location> is the subdirectory name entered in the Specify XML
File and Root Element window of the wizard.

A DTD can be deleted using the DeleteDTDFromClob program as
follows:

Execute java DeleteDTDFromClob <DB username> <DB
password> <Hostname>:<Port>:<SID><mydtd.dtd>
<RootElementName><Location> to delete a DTD from the XML
Gateway database.  LoadDTDToClob will replace existing DTDs
with the same name, but obsolete DTDs with a different name must
be manually deleted.

<RootElementName> is the XML Root Element entered in the
Message Designer.

<Location> is the subdirectory name entered in the Specify XML
File and Root Element window of the wizard.

LoadMap and LoadDTDToClob are provided as two separate
programs to support various combinations of changes.  To ensure that
the maps and DTDs are synchronized, always execute LoadMap and
LoadDTDToClob as a pair.
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XML Gateway Setup

his chapter does the following:

• Lists the implementation steps

• Explains the XML Gateway setup forms
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Setup Overview

Implementation Checklist

There are ten setup steps for the XML Gateway:

Step Completed Task

1 Define System Profile Values: page 4 – 3

2 Define XML Gateway Responsibility: page 4 – 4

3 Define the utl_file_dir parameters: page 4 – 5 (per-
formed by a DBA)

4 Define Hubs: page 4 – 7

5 Define XML Standards: page 4 – 10

6 Define Transactions: page 4 – 12

7 Define Lookup Values: page 4 – 21

8 Define Trading Partners: page 4 – 24

9 Set up Trading Partner Code Conversion: page 4 – 52

10 Define Standard Code Conversion: page 4 – 48

XML Gateway Forms

There are seven forms in the XML Gateway that you will use to
complete the setup steps:

• System Profile Values: page 4 – 3

• Hub Definitions: page 4 – 7

• Define XML Standards: page 4 – 10

• Define Transactions: page 4 – 12

• Oracle XML Gateway Lookups: page 4 – 21

• Define Trading Partner Setup: page 4 – 24

• Define Code Conversion: page 4 – 48
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Define System Profile Values

The purpose of the Profile System Values form is to define the
following:

• Directory path for XML message and processing log file

• Directory path for XSLT style sheets

• XML Gateway System Administrator e–mail address

• Identify sender’s information system

The following table lists the system profile options:

Profile System Option Description Required Default
Value

ECX: Log File Path Log File Path where the XML
messages and runtime log are
stored

YES None

ECX: XSLT File Path XSLT Path where XSLT style
sheets are stored

YES None

ECX: System
Administrator Email
Address

XML Gateway System Adminis-
trator e–mail address

YES None

ECX_OAG_LOGICALID Identifier for Sender’s Informa-
tion System

NO None

Additional Information:  See Oracle Applications System
Administrator’s Guide.
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Define XML Gateway Responsibility

Have the System Administrator assign the Oracle XML Gateway
responsibility to your user to access the Oracle XML Gateway database
and forms.  Use standard procedures to assign the responsibility.

Additional Information:  See Oracle Applications System
Administrator’s Guide.
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Define UTL_FILE_DIR Parameter

Perform this step in cooperation with a Database Administrator (DBA).

Define UTL_FILE_DIR Parameter in the INIT.ORA File

To use Oracle XML Gateway, you must first create directories where
the XML message process log and XSLT style sheets will be stored.
Oracle XML Gateway uses the UTL_FILE package to read and write to
the server.

UTL_FILE can only write to accessible directories.  The directories are
defined by the utl_file_dir parameter in the init<SID>.ora file.
This file is usually found in the $ORACLE_HOME/dbs directory.  Within
this file, each accessible directory is indicated by a line such as

utl_file_dir = directory_name

The specification of directory_name will vary, depending on the
operating system.  If the operating system is case sensitive, then
directory_name is case sensitive.

The value for directory_name must be a physical directory.  It cannot be
a variable, logical, or an alias.  In addition, the value for directory_name
must match the value defined in the Oracle XML Gateway profile for
ECX_UTL_LOG_DIR File Path (ECX: Log File Path) and
ECX_UTL_XSLT_DIR File Path (ECX: XSLT File Path).

Refer to Define Profile System Values: page 4 – 3 for details.

Example: UNIX Operating System

For example, the following entry is legal for a UNIX operating system,
assuming the directories specified exist:

utl_file_dir = /d1/XML/logs/d1/XML/xslt

In addition to this form of database security, operating system security
must also be considered.  The file I/O operations performed with
UTL_FILE will be done by the Oracle user (the Oracle user is the
owner of the files that are used to run the database, and also the owner
of the processes that make up a database instance).  Consequently, the
Oracle user has to have operating system privileges to read from and
write to all of the accessible directories.  If the Oracle user does not
have privileges for an accessible directory, then any operations in that
directory will be prohibited by the operating system.

To ensure that operating system security allows the Oracle user to
create, delete, rename, read, and write files in the specified directories,
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the DBA must grant directory and file access privileges by issuing the
CHMOD 777 command at the operating system level.  This is a UNIX
example only, so use appropriate operating system commands for your
environment.

The Oracle instance must be brought down and back up for the
changes in the init<SID>.ora file to be effective.
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Hub Definitions Form  

Navigate to the Hub Definitions form from the XML Gateway
Responsibility by selecting Setup > Define Hubs.

A hub is defined as an integration point within your network (either
your intranet or the internet).  Hubs are typically used to route
documents to and from trading partners.  Oracle Exchange is an
example of a hub.  You may also decide to create a private hub within
your intranet through which all your ERP systems communicate.

The Hub Definitions form is used to define the hub and the authorized
users conducting business via the hub.  The hub users entered in this
form will appear on the Trading Partner Setup form: page 4 – 24.

Name (Required)

Enter the Hub name.
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Protocol Type (Required)

Protocol Type is the communication protocol associated with the hub
being defined, such as SMTP and HTTP.  Select a value from the seeded
list of values.  The description for the protocol type is displayed.

Protocol Address

When protocol type is HTTP or HTTPS, protocol address is prompted.

Protocol Address is the complete URL (including service/servlet)
where the Transport Agent will attempt to POST the XML Document.

If the Protocol type is SMTP, the protocol address is an e–mail address.

Hub Users

Username (Required)

Enter the user name of the trading partner conducting business via the
hub.

Password (Required)

Enter the password for this user.  The encrypted password is stored in
the database. The password is not echoed when it is entered.  You will
be prompted on the same field to confirm the password.

Hub Entity Code (Required)

Enter the hub entity code for this user.

Hub Entity Code has the same function as the Source Trading Partner
Location Code: page 4 – 31 in the Trading Partner Setup form: page
4 – 24.  It is the code found in the XML envelope to identify the source
of the message.

For outbound messages, the code represents the sending organization.
For inbound messages, this is the code for your trading partner’s
location from where you receive messages.

If you are sending and receiving messages from a trading partner, you
will have a mixture of your location codes and your trading partner’s
location codes depending on the direction of the message.  For
example, if you are sending messages out, the Source Trading Partner
Location Code is your location code since you are the source of the
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XML message.  If you are receiving messages, the Source Trading
Partner Location Code is your trading partner’s location code since
they are the source of the XML message.

This code is examined for inbound messages during Trading Partner
validation.  When placed on an outbound message, the recipient will
validate it as a valid source location code.

The Hub Entity Code is placed in the PARTY ID field in the XML
Gateway envelope: page 5 – 6.
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Define XML Standards Form  

Navigate to the Define XML Standards form from the XML Gateway
Responsibility by selecting Setup > Define XML Standards.

This form defines standards bodies for XML messages, such as OAG.

The Standard Code entries made in this form will appear in a list of
values for the Standard Code field in the following forms:

• Define Transactions form: page 4 – 12

• Trading Partner Code Conversion form: page 4 – 52 (accessed via
the Define Trading Partner Setup form)

• Standard Code Conversion form: page 4 – 48

The Define Transactions form identifies the creating organization of the
DTD, and hence, the XML message structure.  The values entered in
the Define XML Standards form will be the list of values for the
Standard Code field in the Define Transactions form.

In the Trading Partner Code Conversion form and the Standard Code
Conversion form, this value is used as part of the search key to access
the code conversion tables.

Standard Code will also be the default standard code used in Standard
Code Conversion table searches, when the Standard Code is assigned
to the entries in the Define Transactions form.

Standard Code (Required)

This field is the name or code for the standard’s body for the XML
messages.

Only XML Standards are entered in this form with the exception of the
value UNIVERSAL.  The seeded value UNIVERSAL is needed for the
Standard Code Conversion form to identify universally used codes,
such as ISO codes.
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Standard Type

Standard Type is any appropriate value that you choose.

Description

Enter a description of the standard.
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Define Transactions Form  

Navigate to the Define Transactions form from the XML Gateway
Responsibility by selecting Setup > Define Transactions.

The Define Transactions form defines transactions that will be used by
the XML Gateway Execution Engine.  These transactions will then be
associated with the trading partner in the Trading Partner Setup form.

The Define Transactions form provides the following:

• A cross–reference between the external transaction identifiers
and the internal Oracle transaction identifiers.

• Identification of the queue from which to retrieve inbound
messages or on which to place outbound messages.

Cross–Reference Transaction Identifiers

This form provides a cross–reference between internal Oracle
transaction identifiers, represented by the Transaction Type and
Transaction Subtype, and External Transaction Types and External
Transaction Subtypes.

Note:  The data element pair of External Transaction Type and
External Transaction Subtype, and the data element pair of
Transaction Type and Transaction Subtype are not a one–to–one
cross–reference by similar data element names.  It is the
combination of each pair that is significant to respectively
identify the external representation of the XML message, or the
internal representation to identify the transaction to the Oracle
Application.

For example: The following is an inbound message with a Party Type of
”CUSTOMER”: OAG PROCESS_INVOICE_003.  The message has the
External Transaction Type ”PROCESS” and External Transaction
Subtype ”INVOICE.”  The inbound direction is determined by the XML
Gateway.

The External Transaction Type ”PROCESS” and External Transaction
Subtype ”INVOICE” will be matched to Transaction Type and
Transaction Subtype equal to AP and INI as they are defined in the
Define Transactions form.  For this trading partner, the message map
defines on which tables in Oracle Payables to place the inbound data.

Another example is an outbound message with a Party Type of
”SUPPLIER”:
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Invoice transaction from Oracle Receivables has the Transaction Type
”AR” and the Transaction Subtype ”INO.”  The outbound direction is
determined by the XML Gateway.

This Transaction Type and Transaction Subtype will be matched to the
External Transaction Type ”INVOICE” and External Transaction
Subtype ”PROCESS” as defined in the Define Transactions form for the
specified trading partner.  For this trading partner, the message map
identifies what data to extract from Oracle Receivables.

The Party Type, Transaction Type, and Transaction Subtype are key
codes used by Oracle Applications to integrate with the Workflow
Business Event System (BES) to trigger message creation or message
consumption.

Queues

Different queues can be defined for various transactions from the
application, or for XML messages to be transmitted.  The queue names
are assigned to the transactions via this form.

 See Message Queues: page 6 – 2.
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Party Type (Required)

Party Type defines the type of trading partner, such as Supplier,
Customer, Bank, or internal locations (such as warehouses).  Select a
value from the list of values.

Transaction Type (Required)

Transaction Type is the product short name for the base Oracle
Application associated with the transaction, such as ”AR” for Oracle
Receivables.  Refer to Transaction Type and Transaction Subtype
Naming Conventions: page 4 – 16.

If you are using OAG standards, refer to Setting VERB and NOUN in
OAG Standards: page 4 – 19.
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Transaction Subtype (Required)

Transaction Subtype is a code for a particular transaction within the
application specified by the Transaction Type.  The last position of the
code represents the direction of the transaction: ”I” for inbound, ”O”
for outbound.

See Transaction Type and Transaction Subtype Naming Conventions:
page 4 – 16.

The combination of the Transaction Type and the Transaction Subtype
identifies an Oracle transaction with which to associate this message.
This data will appear on the Trading Partner Setup form.

If you are using OAG standards, refer to Setting VERB and NOUN in
OAG Standards: page 4 – 19.

Transaction Description

Enter a description for the transaction.

Standard Code (Required)

Standard Code is the code that was set up in the Define XML
Standards form: page 4 – 10.  Choose the code from the list of values.

Direction (Required)

Direction indicates if the message is inbound or outbound.  Select ”IN”
for inbound messages, or ”OUT” for outbound messages from the list
of values.

External Transaction Type (Required)

External Transaction Type is the primary external identifier for the
XML message.

The combination of the External Transaction Type and the External
Transaction Subtype should cross–reference this message to the Oracle
internal transaction identified by the Transaction Type and the
Transaction Subtype.

External Transaction Subtype (Required)

External Transaction Subtype is the secondary external identifier for the
XML message.
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The combination of the External Transaction Type and the External
Transaction Subtype should cross–reference this message to the Oracle
internal transaction identified by the Transaction Type and the
Transaction Subtype.

Queue (Required for Inbound Messages)

A queue is a table in a database where transactions are staged for
processing.  Default queues are defined during installation.  Select a
queue from the list of values.

The field is disabled for outbound messages.

 See Message Queues: page 6 – 2.

Note:  Only queues with a prefix of ECX will display in the list
of values.

Transaction Type and Transaction Subtype Naming Conventions

Naming conventions for Transaction Type and Transaction Subtype are
necessary to facilitate the reading of audit trails and troubleshooting
across applications.

The Transaction Type and Transaction Subtype codes should not focus
on naming conventions based on the standard XML message that is
implemented.  A given transaction from an application may be mapped
to several XML standards based on the trading partner agreements,
likewise for inbound messages.

The following naming conventions are recommended:

Transaction Type

The Transaction Type is the product short name for the base Oracle
Application.  Examples of Oracle Application product short names are
shown in the following table:
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Transaction Type Application

AP Payables

AR Receivables

OM Order Management

PO Purchasing

SS Supplier Scheduling

RLM Release Management

CUSTOM (for user–defined messages)

Transaction Subtype

The Transaction Subtype is a code for a particular transaction within
the application specified by the Transaction Type.  The last position of
the subtype code represents the direction of the transaction: ”I” for
inbound, ”O” for outbound.

The naming convention is XXXXI or XXXXO where XXXX is significant
to the application and its function, such as invoicing to Receivables and
Payables.

For custom transactions, add a prefix to distinguish custom
transactions from the Oracle supplied transactions.

The table below lists Transaction Type and Transaction Subtype
common combinations:
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Transaction
Type
(Application)

Transaction
Subtype
(Transaction)

Transaction Type’s
Processing
Application

Transaction Type’s Processing
Application
(Transaction Code plus
Direction)

PO POCO Purchasing Purchase Order Change, Out-
bound

PO POO Purchasing Purchase Order, Outbound

PO POAI Purchasing Purchase Order Acknowledg-
ment, Inbound

OM POI Order Management Purchase Order, Inbound

OM POCI Order Management Purchase Order Change, In-
bound

OM POAO Order Management Purchase Order Acknowledg-
ment, Outbound

OM POCAO Order Management Purchase Order Change Ac-
knowledgment, Outbound

AR INO Receivables Invoices, Outbound

AP INI Paybables Invoices, Inbound

The actual transaction detail is therefore recognized by its unique
combination of the Transaction Type and Transaction Subtype.  The
Transaction Subtype does not have to be unique across applications,
but only within the application specified by the Transaction Type.

Consequently, both the Purchasing and the Order Management
application can use the same Transaction Subtype (for example, POI)
because they may both import some type of purchase order.  For
example, Order Management will load orders from its customers;
Purchasing may load from another purchasing application.

Additional Suffix on Transaction Subtype

If different database views are used to extract different types of
transaction data, such as a blanket order versus a standard order, or
different XML messages are needed for transactions such as a blanket
order versus a standard order, then you can create different message
maps using the Message Designer.  You may also need to define
different Transaction Subtypes to distinguish between such transactions
in the Transaction setup.

When appropriate, a suffix can be attached to the base Transaction
Subtype following the XXXXI or XXXXO naming convention to further
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distinguish a transaction in the XML Gateway.  For queries in a form, it
is recommended to keep the same base Transaction Subtype XXXXI or
XXXXO, so the Transaction Subtypes will follow each other in queries.

The suffix naming convention is therefore XXXXI–yyyy and
XXXXO–yyyy where yyyy is the suffix.

The following table illustrates the Transaction Subtype naming
convention using a suffix:

Transaction
Type
(Application)

Transaction
Subtype
(Transaction)

Transaction
Type’s
Processing
Application

Transaction Type’s Processing
Application
(Transaction Code plus
Direction)

PO POO–BLK Purchasing Blanket Purchase Order, Out-
bound

PO POO–REL Purchasing Purchase Order Release, Out-
bound

PO POO–STD Purchasing Standard Purchase Order, Out-
bound

For example in a Purchasing application, all types of outbound
purchase orders can be initiated under the general subtype POO with
qualifiers for the various types of purchase orders such as blanket,
standard, and release.  Their subtype codes can be recognized as
POO–BLK, POO–STD, and POO–REL respectively by the process.
Avoid using long suffixes such as –BLANKET, –STANDARD, and
–RELEASE to keep the naming convention simple.  This sample is for
illustration only.

Setting VERB and NOUN in OAG Standards

The following topic discusses sources of data for the OAG
CNTROLAREA.

The VERB and NOUN are key values required in the OAG
CNTROLAREA data type.  XML Gateway provides a database view
that provides key data from the transaction table, while the attribute
values are default values from the DTD used to create the outbound
message map.

The purpose of the database view is to populate the VERB and NOUN
elements illustrated below.
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The Verb and Noun in OAG’s CNTROLAREA

<NOUN value = ”INVOICE”> INVOICE </NOUN>

<VERB value = ”PROCESS”> PROCESS </VERB>

When the External Transaction Type and External Transaction Subtype
are entered into the transaction table through the Define Transactions
form, they can be mapped to the NOUN and VERB value fields
respectively by using the database view
ECX_OAG_CONTROLAREA_V.  See Transaction Map – Element
Mapping: page 3 – 60.

Attention:  Within the OAG CNTROLAREA, the sequence of
fields is VERB then NOUN in the message.  In the Define
Transactions form, the sequence of fields is NOUN in the
External Transaction Type, then VERB in the External
Transaction Subtype.  Be careful not to reverse the order of the
data.
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Define Lookup Values  

To navigate to the Oracle XML Gateway Lookups form from the XML
Gateway Responsibility select Setup > Define Lookup Values.

The Oracle XML Gateway Lookups form allows both entry and display
of seeded data.  This is a standard Oracle Application Object Library
form.

Once a Type is selected in the upper section, its seeded values are
displayed in the Lookup Details section of the form.

Type (Required)

Type is the key code for the element stored in the seeded table.

The XML Gateway seeded lookup types are listed in the following
table:
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Type Description Sample Values

COMM_METHOD Communications Method HTTP, HTTPS, SMTP, NONE

CONFIRMATION_CODE Confirmation Code 0, 1, 2

DOCUMENT Documents/Transactions CBODI and CBODO are seeded by Oracle
XML Gateway:
CBODI (for OAG’s inbound confirmation) 
CBODO (for OAG’s outbound confirmation)

MESSAGE_STANDARD XML Message Standard OAG, RN, UNIVERSAL

MESSAGE_TYPE Message Type XML, EDI, FF (for flat file)

PARTY_TYPE Party Types B (for bank), C (for customer), S (for supplier),
I (for internal location)

TRANSACTION_CODE Transaction Code CBOD for confirmation BOD is the XML Gate-
way seeded transaction code.

User Name (Required)

User name is defined by the user when data is entered.

Application (Required)

The text name for the application responsible for this Type.

Description

Description of the Type.

Access Level

The Access Level restricts changes that are possible to a lookup type.
The possible levels are:

• System – No changes to the lookup codes are allowed.

• Extensible – New lookup codes can be added.  However, you
cannot modify seeded lookup codes.

• User – You can change any lookup code.
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Lookup Details

Code (Required)

The seeded code for the lookup.

Meaning (Required)

The meaning of the lookup code.

Description

Description of the lookup code.

Tag

Not used.

From Effective Date

The starting effective date for the lookup code.

To Effective Date

The expiration date for the lookup code.  The ending date is optional.

Enabled Check Box

Check the box if the Code is enabled.  Remove the check to disable the
Code.
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Trading Partner Setup  

Navigate to the Define Trading Partner Setup form from the XML
Gateway Responsibility by selecting Setup > Define Trading Partners.

The Trading Partner Setup form is used to:

• Enable messages for the trading partner by identifying the
internal and external transaction type and transaction subtype
codes, and the XML standard associated with the message.

• Access the Trading Partner Code Conversion form.

• Select a message map for the trading partner.

• Identify the communications protocol and address for a message.
Optionally, the user can be selected from a hub.

This is the tie that will enable a message to be processed through the
XML Gateway engine.  In the XML Gateway, the term ”Trading
Partner” refers to an entity such as a customer, supplier, bank branch,
or internal locations at a particular address with which you exchange
messages.  Since a given entity may have several locations, you must
define one Trading Partner for each customer address, supplier site, or
bank branch as required for processing transactions by the Oracle XML
Gateway.

During message processing, Trading Partner data is used to:

• Link a particular address location in Oracle Applications to the
Trading Partner definition in the Gateway.

• Provide a means of telling the Execution Engine which Trading
Partner message map to use.

• Enable specific transactions for Trading Partners.

• Determine how to deliver the message.

Note:  Multi–Org Consideration  Trading Partner setup in
XML Gateway is organization–dependent.  The list of Trading
Partners and Trading Partner sites displayed is limited to those
trading partners defined to the organization of the logon
responsibility.

This form defines the parameters for the Trading Partner setup.  The
setup includes the identification of the trading partner site, the
messages enabled for that site, and the delivery mechanism.

The Trading Partner Setup form requires an entry for each Transaction
Type and Transaction Subtype associated with this trading partner.
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The Trading Partner Setup form includes the following data to define
the Trading Partner:

Trading Partner Type (Required)

Trading Partner Type defines the type of trading partner, such as
Supplier, Customer, Bank or internal location.  Once the Trading
Partner Type is selected from the list of values, the Trading Partner
Names and Trading Partner Sites associated with the Trading Partner
Type are displayed in the Trading Partner Name and Trading Partner
Site lists of values below.

Trading Partner Name (Required)

Given the selection in the Trading Partner Type, the appropriate
Trading Partner Names are displayed in the Trading Partner Name list
of values.  For example, if Partner Type is Customer, then customer
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names will be displayed.  These Trading Partners are limited to those
trading partners associated with the organization of your logon
responsibility.  Select the appropriate Trading Partner Name.

Trading Partner Site (Required)

Given the selection in the Trading Partner Name, the appropriate
Trading Partner Sites are displayed in the list of values.  Select the
appropriate Trading Partner Site.

Company Admin Email (Required)

This is the e–mail address of the administration contact to receive
e–mails regarding warnings and errors.  These notifications may be
initiated by Oracle Workflow or by an action defined in the message
map using the Message Designer.  Users should check the error log.

Code Conversion Button

Use the Code Conversion button to access the Trading Partner Code
Conversion form

See: Code Conversion: page 4 – 40

        Trading Partner Code Conversion Form: page 4 – 52

Trading Partner Details

The Trading Partner Setup form includes the following detail for each
message:

Transaction Type (Required)

Transaction Type is the standard product short code for the base Oracle
Application.  These values are defined in the Define Transactions form.
Select a Transaction Type from the list of values.

These values are only used internally to the XML Gateway.  Refer to the
Define Transactions Form: page 4 – 12 for details.

Transaction SubType

The Transaction Subtype associated with the Transaction Type selected
above is displayed.
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Transaction subtype is a code for a particular transaction within the
application specified by the Transaction Type.  The last position
represents the direction of the transaction: I for inbound,  O for
outbound.

The combination of the Transaction Type and the Transaction Subtype
should identify an Oracle transaction with which to associate this
message. These values are defined in the Define Transactions form.

These values are only used internally to the XML Gateway.  Refer to the
Define Transactions Form: page 4 – 12 for details.

Standard Code

The Standard Code associated with the Transaction Type selected
above is displayed.

Standard Code is the code that was set up in the Define XML
Standards form: page 4 – 10.

External Transaction Type

The External Transaction Type associated with the Transaction Type
selected above is displayed.

The External Transaction Type is the primary external identifier for the
XML message.  These values are defined in the Define Transactions
form: page 4 – 12 and they are found in the XML Gateway envelope:
page 5 – 6.

The combination of the External Transaction Type and the External
Transaction Subtype should identify this external message to the Oracle
transaction.

External Transaction Subtype

The External Transaction Subtype associated with the Transaction Type
selected above is displayed.

The External Transaction Subtype is the secondary identifier for the
XML message.  These values are defined in the Define Transactions
form: page 4 – 12 and they are found in the XML Gateway envelope:
page 5 – 6.

The combination of the External Transaction Type and the External
Transaction Subtype should identify this external message to the Oracle
transaction.
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Direction

The Direction associated with the Transaction Type selected above is
displayed.

This code identifies the direction of the transaction.  The value IN
identifies an inbound message, and the value OUT identifies an
outbound message.

Map (Required)

(Message) Map is the name of the map created using Message
Designer.

Select the appropriate map from the list of values.

The naming convention for message maps and their .XGM file names
consists of the four components: Transaction Type, Transaction
Subtype, Standard and Release, and Direction.  For example:
”PO_POO_OAG70_OUT” is the outbound Oracle Purchasing Purchase
Order in the OAG standard, release 7.0.  The direction code OUT
makes the message direction more apparent in any list.

Refer to Message Designer page: 3 – 25 for more details on the naming
convention.

If the desired map does not appear in the list of values, then the map
has not been loaded into the XML Gateway database.  Refer to the How
to Load Message Maps and DTDs: page 3 – 118.
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Connection/Hub (Required for outbound messages only)

A DIRECT connect and a hub are the methods by which the message
can be communicated.  The XML message can be sent directly to a
trading partner, or sent to a trading partner via a hub.  The hub will
then communicate the message to the trading partner.

Select DIRECT to conduct business directly with a trading partner, or
select a hub from the list of values.  If a hub is selected, then select a
trading partner from that hub.

See the Hub Definition form: page 4 – 7 to define hubs.

If you select ”DIRECT”, the following data fields are needed depending
on the protocol type:

• Protocol Type (Required)
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Select the protocol type from the list of values.  This data is
seeded by the XML Gateway.

Protocol type NONE will disable the outbound message for this
trading partner.

• Username (Required)

Enter the destination Username used to log in to the receiving
server for the server that is identified in the server address.

For protocol type HTTP and HTTPS, the Username and
Password are required fields.

For protocol type SMTP, the e–mail address is a required field.  It
may be entered in the Username field.

• Password (Required)

Enter the Password for the destination Username.  The password
is not echoed when it is entered.  You will be prompted on the
same field to confirm the password.

For protocol type HTTP and HTTPS, Password is a required
field.

• Protocol Address (Required)

Protocol Address is the complete URL (including
service/servlet) where the Transport Agent will attempt to POST
the XML Document.  If the Protocol is SMTP, the protocol
address is an e–mail address.  This field is user–defined.

If you select a Hub, the following data fields are needed depending on
protocol type:

• Protocol Type

Protocol Type defaults from the Hub definition.

• Username

Select the Username from the list of values supplied by the Hub
definition.

• Password

Defaults to the password for the Username from the Hub
definition.

• Protocol Address

Protocol Address defaults from the Hub definition.
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Source Trading Partner Location Code (Required)

Source Trading Partner Location Code is the code found in the XML
Gateway Envelope  to identify the source of the message.  This is the
code for the source trading partner of the message.

For outbound messages, this is a code for the sending organization.
For inbound messages, this is the code for your trading partner’s
location from where you receive messages.

If you are sending and receiving messages from a trading partner, you
will have a mixture of your location codes and your trading partner’s
location codes depending on the direction of the message.  For
example, if you are sending messages out, the Source Trading Partner
Location Code is your location code since you are the source of the
XML message.  If you are receiving messages, the Source Trading
Partner Location Code is your trading partner’s location code since
they are the source of the XML message.

This code is examined for inbound messages for Trading Partner
validation.  When placed on an outbound message, the recipient will
validate it as a valid source or sending location.

This field is placed in the PARTY SITE ID in the XML Gateway
Envelope.

See: XML Gateway Envelope: page 5 – 6.

Destination Trading Partner Location Code

There are two types of routing in the XML Gateway: Static Routing and
Dynamic Routing.  Dynamic Routing allows the message to be rerouted
by the first recipient of the message to the final destination recipient.
Refer to the Routing field below for Static Routing.

Destination Trading Partner Location Code is the code for the final
recipient of the XML message.  This code is not needed by the XML
Gateway creating this message, but needed by the hub or the first
trading partner receiving the message to identify their final trading
partner to receive the message.  It is the hub’s or the first trading
partner’s code for that final destination trading partner.

For outbound messages, the final intended recipient location code
identified by the Destination Trading Partner Location Code will be
placed in ATTRIBUTE3 in the XML Gateway Envelope.

For inbound messages, this code is found in ATTRIBUTE3 in the XML
Gateway envelope.  Refer to Static and Dynamic Routing: page 4 – 33
for an illustration that explains how ATTRIBUTE3 is populated.
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Document Confirmation

Document Confirmation is the indicator for the confirmation level that
this Trading Partner would like to send or receive a confirmation.

0   means Never send a confirmation

1   means Send a confirmation only if there are errors

2   means Always send a confirmation

It defines the condition under which a confirmation XML message is
generated or received.  Outbound messages receive inbound
confirmations.  Inbound messages generate outbound confirmations.

Routing

Use the Routing field to identify another trading partner to whom
messages will be routed.  You select a trading partner for outbound
transactions from the list of values.  The inbound message is forwarded
as an outbound message to the trading partner identified in the
Routing field.

The XML Gateway provides both Static Routing and Dynamic Routing.
Routing is the address to route the outbound message when using the
Static Routing method.  Refer to the Destination Trading Partner
Location Code: page 4 – 31 field above for Dynamic Routing.

See: Static and Dynamic Routing: page 4 – 33 for more information.

Required Communications Data

Required Communications for Outbound Messages

Different data is required depending on whether DIRECT or a trading
partner is selected from a hub.

If DIRECT is selected, the following data fields are entered by the user
depending on the protocol type for outbound messages:

• Protocol Type (required)

• Protocol Address (required)

• User Name (depends on Protocol Type)

• Password (depends on Protocol Type)
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• Source Trading Partner Location Code to identify the recipient of
the message (required)

If the message is sent via a hub, select the hub, then select a
USERNAME from the presented list.  The following data fields are
retrieved for outbound messages:

• The following data fields are copied from the USERNAME in the
hub definition:

– Protocol Type

– Protocol Address

– Hub Entity Code (acts like the Source Trading Partner
Location Code for DIRECT communication)

– Password (optional and depends on Protocol Type)

If the message will be rerouted to another trading partner by the hub
using Dynamic routing, then the following data is needed.  It will be
placed in ATTRIBUTE3 in the XML Gateway Envelope:

• Destination Trading Partner Location Code

See: XML Gateway Envelope: page 5 – 6.

Required Communications Data for Inbound Messages

Inbound messages require the following:

• Source Trading Partner Location Code to identify the sender of
the message

Static and Dynamic Routing

Messages can be passed through a middle trading party by using the
static routing or dynamic routing feature.  This method is also called a
pass through.

The following figure shows the routing flow of messages using the
dynamic or static routing feature.  The process starts with the review of
the Trading Partner detail associated with the inbound message.

If data is found in the ATTRIBUTE3 field of the XML Gateway
envelope, then the transaction is processed under the rules of Static
Routing.  First the message is processed according to the inbound
message map for the trading partner, then the message is rerouted to
another trading partner who is the final recipient of the message.  The
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trading partner detail for the final recipient is found in the Trading
Partner Detail as an outbound message for the trading partner
identified in the ATTRIBUTE3 field.

If there is no data in the ATTRIBUTE3 field of the XML Gateway
envelope and there is data in the Routing field in the Trading Partner
Detail for the inbound message, then the transaction is processed under
the rules of Dynamic Routing.

First, the message is processed according to the inbound message map
for the trading partner, then the message is rerouted to another trading
partner who is the final recipient of the message.  The trading partner
detail for the final recipient is found in the Trading Partner Detail as the
trading partner identified in the Routing field for that inbound
message.

If there is data in the ATTRIBUTE3 field of the XML Gateway envelope
and there is data in the Routing field in the Trading Partner Detail for
the inbound message, ATTRIBUTE3 will be used for the routing data.

If there is no data in the ATTRIBUTE3 field of the XML Gateway
envelope and there is no data in the Routing field in the Trading
Partner Detail for the inbound message, the message is not rerouted to
another trading partner.

In both dynamic and static routing, data in the message may have code
conversion applied at the trading partner level before constructing the
outbound message for the final recipient.  The retrieved code
conversion values will be substituted into the XML message so the final
trading partner receives the values that apply to them.
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To explain Static and Dynamic routing for pass through messages, the
following three trading partners are defined:

• Party 1: ”ME”:  Initiator of the Message

• Party 2: ”YOU”:  First Recipient of the Message (This may be a
hub)

• Party 3: ”THEM”:  Final Destination of the Message

Party 1 ME will send the message to Party 2 YOU.  Then Party 2 YOU
will reroute it to Party 3 THEM.
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Static Routing

Static routing allows you to select another XML Gateway Trading
Partner detail record from all your entries in the Trading Partner Setup
form.  You can select a trading partner within the same trading partner
or from any other displayed trading partner.  Every time a message is
received for that trading partner and that transaction, it will
automatically be routed to the trading partner defined in the ”Routing”
column.

Static Routing occurs under the following conditions:

• The originator of the message (Party 1) does not include the final
Destination Trading Partner Location Code in the message.

• For the given transaction and trading partner, the first recipient
of the message (Party 2) has selected a trading partner in the
Routing field to automatically forward that message.

In order for this to happen, the following is necessary:

• Proper trading partner setup must be entered only in Trading
Partner Setup in Party 2’s environment.

Static Routing Illustration

The following illustration reviews the required trading partner setup
for each party in the example.

Party 1 ME:  Initiator of the Message:

1. In Static Routing, the first initiator of the message does not indicate
the final Destination Trading Partner Location Code in their setup.
No data should appear in ATTRIBUTE3 of the XML Gateway
envelope.  This is illustrated in the following table:

Trading
Partner

Direction External
Transaction
Type

External
Transaction
Subtype

Protocol Source TP
Location
Code

Routing Destination TP
Location Code (in
ATTRIBUTE3)

(1) YOU OUT INVOICE ADD HTTP ME N/A N/A

Party 2 YOU:  First Recipient of the Message:

PARTY 2 must define the message for both the inbound trading partner
and the outbound trading partner to whom the message will be
rerouted.

2. Party 2 YOU received the message from Party 1 ME.  The message
was an inbound invoice to Party 2.  See entry (2) of the table below.
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3. Party 2 YOU will reroute the message to Party 3 THEM, because
their trading partner setup was stored under the Routing field.  The
trading partner setup data for the trading partner in the Routing
field is used to create the new message and the XML Gateway
envelope. See entry (3) of the table below.

Trading
Partner

Direction External
Transaction
Type

External
Transaction
Subtype

Protocol Source TP
Location
Code

Routing Destination
TP Location
Code

(2) ME IN INVOICE ADD N/A (points to
THEM for
the out-
bound
message)

N/A

(3) THEM OUT
(will be set
to out)

INVOICE
(use the
same Ex-
ternal
Transaction
Type)

ADD 
(use the
same Ex-
ternal
Transaction
Subtype)

HTTP THEM N/A N/A

Dynamic Routing

The following method is dynamic because the first party who
originated the message indicates the Destination Trading Partner
Location Code for the final destination trading partner to receive the
message.

Dynamic Routing occurs under the following conditions:

• The originator of the message (Party 1) includes the final
Destination Trading Partner Location Code in ATTRIBUTE3 in
the XML Gateway envelope.

• The first recipient of the message (Party 2) can identify the
trading partner code in ATTRIBUTE3 in their own Trading
Partner setup.

In order for this to happen the following is necessary:

• Party 1’s XML process must be set up to write the final trading
partner to ATTRIBUTE3 of the XML Gateway envelope.  The
XML Gateway uses the Destination Trading Partner Location
Code field in the Trading Partner Setup form.

• The proper trading partner setup must be entered in Party 2’s
process to act on ATTRIBUTE3.  For the XML Gateway, this is in
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the Source Location Code field in the Trading Partner Setup
form.

Dynamic Routing Illustration

The following illustration reviews the required trading partner setup
for each party in the example.

Party 1 ME:  Initiator of the Message:

1. In Dynamic Routing, the first initiator of the message (Party 1)
passes a Destination Trading Partner Code in ATTRIBUTE 3 to the
first message recipient (Party 2).

This code is defined by the first recipient of the message, so they
can identify the trading partner to whom the message will be
forwarded.  The Destination Trading Partner Code will be copied
to ATTRIBUTE3 in the XML Gateway envelope.  See the table
below:

Trading
Partner

Direction External
Transaction
Type

External
Transaction
Subtype

Protocol Source TP
Location
Code

Routing Destination TP
Location Code (in
ATTRIBUTE3)

(1) YOU OUT INVOICE ADD HTTP ME N/A THEM

Party 2 YOU:  First Recipient of the Message:

This second party must define the message for both the inbound
trading partner and the outbound trading partner.

2. Party 2 YOU received the message from Party 1 ME.  The message
was an inbound invoice to Party 2.  See entry (2) in the Trading
Partner Setup for Party 2 table.

Party 2 YOU will validate Party 1 as a trading partner for that
inbound message.  The data is shown in the following table:

Direction External
Transaction Type

External Transaction Subtype

IN INVOICE ADD

3. Party 2 YOU will reroute the message to Party 3 THEM.  The
message becomes an outbound invoice from Party 2. See entry (3)
below.
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Party 2 YOU will also perform a trading partner lookup for  the
trading partner to whom the message is to be forwarded.  The
direction is changed to OUT.  External Transaction Type and
External Transaction subtype are copied from the inbound
message.  The lookup involves the data shown in the following
table:

Direction External
Transaction Type

External Transaction Subtype

OUT INVOICE ADD

The Trading Partner Setup for Party 2, YOU is shown in the following
table:

Trading
Partner

Direction External
Transaction
Type

External
Transaction
Subtype

Protocol Source TP
Location
Code

Routing Destination TP
Location Code (in
ATTRIBUTE3)

(2) ME IN INVOICE ADD N/A ME N/A N/A

(3) THEM OUT 
(set to
OUT)

INVOICE
(use the
same Ex-
ternal
Transaction
Type)

ADD
(Use the
same Ex-
ternal
Transaction
Subtype)

HTTP THEM N/A N/A

Party 3 ”THEM”: Final Recipient of the Message:

4. Party ”THEM” received the message from party ”YOU.”  The
message was an inbound invoice.  The data is shown in the
following table:

Trading
Partner

Direction External
Transaction
Type

External
Transaction
Subtype

Protocol Source TP
Location
Code

Routing Destination TP
Location Code (in
ATTRIBUTE3)

4 THEM IN INVOICE ADD N/A YOU N/A N/A
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Code Conversion

The Oracle XML Gateway code conversion function provides a method
to cross–reference the codes defined in Oracle Applications to codes
used by trading partners, the XML standard, or other standard codes in
the transactions.

For example, assume that the ABC Corporation transmits a purchase
order to the XYZ Corporation.  The XYZ Corporation processes the
incoming data using its own Oracle values (for example, unit of
measure, currency, or freight carriers), but XYZ is required to return
ABC’s codes.  In this way, the trading partner that created the original
transaction receives response transactions that use their own values.

The Code Conversion features include the following:

1. Define XML standard code conversion values defined by the XML
standard.  These codes are used by all trading partners.

2. Define universally used code conversion values that are defined by
other standard organizations such as ISO, X12, and EDIFACT.
These codes are used by all trading partners.

3. Define trading partner–specific code conversion values.  The
trading partner–specific code may override an XML standard or
the other universally used code conversion values.

Code Conversion Setup Across XML Gateway Forms

In the Define XML Standards form, Standard Codes such as OAG are
entered to represent a message standard. There is a special purpose
Standard Code called ”UNIVERSAL” that is described below.  See:
Define XML Standards Form: page 4 – 10.

Entries from the Define XML Standards form appear in a list of values
in the Define Transactions form that defines transactions to the XML
Gateway.  In this form, one Standard Code is associated with each
transaction listed under External Processes.  See: Define Transactions
Form: page 4 – 12.

The actual code conversion values are entered in the Standard Code
Conversion form and the Trading Partner Code Conversion form.  The
code conversion form provides a one–to–one code conversion from the
Oracle values to an external value. The external code may be the XML
standard codes such as OAG’s code, the universal code such as ISO
codes, or trading partner–specific codes.  These are discussed below.
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Code Conversion Values Marked for the Trading Partner

The trading partner code conversion values are accessed through the
Trading Partner Setup form.  Refer to Trading Partner Setup: page
4 – 24 for details.  Press the Code Conversion button to access the
Trading Partner Code Conversion form from the Trading Partner Setup
form.

The values associated with the trading partner’s code values are the
first set of codes to be examined during code conversion.

Before making entries in the trading partner specific table, first update
the Standard Code Conversion values if necessary.  This is important
because the entries in the Standard Code Conversion tables are
displayed and potentially overridden in the Trading Partner Code
Conversion form.

The following table illustrates the linking of a Trading Partner’s
message maps to Code Conversion:

Trading
Partner

Message Map Code Conversion
Values are created for
the Trading Partner?

The Message Map has a
Unit of Measurement
(UOM) field?

Accessed Trading Partner
Code Conversion Values
when the Message is
Processed

Acme Corp,
Atlanta

PROCESS_PO Yes, for Acme, Atlanta Yes, So Category UOM is
entered for Code Conver-
sion on the field

For UOM Category Code,
the Acme, Atlanta code con-
version values are accessed
for the message map PRO-
CESS_PO

Acme Corp,
Chicago

PROCESS_PO Yes, for Acme, Chicago Yes, So Category UOM is
entered for Code Conver-
sion on the field

For UOM Category Code,
the Acme, Chicago code
conversion values are ac-
cessed for the message map
PROCESS_PO

Acme Corp,
Atlanta

ADD_INVOICE Yes, for Acme, Atlanta Yes, So Category UOM is
entered for Code Conver-
sion on the field

For UOM Category Code,
the Acme, Atlanta code con-
version values are accessed
for the message map
ADD_INVOICE

Acme Corp,
Chicago

ADD_INVOICE Yes, for Acme, Chicago Yes, So Category UOM is
entered for Code Conver-
sion on the field

For UOM Category Code,
the Acme, Chicago code
conversion values are ac-
cessed for the message map
ADD_INVOICE

• Message Map is assigned to this trading partner site in the
Trading Partner Setup form (under Trading Partner Details)



4 – 42 Oracle XML Gateway User’s Guide

• Access Code Conversion through the Trading Partner Setup
form

• Data field is assigned the Category Code when the message map
is created in the Message Designer

Duplicate Entries Not Found

Since duplicate Oracle Values cannot be entered into the code
conversion tables, the trading partner must always use the same ”To
Trading Partner Value” for all the transactions that it has enabled.  The
following table illustrates this rule:

Oracle
Value

Description From Trading Partner
Value

To Trading Partner Value

Each Each EA EA

Piece Piece PC PC

Each Each PC PC

• Oracle Value – Cannot key on multiple occurrences of the value
”EACH”

• From Trading Partner Value – Cannot key on multiple
occurrences of the value ”PC”

• To Trading Partner Value – Cannot key on multiple occurrences
of the value ”PC”

Code Conversion Values Marked as a Standard Code

Given the Code Conversion setup discussed above, there is a standard
code associated with each message.  The standard code is the source
organization for the code value, such as OAG for the given XML
message to be processed.

The values associated with that standard organization’s code values are
the second set of codes to be examined during code conversion.

Code Conversion Values Marked UNIVERSAL

All other standards except the one that defined the XML message are
marked collectively as UNIVERSAL.  The XML Gateway does not store
the other code conversion values under each standard such as the ISO
codes or the X12 codes.  It does not know which order the user wishes
to access those code sets.  For example, should the ISO codes be
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accessed before the X12 Codes, or the reverse?  Hence, they are stored
under a generic name.

The values associated with the UNIVERSAL code values are the third
set of codes to be examined during code conversion.

The table below displays samples of ISO Country Codes that can be
used across all trading partners and entered only once in the Standard
Code Conversion forms.

Standard
Code

Oracle Value Description From Trading
Partner Value

To Trading
Partner Value

UNIVERSAL United States United States US US

UNIVERSAL United King-
dom

United King-
dom

UK UK

If there is a conflict between two codes that must be entered as
UNIVERSAL, it may be resolved by entering the conflicting codes
under the Trading Partner code conversion for each trading partner
needing that code.

Only the conflicting or duplicate code values need to be entered under
each trading partner.  The entries that do not cause conflicts can be
entered under UNIVERSAL at the same time.

Code Categories

A Category Code is a label for a set of entries in the code conversion
table.  For example, CARRIER is the category code for code conversion
values associated with the carrier.

During transaction processing, only the code conversion table entries
with an assigned category code are accessed for the given data element.

See Appendix A for the seeded list.
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Accessing the Code Conversion Values

Key Access

Outbound and inbound transactions use different keys in the code
conversion tables to access the codes.

• For outbound transactions, ”Oracle Value” and the Standard
Code are keys to access this table to determine the ”To Trading
Partner Value” to write in the transaction.

• For inbound transactions, ”From Trading Partner Value” and the
Standard Code are keys  to access the table to determine the
”Oracle Value” to pass to Oracle Application tables.

Order of Table Search

The following table search order is performed for all transactions until
a code conversion value table entry is found:

1. Access the Trading Partner code conversion table.

If the code is not found in this table, perform a second search.

2. Access the Standard code conversion table using the XML
message’s Standard Code, such as OAG.  This Standard Code is
associated with the transaction in the transaction table as defined
via the Define Transactions form.

If the code is not found in this table, perform a third search.

3. Access the Standard code conversion table using the Standard
Code UNIVERSAL.  The universal entries may represent ISO codes
or other standards.

For inbound transactions:  If the code is not found in the tables
after the three searches described above, then the ”From Trading
Partner Value” is copied to the target field in the message map.

For outbound transactions: If the code is not found in the tables
after the three searches described above, then the ”Oracle Value” is
copied to the target field in the message map.

Attention:  If a code conversion value is not found in the table,
it is not an error.  There may be cases where only select values
for a data element need code conversion.  To require all values
to have a code conversion table entry may cause you to do an
excessive number of code conversion entries that are not
necessary.
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The following table illustrates the order that the tables and Standard
Code Values are searched:

Search
Order

Code Conversion Form STANDARD CODE Purpose

1 Trading Partner Code
Conversion

CUSTOM Define the trading partner–specific code conversion
values.
This includes any overrides to any standard’s or uni-
versal code conversion values that are displayed from
the Standard Code Conversion form.
The trading partner code conversion values are used
by all transactions for that trading partner.

2 Standard Code Conver-
sion

For example:
OAG
ROSETTANET
(ROS)

Define standard code conversion values for a given
XML standard that are used across all trading partners.
These values can be overridden for a specific trading
partner in the Trading Partner Code Conversion form.
The Standard Code field is the default XML standard
associated with the XML message.

3 Standard Code Conver-
sion

UNIVERSAL Define standard code conversion values that are used
across all trading partners and not associated with an
XML Standard.
These values can be overridden for a specific trading
partner in the Trading Partner Code Conversion form.
Those entries accommodate universally used code lists
such as ISO, X12, EDIFACT, that can be used by all
XML Messages.

Outbound Transaction Code Conversion Table Access

For outbound transactions, the ”Oracle Value” and the Standard Code
in the code conversion tables are keys to retrieve the ”To Trading
Partner Value” to place it in the transaction.  First the trading partner
codes are searched.  If an entry is not found, then the Standard code
conversion table is searched for the standard codes and the universal
codes.

If the code is not found in the tables after the three searches described
above, then the Oracle Value is copied to the target field in the message
map.  Otherwise, the ”To Trading Partner Value” will be copied to the
target field in the message map.

The following table illustrates the code conversion concepts for
outbound transactions using the category code UOM.  The Outbound
Search Key is comprised of the values for Conversion Table, Standard
Code, and Oracle Value.  The To Trading Partner Value is the data
retrieved.
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Conversion
Table

Standard Code Oracle
Value

Description From Trading
Partner Value

To Trading
Partner Value

Trading
Partner or
Standard

Appropriate Code
for the first, se-
cond, third search

Each Each (ignore the value
here – not rele-
vant for Out-
bound Transac-
tions)

EA 
(derive this code
to place in the
transaction)

The following table illustrates a sample outbound transaction code
conversion for the category code UOM.  The Outbound Search Key is
comprised of the values for Conversion Table, Standard Code, and
Oracle Value.  The To Trading Partner Value is the data retrieved.

Conversion
Table

Standard
Code

Oracle
Value

Description From Trading Partner
Value

To Trading
Partner
Value

Trading
Partner

Box Box (ignore the value here) BX

Trading
Partner

CUSTOM Each Each (ignore the value here) EA

Standard OAG Box Box (ignore the value here) BX

Standard OAG Each Each (ignore the value here) EA

Standard UNIVERSAL Box Box (ignore the value here) BX

Inbound Transaction Code Conversion Table Access

For inbound transactions, the ”From Trading Partner Value” and the
Standard Code in the code conversion tables are keys to retrieve the
”Oracle Value.”  First the trading partner codes are searched.  If an
entry is not found, the Standard code conversion table is searched for
the standard codes and then the universal codes.

If the code is not found in the tables after the three searches described
above, then the ”From Trading Partner Value” is copied to the target
field in the message map.  Otherwise, the ”Oracle Value” will be copied
to the target field in the message map.

The following table illustrates the code conversion concepts for
inbound transactions using the category code UOM.  The Inbound
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Search Key–1 is comprised of the values for Conversion Table and
Standard Code.  The Oracle Value is the retrieved data.  The From
Trading Partner Value is the Inbound Search Key–2.

Conversion Table
(Inbound Search
Key–1)

Standard Code
(Inbound Search
Key–1)

Oracle Value
(Retrieve)

Description From Trading
Partner Value
(Inbound Search
Key–2)

To Trading
Partner Value

Trading Partner
or Standard

Appropriate Code
for the first, se-
cond, third search

Each
(Derive this code
to place in the
Oracle table)

Each EA (Ignore the
value here –
Not relevant
for Inbound
Transactions)

The following table illustrates a sample inbound transaction code
conversion for the category code UOM.  The Inbound Search Key–1 is
comprised of the values for Conversion Table and Standard Code.   The
Oracle Value is the data retrieved.  The From Trading Partner Value is
the Inbound Search Key–2.

Conversion Table
(Inbound Search
Key–1)

Standard Code
(Inbound Search
Key–1)

Oracle Value
(Retrieve)

Description From Trading
Partner Value
(Inbound
Search
Key–2)

To Trading
Partner Value

Trading Partner Box Box BX (Ignore the value
here)

Trading Partner CUSTOM Each Each EA (Ignore the value
here)

Standard OAG Box Box BX (Ignore the value
here)

Standard OAG Each Each EA (Ignore the value
here)

Standard UNIVERSAL Box Box BX (Ignore the value
here)

Standard UNIVERSAL Each Each EA (Ignore the value
here)
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One Internal Code to Multiple External Codes

You can use the Action Assign Variable Value in Message Designer to
assign multiple external codes given the single Oracle internal code by
using conditions on the internal code.  You must update the message
in Message Designer as new codes are needed.

For example, the single Oracle internal carrier code stored in the
SHIP_VIA column may need to cross–reference to two external codes:
the carrier and the transportation mode.  For example,

If SHIP_VIA  = ’TRUCK–LAND’

move ’TRUCK’ to the CARRIER.

If SHIP_VIA  = ’TRUCK–LAND’

move  ’L’ to the TRANSPORTATION_METHOD.

If SHIP_VIA  = ’TRUCK–AIR’,

move ’TRUCK’ to the CARRIER.

If SHIP_VIA  = ’TRUCK–AIR’

move ’A’ to the TRANSPORTATION_METHOD.

Note:  For Outbound Transactions:

If you have the SHIP_VIA source data written twice to the file,
then code conversion could be performed to convert the two
fields separately: Once to derive the carrier code and once to
derive the transportation method.

Standard Code Conversion Form  

Navigate to the Standard Code Conversion form from the XML
Gateway Responsibility by selecting Setup > Define Code Conversion.

The Standard Code Conversion form displays a list of code values that
are used by all trading partners unless the codes are overridden by
trading partner specific code values.  For a discussion of trading
partner specific codes see Trading Partner Code Conversion Form:
page 4 – 52.
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Category Code

Select a category code to view its list of values in the Category Values
portion of the form.  A category code cannot be added or deleted.

Description

Description of the category code.
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Category Values

Standard Code (Required)

A Standard Code identifies one of the following:

• The source organization for the code value, such as OAG, for the
given XML message to be processed.

• The word UNIVERSAL, the seeded code to identify any other
organizations such as ISO, X12, EDIFACT.

Note:  Only XML standards and the single non–XML standard
UNIVERSAL should be defined in the Define Transactions
form.  The process would not recognize standard codes such as
ISO or EDIFACT though they can be entered into this form.

Select a standard code from the list of values.

Use the Define XML Standards form: page 4 – 10 to add new standard
codes as needed.

Oracle Value (Required)

The Oracle Value is a code defined in the Oracle Applications,
regardless if it is an inbound or outbound transaction.  The Oracle
Value is case–sensitive.

Description

Description of the Oracle Value.

From Trading Partner Value (Used with Inbound Transactions)

The ”From Trading Partner Value” is a code in the message that
represents data from the trading partner’s perspective.  This code is
found in the inbound source transaction.

To Trading Partner Value (Used with Outbound Transactions)

The ”To Trading Partner Value” is a code to be written in the outbound
message.  It represents data that the trading partner is expecting to
receive.  You cannot enter data in this field.  This code value is always
equal to and copied from the ”From Trading Partner Value.”
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Standard Check Box

The Standard check box is enabled for all entries made in the Standard
Code Conversion form.

If a code conversion value table entry has the Standard check box
checked, and the code conversion value is later overridden in the
Trading Partner Code Conversion table, this check box is switched
”off” (made blank) in the Trading Partner Code Conversion form.

The system controls setting this check box off and on.

Data Seeded Check Box

Data can be seeded into the database by the XML Gateway.  Seeded
data is indicated by a check mark in this check box.  If data is marked
as seeded, it cannot be modified in the forms.

REVERT ALL Button

The Revert All Button is disabled in this form.  It is used in the Trading
Partner Code Conversion form to revert all codes back to the standard
code value found in the standard Code Conversion table up to the last
saving of the entries.

All fields except the Standard check box, Data Seeded check box, and
the To Trading Partner Value can be changed.

REVERT Button

The Revert Button is disabled in this form.  It is used in the Trading
Partner Code Conversion form to revert the codes back to the standard
code value found in the standard Code Conversion table up to the last
saving of the entries.
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Trading Partner Code Conversion Form

The Trading Partner Code Conversion form allows the entry and
display of code values for a specific trading partner.

Navigate to this form by clicking the Code Conversion button on the
Define Trading Partner Setup form (XML Gateway Responsibility >
Setup > Define Trading Partners).

The Trading Partner Code Conversion form contains data from the
following sources:

• All trading partner–specific code values entered in this form

• All codes entered in the Standard Code Conversion form.  The
Standard check box on the form indicates if the data was entered
in the Standard Code Conversion form.  The standard code
conversion values can be changed.
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Category Code

Select a category code to view its list of values in the Category Values
portion of the form.  A code category cannot be added or deleted.

Description

Description of the category code.

Category Values

Standard Code

A Standard Code identifies one of the following:

• The source organization for the code value, such as OAG, for the
given XML message to be processed.

• The word ”UNIVERSAL”, the seeded code to identify any other
organizations such as ISO, X12, or EDIFACT.

Note:  Only XML standards and the single non–XML standard
UNIVERSAL should be defined in the Define Transactions
form.  The process would not recognize standard codes such as
ISO or EDIFACT though they can be entered on this form.

Select a standard code from the list of values.

Use the Define XML Standards form: page 4 – 10 to add new standard
codes as needed.

Oracle Value

The Oracle Value is a code defined in the Oracle Applications,
regardless if it is an inbound or outbound transaction.  The Oracle
Value is case–sensitive.

Description

Description of the Oracle Value.

From Trading Partner Value (Used with Inbound Transactions)

The ”From Trading Partner Value” is a code in the message that
represents data from the trading partner’s perspective.  This code is
found in the inbound source transaction.
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To Trading Partner Value (Used with Outbound Transactions)

The ”To Trading Partner Value” is a code to be written in the outbound
message.  It represents data that the trading partner is expecting to
receive.  You cannot enter data in this field.  This code value is always
equal to and copied from the ”From Trading Partner Value.”

Standard Check Box

The Standard check box is enabled for all entries made in the Standard
Code Conversion form.

If a code conversion value table entry has the Standard check box
checked, and the code conversion value is later overridden in the
Trading Partner Code Conversion table, this check box is switched
”off” (made blank) in the Trading Partner Code Conversion form.

The system controls setting this check box off and on.

Data Seeded Check Box

Data can be seeded into the database by the XML Gateway.  Seeded
data is indicated by a check mark in this check box.  If data is marked
as seeded, it cannot be modified in the forms.

REVERT ALL Button

The Revert All Button in the Trading Partner Code Conversion form
reverts all codes back to the standard code value found in the standard
Code Conversion table up to the last saving of the entries.

All fields except the Standard check box, the Data Seeded check box,
and the To Trading Partner Value can be changed.

REVERT Button

The Revert Button in the Trading Partner Code Conversion form
reverts the codes back to the standard code value found in the standard
Code Conversion table up to the last saving of the entries.

Note:  The Revert Button applies to only one table entry at a
time for this specific trading partner.

What Can Be Updated

If the Standard Code is ”CUSTOM,” all fields except the Standard
check box, and Data Seeded check box can be changed.
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If the Standard Code is not ”CUSTOM,” then only the From Trading
Partner Value and the To Trading Partner Value can be changed.  The
Standard check box will be enabled.
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Execution Engine

he functions of the Execution Engine are discussed in this chapter.
Specifically, this chapter:

• Presents an overview of how the Execution Engine processes a
message

• Describes the XML Gateway Envelope – where the XML
message is placed or found

• Describes how the Trading Partner is validated for the message

• Describes Concurrent Manager Requests
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Execution Engine Overview

The XML Gateway consists of three components: the Message
Designer, Setup, and the Execution Engine.  It interfaces with the
following Oracle products:

• Oracle transport agent for message delivery

• Oracle Advanced Queuing for message propagation, and queue
management

• Oracle Workflow Business Event System to publish and
subscribe to business events.  Workflow also provides an active
e–mail notification to report errors detected by the XML
Gateway Execution Engine, Advanced Queuing (AQ), or the
transport agent

The following diagram illustrates the process flow of XML messages
through the XML Gateway Execution Engine using all the components
mentioned above.  Details of the XML Gateway Execution Engine are
summarized below.
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XML Gateway Execution Engine can process messages properly after
the following is set up:

• Message maps are created and loaded into the repository along
with their associated DTDs.

• Trading Partners are defined.

• Code Conversions are defined.

• Transactions are defined.

• Oracle Workflow Business Event System events are published by
the Oracle e–Business Suite and subscriptions to those events are
defined.

• Engine and listeners are started.

The XML Gateway listeners are actively polling for interested
events.  The Execution Engine will begin processing once Oracle
Workflow Business Event System detects an outbound
transaction to be processed, or that an inbound message has
arrived on the queue.

The XML Gateway Execution Engine does the following during
processing:

• (Inbound Messages) Dequeue Message from Inbound Queue

• Validate Message via XML Parser

(Inbound Message) Uses the XML Parser to validate the inbound
message to determine if it is well–formed and valid (based on
DTD stored in DTD directory) before proceeding further.

(Outbound Message) Uses the XML Parser to validate the newly
created message to ensure that it is well–formed and valid.  A
poorly formed or invalid message (based on DTD stored in DTD
directory) will not be enqueued onto the Outbound Queue.

• Validate Trading Partner or Hub

If the inbound message is both well–formed and valid, the
Execution Engine proceeds to validate that the Trading Partner
and document are defined.  If the Trading Partner is not  defined
or the document is not defined for the Trading Partner, the XML
message will not be processed further.

• Get Message Map from Repository

If the message map associated with the Trading Partner is not
available in the XML Gateway repository, the XML message will
not be processed further.
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• Execute the Message Map

– (Outbound Messages) Gather Application Data

If the Trading Partner is valid and the message map exists in
the repository, the Execution Engine gathers the application
data from the Oracle e–Business Suite using the database
views and columns identified in the message map.

– (Inbound Messages) Maps Data

If the Trading Partner is valid and the message map exists in
the repository, the Execution Engine maps the data in the
XML message to its target data fields in Oracle e–Business
Suite tables and columns identified in the message map.
These are often the Application Open Interface tables.

– Apply Code Conversion

Apply code conversion for source columns enabled for code
conversion.

– Apply Actions

Apply actions where defined (may be document, element,
or root level).

(Inbound Message) Action codes include inserting data into
the Application Open Interface tables, then executing the
Application Open Interface API to populate the base
application tables.

– (Outbound Messages) Create XML Message

Create XML message using the message map and the
application data as described above.

• Detect and Report Processing Errors

Errors may be detected by the Oracle XML Gateway Execution
Engine, Oracle Advanced Queuing, Oracle Workflow, or Oracle
Transport Agent.  Information regarding the error is enqueued
onto the Error Queue.  An e–mail notification is sent via Oracle
Workflow to notify the trading partner regarding data errors, or
the XML Gateway system administrator regarding system or
process errors.

In addition, for system or process errors, a copy of the XML
message is placed in the XML message directory for use in
troubleshooting the reported error.  For trading partner–related
data errors, the trading partner can refer to the copy of the XML
message.
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• Copy XML Message

For system or process errors, a copy of the XML message is
placed in the XML message directory for use in troubleshooting
the reported error.  For trading partner–related data errors, the
trading partner can refer to their copy of the XML message.

• (Outbound Messages) Enqueue Message to Outbound Queue

Enqueue well–formed and valid message onto the Outbound
Queue.  Oracle Transport Agent will dequeue the message from
the Outbound Queue and deliver it to the trading partner.

• Create or Consume Confirmation Messages

(Inbound Message) Receive confirmation message, if it is enabled
for the Trading Partner and confirmation is requested on the
outbound message, or a default is set up for the trading partner.

(Outbound Message) Create a confirmation message, if it is
enabled for the Trading Partner and confirmation is requested on
the inbound message, or a default is set up for the trading
partner.
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XML Gateway Envelope

In addition to the business document such as a purchase order or
invoice in the XML Payload, a set of message attributes are transmitted.
Collectively, these attributes are called the XML Gateway envelope.

This section discusses the XML Gateway envelope and its data in the
validation process for inbound messages, or its source of data for its
creation for outbound messages.  Data entered into the Trading Partner
Setup form is referred to as data in the trading partner table.  Data
entered into the Define Transactions form is referred to as data in the
transaction table.

Most of the data elements are copied from the Trading Partner tables or
the Transaction tables to the XML Gateway envelope.

Transaction direction is determined by the XML Gateway.  The
direction values used by the XML Gateway are the following:

• IN for inbound messages

• OUT for outbound messages

The XML Gateway envelope consists of the data presented in the
following table:
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Attribute Contents Sample Values Data Source

1 MESSAGE_TYPE Payload message format XML Hard coded ”XML”

2 MESSAGE_STAN-
DARD

Message format standard OAG Transaction table

3 TRANSAC-
TION_TYPE

External Transaction Type
for that business document

INVOICE Trading Partner table

4 TRANSACTION_SUB-
TYPE

External Transaction Sub-
type for that business docu-
ment

PROCESS Trading Partner table

5 DOCUMENT_NUM-
BER

Business document number
such as invoice number

(Not Used)

6 PARTYID (Not Used) Trading Partner table.  This
is not used by the XML
Gateway.

7 PARTY_SITE_ID Source Trading Partner
Location Code

ACME_CHICAGO SOURCE TP LOCATION (if
not recreated) or TARGET
TP LOCATION CODE (if
recreated) from Trading
Partner table

8 PARTY_TYPE (Not Used) (Not Used)

9 PROTOCOL_TYPE Transmission Protocol SMTP, HTTP, HTTP–
WM

Trading Partner table

10 PROTOCOL_AD-
DRESS

Transmission Address me@co.com,
http://www.co.com:5
555

Trading Partner table

11 USERNAME User Name Trading Partner table if
Connection is ”DIRECT;”
Hub Definition if ”HUB”

12 PASSWORD password Trading Partner table if
Connection is ”DIRECT;”
Hub Definition if ”HUB”

13 ATTRIBUTE1 (determined by application)

14 ATTRIBUTE2 (determined by application)

15 ATTRIBUTE3 Rerouting Location (used
only if the message is re-
routed)

TARGET TP LOCATION
CODE from Trading Partner
table

16 ATTRIBUTE4 (determined by application)

17 ATTRIBUTE5 (determined by application)

18 PAYLOAD XML business document (XML Message)

MESSAGE_TYPE

Payload message format. This is hard–coded as ”XML”.
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MESSAGE_STANDARD

Message format standard such as OAG as displayed in the Define
Transactions form and entered in the Define XML Standards form.

TRANSACTION_TYPE

External Transaction Type for that business document from the Trading
Partner table.

TRANSACTION_SUBTYPE

External Transaction Subtype for that business document from the
Trading Partner table.

DOCUMENT_NUMBER

The document identifier that the user recognized the transaction such
as a purchase order or invoice number.  This field is not used by the
XML Gateway, but it may be passed on inbound messages.

PARTY_SITE_ID

Source Trading Partner Location Code if no data is found in the
Destination Trading Partner Location Code in the Trading Partner
table.

PROTOCOL_TYPE

Transmission Protocol as defined in the Trading Partner table.

PROTOCOL_ADDRESS

Transmission address as defined in the Trading Partner table.

USERNAME

USERNAME  as defined in the Trading Partner table.

PASSWORD

The password associated with the USERNAME defined in the Trading
Partner table.
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ATTRIBUTE3

For outbound messages, this field has the value from the Destination
Trading Partner Location Code in the Trading Partner table.

For inbound messages, the presence of this value generates another
XML message that is sent to the trading partner identified in the
Destination Trading Partner Location Code in the Trading Partner
table.  This value must be recognized by the hub to forward the XML
message to the final recipient of the XML Message.  Refer to XML
Gateway Setup: page 4 – 2 for details.

PAYLOAD

The XML message.

Parameters defined by the Application

The following parameters may be defined by the base application:

• ATTRIBUTE1

• ATTRIBUTE2

• ATTRIBUTE4

• ATTRIBUTE5

Parameters Not Used

The following parameters are not used:

• PARTYID

• PARTYTYPE
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Trading Partner Validation for Inbound Messages

Events Raised in Oracle Workflow Business Event System

Oracle Workflow Business Event System is a tool used to integrate with
the Oracle e–Business Suite for event–based XML message creation and
consumption.

Before XML Gateway processes the message:

Messages sent by the trading partner are staged onto a message
queue.  An Oracle Workflow listener dequeues the message from
the message queue and raises an event to the XML Gateway to
begin processing.

Refer to Message Queues: page 6 – 2 for details.

After XML Gateway processes the message:

When XML Gateway completes processing the data according to
the instructions in the message map associated with the trading
partner, an event is published by XML Gateway to inform the
Oracle e–Business Suite that it has successfully processed the
inbound message.  Any Oracle e–Business Suite module
interested in this event may register a subscription to continue
with the transaction.

XML Gateway Processing

Inbound messages can take two paths:

• Standard XML Messages

If ATTRIBUTE3 in the XML Gateway envelope is NULL, the
XML message is processed according to the message map.

• ”Pass Through” Messages

If ATTRIBUTE3 in the XML Gateway envelope has data, the
inbound message will be recreated as an outbound message
according to a message map for the trading partner identified in
ATTRIBUTE3.  This transaction is referred to as a ”pass through”
message and defined as a message with ”Dynamic Routing.”
Refer to Static and Dynamic Routing: page 4 – 33 for details.
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Standard XML Messages

The following table summarizes the required data in the XML Gateway
envelope to identify standard XML messages.  How this data is
validated for an inbound message is described below.

Attribute Sample Values Used in Trading
Partner Lookup

1 MESSAGE_STANDARD OAG YES

2 TRANSACTION_TYPE INVOICE YES

3 TRANSACTION_SUBTYPE PROCESS YES

4 PARTY_SITE_ID ACME_CHICAGO YES

5 ATTRIBUTE3 NULL NO

6 PAYLOAD (XML MESSAGE)

Note:  USERNAME and PASSWORD can be placed in the XML
Gateway envelope by the system that created the XML
message.  The transport agent uses the USERNAME and
PASSWORD for delivery purposes.  These fields are not passed
to the XML Gateway from the transport agent software.

”Pass–Through” XML Messages

XML Gateway can recreate, then route messages to another trading
partner without loading the transaction into a base Oracle Application.
This case is recognized by the presence of a trading partner code in
ATTRIBUTE3 in the XML Gateway envelope in the inbound message.

If a trading partner location code is identified in ATTRIBUTE3 for an
inbound message the following happens:

• A Trading Partner Setup table entry for an outbound message for
this same TRANSACTION_TYPE and
TRANSACTION_SUBTYPE is found for the Trading Partner
identified in ATTRIBUTE3.  The values in ATTRIBUTE3 must
match an entry in the Destination Trading Partner Location Code
defined in the Trading Partner Setup form.

• If the entity in ATTRIBUTE3 is found in the Trading Partner
Setup tables, then another XML Gateway message is created
according to the message map for that trading partner.  This new
XML message is then routed to the trading partner identified in
the original ATTRIBUTE3.
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The following table summarizes the required data in the XML Gateway
envelope to identify these messages, and key data for the pass through
XML message.

Attribute
(Original XML Message)

Sample Inbound
Message Values

Pass–Through Message Created (Find its
corresponding Trading Partner Setup for an
OUTBOUND message where the Trading
Partner is identified in ATTRIBUTE3 of
the original message)

1 MESSAGE_STANDARD OAG OAG

2 TRANSACTION_TYPE INVOICE INVOICE

3 TRANSACTION_SUBTYPE PROCESS PROCESS

4 PARTY_SITE_ID ACME_CHICAGO BETA–LONDON (from original AT-
TRIBUTE3)

5 ATTRIBUTE3
(the DESTINATION TRAD-
ING PARTNER LOCATION
CODE in the Trading Part-
ner Setup table.  This be-
comes the PARTY_SITE_ID
for the outbound message.)

BETA–LONDON

6 PAYLOAD (XML Message) (XML Message)

Validation Against Data in the Trading Partner Setup Form

Inbound messages validate data only against data that was entered in
the Trading Partner Setup form.

Source Trading Partner Location Code

Source Trading Partner Location Code is the code found in the XML
envelope in PARTY_SITE_ID to identify the source of the message.
This field must contain a value stored in Source Trading Partner
Location Code in the Trading Partner setup table.

When a trading partner is entered into the Trading Partner Setup form,
the Trading Partner Name and Trading Partner Site are selected from a
list of values obtained from Oracle Receivables, Oracle Payables, or
Oracle HR Locations.  Associated with each Trading Partner site is a
table ID in the base Oracle Application.   See Derive Address ID from
Location Code action: page 3 – 79 and Get Predefined Variable Value
action: page 3 – 97 if you wish to use this table ID in a message map.
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The parameters listed in the table below compose a search key against
the Trading Partner table.  This key is used to determine if the Trading
Partner is enabled for that transaction, then to retrieve the message
map name to process the transaction.

Search Parameters Description Sample

1 PARTY_SITE_ID Source Trading Partner
Location Code

ACME_CHICAGO

2 TRANSACTION_TYPE External Transaction Type
for that business document

INVOICE

3 TRANSACTION_SUBTYPE External Transaction Sub-
type for that business docu-
ment

PROCESS

4 DIRECTION Determined by the XML
Gateway

IN

The following table shows data that is returned from a search against
data that was entered in the Trading Partner Setup form:

Returned Data Description Sample

1 Trading Partner Site en-
abled for the message

This data is stored in the
table given the trading
partner that was selected.·

This data is not displayed.

12345 (a table ID)

2 Message Map to use for this
inbound transaction for the
given trading partner

OAG_IN_INVOICE

Note that transaction direction is determined by the XML Gateway.
The direction values used by the XML Gateway are the following:

• IN for inbound messages

• OUT for outbound messages
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Trading Partner Validation for Outbound Messages

Event Raised in Oracle Workflow Business Event System

Application business events for outbound messages are raised by the
Oracle e–Business Suite module responsible for the transaction.  The
Oracle XML Gateway has a subscription to that event in order to access
the transaction.  That event will correlate to a transaction that the XML
Gateway creates.

The Oracle Workflow Business Event System calls a rule function
within the Business Event System to verify that the trading partner is
enabled for that transaction.  Only if the trading partner is enabled for
a given transaction will Oracle Workflow Business Event System
execute the Workflow process to send the message.

If XML Gateway has a subscription to that event, it will do the
following with the transaction data:

• Gather the data from the Oracle e–Business Suite

• Create the XML message

• Stage the message onto the outbound queue for delivery by the
transport agent to the trading partner

See Integrating Oracle XML Gateway with Oracle Workflow Business
Event System: page 7 – 2.
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Message Queues

his chapter describes the queues used by the XML Gateway.
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Queues

Queues are tables on a database that are managed by Oracle Advanced
Queuing.

The XML Gateway uses queues specifically at two points in the
process, as well as employing a general error queue.  The first point is
at the transport agent level between the transport agent module and
the XML Gateway.  The second point is at the transaction level between
base Oracle Applications or other source process, and the XML
Gateway.  Details about these queues are provided in the table below.

Queue Name Description Level and Position in Process

ECX_INBOUND Inbound Message Queue:
Holds all messages that enter the
process through the Transport
Agent, or are placed directly on
the queue by an API.

Transport Agent Level
Between the Transport Agent and
the Inbound Transaction Queue

ECX_OUTBOUND Outbound Message Queue:
XML Gateway enqueues all out-
bound messages that it formatted
on this queue

Transport Agent Level
Between the XML Gateway and
the Transport Agent

ECX_IN_OAG_Q Inbound Transaction Queue:
Holds inbound messages that
originated from the
ECX_INBOUND queue, then en-
queued on this queue by Oracle
Workflow

These messages will be processed
by the XML Gateway

Intermediate Level
After the message is received
through the Transport Agent
(Transport Agent Level above),
Oracle Workflow enqueues the
message in this queue for the
XML Gateway to process.

WF_ERROR Workflow Error Queue:
For errors detected by XML Gate-
way or WF BES.  Notifications
are sent to a Trading Partner con-
tact or the System Administrator.

Transaction Level

Refer to Oracle Advanced Queuing under Oracle Database
documentation for details, including topics on checking the status and
content of the queues.



6 – 3Message Queues

Outbound Queues

Outbound Message Queues

The outbound Message Queue is positioned between the XML
Gateway and the Transport Agent.

The XML Gateway creates XML messages, then enqueues them on this
queue.

Next Step:  The Transport Agent dequeues the message and delivers it
to the Trading Partner.

Inbound Queues

Inbound Message Queue

Inbound messages are first queued on the Inbound Message Queue.

The inbound Message Queue is positioned between the Transport
Agent and the Oracle Workflow Business Event System.

There are two methods for placing a message on the Inbound Message
Queue:

• The Transport Agent enqueues the message.

• An API writes directly to the queue.

Refer to Oracle Advanced Queuing under Oracle Database
documentation for details.
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The full message must be formatted according to the XML Gateway
envelope message format described in the Execution Engine section.
See  XML Gateway Envelope 5 – 6 for details.

Next Step:  Oracle Workflow Business Event System will copy the
inbound messages to the proper inbound Transaction Queue.  One
queue is seeded, but you may define other queues to meet your
business needs.  See information below.

Inbound Transaction Queue

This is the second queue for an inbound message.

After the message is received through the inbound Message Queue,
Oracle Workflow Business Event System enqueues the message to this
queue for the XML Gateway to process.

Next Step: The XML Gateway will process the inbound messages
placed in this queue.

Error Queue

When an error is detected by Oracle XML Gateway or Oracle Workflow
Business Event System the message is enqueued on to the error queue.
A Workflow listener dequeues the error and sends a notification to the
Trading Partner contact for data errors or to the System Administrator
contact for system or process errors.

XML Gateway Message Format

XML messages in the queues must be formatted according to the XML
Gateway specification.  This specification includes an XML Gateway
envelope with the message payload.

This format is described in the object type system.ecxmsg.

Refer to XML Gateway Envelope 5 – 6 for more information.
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Integrating Oracle XML
Gateway with Oracle
Workflow Business
Event System

his chapter describes the integration of the Workflow Business
Event System with the XML Gateway.  Specifically, this chapter
discusses

• Using the XML Gateway Standard Item Type and the XML
Gateway Error Processing Item Type

• Configuring Oracle Prebuilt Messages (Inbound and Outbound)
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Integrating Oracle XML Gateway with Oracle Workflow Business
Event System

Overview

Oracle Workflow is a process management tool used to seamlessly
integrate Oracle E–Business Suite business processes together.
Introduced with Oracle Workflow 2.6 is the Business Event System to
further support business process integration at the business event level.

Integral to the Business Event System is the ability to raise a business
event to signal that something of interest has occurred in the Oracle
E–Business Suite.  Using Oracle Purchasing as an example, an event of
interest would be the creation, change, confirmation, or deletion of a
purchase order.

Complementary to the raise event is an event subscription defined to
perform some activity when it detects an event of interest has occurred.
An example of an event subscription in our Oracle Purchasing scenario
is to send a message to the appropriate supplier when a new order is
created, or when an existing order is changed, confirmed, or deleted.

An event subscription is controlled by a rule function.  The result of the
rule function determines whether the associated Workflow process will
be executed.  The actual activity performed by the event subscription is
based on the Workflow process defined for it.

In the context of the integration between the Oracle Workflow Business
Event System and Oracle XML Gateway, business events and their
corresponding event subscriptions are seeded and deployed to the
Oracle E–Business Suite.  Once the Trading Partner is defined, the
seeded business events and event subscriptions may be implemented
as is, or they may be configured to perform specific activities relevant
to the business requirements.

Application business events for outbound messages are raised by the
Oracle E–Business Suite application module responsible for the
message and processed by the event subscription defined for it.  The
seeded event subscription for the B2B integration may be based on the
XML Gateway Rule Function or the Workflow Default Rule Function.

Embedded in the XML Gateway Rule Function is the Transaction
Delivery Required Function used to determine if the Trading Partner is
enabled for the transaction.  The XML Gateway Rule Function can
therefore be simply represented as follows:



Figure 7 – 1

Figure 7 – 2
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XML Gateway Rule Function

The Receive Event is followed by the Send Document function activity
which proceeds to End.

The Workflow Default Rule Function uses the Transaction Delivery
Required function as a process activity to determine if the Trading
Partner is enabled for the transaction.  This process consists of the
following steps:  The Receive Event is followed by the Transaction
Delivery Required function activity.  If it returns TRUE, the Send
Document function activity is executed.  If FALSE, the process
proceeds to End.  This process is shown below:

Workflow Default Rule Function

With either rule function, no message is sent if the Trading Partner is
not enabled for the transaction.

For efficiency, the XML Gateway Rule Function is the recommended
approach as it has already predetermined that the Trading Partner is
enabled for the transaction before it proceeds with generating the
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message.  However, the Workflow Default Rule function approach
provides a visual audit trail of the Workflow process.

With either approach, Oracle XML Gateway gathers the data from the
Oracle E–Business Suite, creates the XML message, and delivers it to
the Trading Partner for Business to Business (B2B) integration or to
another application module for Application to Application (A2A)
integration.

Inbound messages received from the Trading Partner for Business to
Business (B2B) integration are enqueued onto the inbound queue.
Inbound messages received from another application module for
Application to Application (A2A) integration are stored in the Event
Message attribute (of the Consume XML Document function) to be
accessed by the XML Gateway execution engine for processing.

An XML Gateway inbound rule function is executed in the B2B
integration to validate the Trading Partner and to identify the
transaction queue.  If the Trading Partner is valid, the message is
enqueued onto the transaction queue for processing by the XML
Gateway execution engine.

The XML Gateway execution engine processes the data according to
the instructions in the message map associated with the Trading
Partner and message.  If successful, the message map sets the Event
Details to inform the Oracle E–Business Suite of the Event.  It is the
application of the map to the message that enables you to determine
what the Event Details are.  The event is then processed by an
application event subscription interested in the inbound message.

Oracle Workflow Business Event System consists of three key
components that are used to integrate with the Oracle E–Business Suite
to create and consume XML messages:

• The Oracle Workflow Builder contains the Oracle Workflow
Standard Item Type and the Oracle XML Gateway Standard Item
Type.  The components of the standard item types can be used to
define Workflow processes.

• Oracle Workflow Administrator used to register new events and
event subscriptions as well as configure seeded event
subscriptions.

• The Oracle Workflow processing engine used to execute the
workflow processes.
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Oracle Workflow Builder – Item Types

Delivered with XML Gateway are two new standard item types:

• XML Gateway Standard Item Type

• XML Gateway Error Processing Item Type

An Item Type is a group of components of a particular category that
share the same set of item attributes (also known as variables).

Both the XML Gateway Standard Item Type and XML Gateway Error
Processing Item Type can be accessed using the Oracle Workflow
Builder.

Components of an Item Type

Common to all item types are the following components:

• Attributes

• Process Activity

• Notification Activity

• Function Activity

• Event Activity

• Messages

• Lookup Types

A Workflow process may be made up of event activities, function
activities, notification activities, or process activities.  A message is the
information sent in a notification activity.  Lookup types represent a list
of valid values.  Attributes represent variables used to share data
between activities in the Workflow process.

See the Oracle Workflow Guide for more information.

XML Gateway Standard Item Type

The XML Gateway Standard Item Type is a toolkit consisting of
function and event activities.  Configure the seeded events and event
subscriptions delivered by the Oracle E–Business Suite for prebuilt
XML messages in support of B2B integration requirements.
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In addition, the function activities can be used to define Workflow
processes in support of A2A integration requirements.

See XML Gateway Standard Item Type: page 7 – 8 for details
regarding the function and event activities.

XML Gateway Error Processing Item Type

The XML Gateway Error Processing Item Type contains error handling
processes to manage errors detected by Oracle Workflow Business
Event System or Oracle XML Gateway.

Oracle Workflow sends a notification to the Trading Partner contact for
data errors or to the XML Gateway system administrator for system or
process errors.  For errors that require collaboration between the
Trading Partner contact and the XML Gateway system administrator, a
notification is sent to both parties to encourage discussion and to
expedite problem resolution.
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Refer to XML Gateway Error Processing Item Type: page 7 – 29 for
details regarding the error handling process.

E–Business Suite Application Module–Specific Item Type

The seeded event subscription delivered for Oracle prebuilt messages is
delivered in an Oracle E–Business Suite application module–specific
item type.  The seeded event subscription may be configured using the
function activities defined in the XML Gateway Standard Item Type or
customized to support the application–specific requirement.

See Configure Oracle Prebuilt Inbound Messages: page 7 – 49 or
Configure Oracle Prebuilt Outbound Messages: page 7 – 51 for details
on how to configure a seeded event subscription.
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XML Gateway Standard Item Type

The XML Gateway Standard Item Type is a toolkit consisting of
function and event activities.  The function and event activities are
available to implementers to build Workflow processes to configure the
seeded event subscriptions delivered by the Oracle E–Business Suite
for prebuilt XML messages in support of B2B integration requirements.

In addition, the function activities can be used to define Workflow
processes in support of A2A integration requirements.

No Attributes or Processes are included in the XML Gateway Standard
Item Type.  The attributes and processes are defined in the Oracle
E–Business Suite application module–specific item type containing the
Workflow process for the seeded event subscription for the transaction.

The Notifications and Messages are contained in the Oracle E–Business
Suite application module–specific item type and are defined using the
XML Gateway Error Processing Item Type.

See XML Gateway Error Processing Item Type: page 7 – 29.
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Functions

The XML Gateway Standard Item Type includes five function activities
as shown in the following table:
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Function Display Name A2A/
B2B

Inbound /
Outbound

Purpose

Consume XML Document A2A Inbound Trigger XML Gateway to process inbound
message on the Event Message attribute.

Generate XML Document A2A Outbound Create XML message and store in Event
Message attribute.  Trading Partner verifica-
tion is not required.

Generate Trading Partner XML Document B2B Outbound Verify transaction is enabled for the Trading
Partner, create XML message, and store in
Event Message attribute.

Send Document B2B Outbound Create and enqueue XML message onto out-
bound queue.

Transaction Delivery Required B2B Outbound Verify transaction is enabled for the Trading
Partner.

Transform XML A2A
/B2B

Inbound/
Outbound

Enable XML to XML transformations

Application–to–Application (A2A) exchange of data is conducted
within and outside your enterprise to share or synchronize data
between information systems.  There is no Trading Partner involved in
an A2A integration.  An example of an A2A exchange is to move data
from the Oracle Payables module to Oracle General Ledger for GL
consolidation.

Business–to–Business (B2B) exchange of data is conducted with a
Trading Partner outside of your enterprise for which Trading Partner
validation is required.  Data will not be sent to or received from an
invalid Trading Partner.  An example of a B2B exchange is to send a
purchase order to a supplier.

There is not a controlling Workflow process for inbound B2B
exchanges.  The XML Gateway execution engine subscribes directly to
the inbound queue.

Functions will be referred to by their function display names.  The
internal function names are provided for reference in the following
table:
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Function Display Name Internal Name

Consume XML Document PROCESSXML

Generate XML Document GETXML

Generate Trading Partner XML Document GETTPXML

Send Document DOCUMENT_SEND

Transaction Delivery Required DELIVREQUIRED

Transform XML XMLTOXML

The following is a description of each function supported by the XML
Gateway Standard Item Type.

Consume XML Document (applies to A2A for inbound messages)

The Consume XML Document function triggers the XML Gateway
Execution Engine to process the inbound message in the Event Message
attribute.  The XML Gateway execution engine will process the
message according to the message map associated with the message,
and will conclude by raising a business event to indicate that it has
successfully processed the inbound message.

See Procedure Call: Execute Procedure: page 3 – 100 for details
regarding the Procedure Call action to raise a business event.

The Consume XML Document function is for inbound messages in the
A2A scenario only.  The XML Gateway execution engine is
automatically triggered in a B2B scenario when an inbound message
arrives on the inbound queue.
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The attributes for the Consume XML Document function are shown in
the following table.  The values for the attributes are provided by the
business event, another function activity, or are set as constants.

Attribute Name Attribute Description

1 Map Code This is the Map Code defined in the Message De-
signer and associated to the Trading Partner that
uniquely identifies the message map associated with
the business document enabled for the Trading Part-
ner.

2 Event Message Event Message contains the event data as well as
header properties for the event name, event key, and
error data.
The Event Message attribute is required to store the
inbound message for processing by the XML Gate-
way execution engine.



7 – 13Integrating Oracle XML Gateway with Oracle Workflow Business Event System

Generate XML Document (applies to A2A for outbound messages)

The Generate XML Document function is used to retrieve data from the
Oracle E–Business Suite.  The data for the XML message retrieved from
the Oracle E–Business Suite is stored in the Event Message attribute.
The Event Message is then processed according to the subsequent
Workflow instruction, which may be to send it to another Oracle
E–Business Suite application module or to the WF_OUT agent.

The difference between the Generate XML Document function and the
Generate Trading Partner XML Document function is that this function
does not require Trading Partner validation since there is no Trading
Partner involved in A2A integration.
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The attributes for the Generate XML Document function are shown in
the following table.  The values for the attributes are provided by the
business event, another function activity, or are set as constants.
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Attribute Name Attribute Description

1 Document ID This is the unique identifier for the business docu-
ment.  It can be the document number or its
associated database key, whichever is guaranteed to
be unique for the transaction.  
The Document ID is optional for the Generate XML
Document function unless it is used in the message
map as a selection criterion.

2 Map Code This is the Map Code defined in the Message De-
signer and associated to the Trading Partner that
uniquely identifies the message map associated with
the business document enabled for the Trading Part-
ner.
The Map Code is required for the Generate XML
Document function.

3 Event Name This is a unique identifier for the business event.
The naming convention is 
oracle.apps.<product code>.<compo-
nent>.<object>.<event>
The Event Name is required for the Generate XML
Document function to store the value returned.

4 Event Key This is a unique identifier for an instance of an event.
The combination of event name, event key, and event
data fully describe what occurred in the event.
The Event Key is required for the Generate XML
Document function activity to store the value re-
turned.

5 Parameter 1 Optional variable.  This attribute is used if it is used
in the message map.

6 Parameter 2 Optional variable.  This attribute is used if it is used
in the message map.

7 Parameter 3 Optional variable.  This attribute is used if it is used
in the message map.

8 Parameter 4 Optional variable.  This attribute is used if it is used
in the message map.

9 Parameter 5 Optional variable.  This attribute is used if it is used
in the message map.

10 Event Message Event Message contains the event data as well as
header properties for the event name, event key, and
error data.
The Event Message is required for the Generate XML
Document function to store the value returned.
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Generate Trading Partner XML Document (applies to B2B for
outbound messages)

The Generate Trading Partner XML Document function is used to
retrieve data from the Oracle E–Business Suite.  The data for the XML
message retrieved from the Oracle E–Business Suite is stored in the
Event Message attribute.  The Event Message is then processed
according to the subsequent Workflow instruction, which may be to
send it to another Oracle E–Business Suite application module or to the
WF_OUT agent.

The difference between the Generate Trading Partner XML Document
function and the Generate XML Document function is that this function
is used in B2B integration for which a valid Trading Partner is required.



7 – 17Integrating Oracle XML Gateway with Oracle Workflow Business Event System

The attributes for the Generate Trading Partner XML Document
function are shown in the following table.  The values for the attributes
are provided by the business event, another function activity, or are set
as constants.
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Attribute Name Attribute Description

1 Transaction Type This is the Transaction Type defined in the XML
Gateway Define Transactions form.
The Transaction Type is optional for the Generate
Trading Partner XML Document function because it
can be derived from the Map Code.

2 Transaction Subtype This is the Transaction Subtype defined in the XML
Gateway Define Transactions form.
The Transaction Subtype is optional for the Generate
Trading Partner XML Document function because it
can be derived from the Map Code.

3 Document ID This is the unique identifier for the business docu-
ment.  It can be the document number or its
associated database key, whichever is guaranteed to
be unique for the transaction.  
The Document ID is optional for the Generate XML
Document function unless it is used in the message
map as a selection criterion.

4 Party Site ID This is the unique identifier for the Trading Partner
site defined in Oracle E–Business Suite.
The Party Site ID is required for the Generate Trad-
ing Partner XML Document function.

5 Party ID This is the unique identifier for the Trading Partner
defined in Oracle E–Business Suite.
This field is optional.

6 Event Name This is a unique identifier for the business event.
The naming convention is oracle.apps.<prod-
uct code>.<component>.<object>.<event>
The Event Name is required for the Generate Trading
Partner XML Document function to store the value
returned.

7 Event Key This is a unique identifier for an instance of an event.
The combination of event name, event key, and event
data fully describe what occurred in the event.
The Event Key is required for the Generate Trading
Partner XML Document function to store the value
returned.

8 Parameter 1 Optional variable.  This attribute is used if it is used
in the message map.

9 Parameter 2 Optional variable.  This attribute is used if it is used
in the message map.

10 Parameter 3 Optional variable.  This attribute is used if it is used
in the message map.

Table 7 – 1  (Page 1 of 2) 
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Attribute DescriptionAttribute Name

11 Parameter 4 Optional variable.  This attribute is used if it is used
in the message map.

12 Parameter 5 Optional variable.  This attribute is used if it is used
in the message map.

13 Event Message Event Message contains the event data as well as
header properties for the event name, event key, and
error data.
The Event Message is required for the Generate
Trading Partner XML Document function to store the
value returned.

Table 7 – 1  (Page 2 of 2) 

Send Document (applies to B2B for outbound messages)

The Send Document function is used to trigger outbound message
creation. The XML message may be created immediately or deferred
depending on the setting of the Send Mode attribute.  This function
triggers XML Gateway to gather the data from the Oracle E–Business
Suite, and to create and enqueue the XML message.

A Send Mode of ”Deferred” defers the processing to the Workflow
background engine.

A Send Mode of ”Immediate” triggers the XML Gateway Execution
Engine to create the XML message immediately after the data has been
entered into the Oracle E–Business Suite.  With this approach, a
snapshot of the data is taken to avoid a race condition where the data
may be changed after the time the event is raised and before the data is
extracted.

The Send Document function may be modeled using the XML Gateway
Rule Function or the Workflow Default Rule Function to ensure that
XML messages are sent to Trading Partners enabled for the transaction.
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The attributes for the Send Document function are shown in the
following table.  The values for the attributes are provided by the
business event, another function activity, or are set as constants.
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Attribute Name Attribute Description

1 Transaction Type This is the Transaction Type defined in the XML
Gateway Define Transactions form.

2 Transaction Subtype This is the Transaction Subtype defined in the XML
Gateway Define Transactions form.

3 Document ID This is the unique identifier for the business docu-
ment.  It can be the document number or its
associated database key, whichever is guaranteed to
be unique for the transaction.

4 Party Site ID This is the unique identifier for the Trading Partner
site defined in Oracle E–Business Suite.

5 Party ID This is the unique identifier for the Trading Partner
defined in Oracle E–Business Suite.
This field is optional.

6 Parameter 1 Optional variable.  This attribute is used if it is used
in the message map.

7 Parameter 2 Optional variable.  This attribute is used if it is used
in the message map.

8 Parameter 3 Optional variable.  This attribute is used if it is used
in the message map.

9 Parameter 4 Optional variable.  This attribute is used if it is used
in the message map.

10 Parameter 5 Optional variable.  This attribute is used if it is used
in the message map.

11 Send Mode Select ”Deferred” or ”Immediate”

12 Message ID This is a unique identifier provided by the XML
Gateway execution engine for each outbound mes-
sage.

Transaction Delivery Required? (applies to B2B for outbound
messages)

The Transaction Delivery Required function is used to determine if the
Trading Partner is enabled for the transaction.  It is used for B2B
integration where Trading Partner validation is required.  The function
returns TRUE or FALSE.

The Transaction Delivery Required function is also embedded in the
XML Gateway Rule Function.  No Workflow process will be executed if
the function returns FALSE.
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The seeded event subscription delivered by Oracle E–Business Suite
application modules can use the XML Gateway Rule Function or the
Workflow Default Rule Function.  The XML Gateway Rule Function is
more efficient because it predetermines whether the Trading Partner is
enabled for the transaction and executes the associated Workflow
process only if the result of the rule function is TRUE.  It is therefore
the recommended approach.

The attributes for the Transaction Delivery Required function are
shown in the following table.  The values for the attributes are
provided by the business event, another function activity, or are set as
constants.
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Attribute Name Attribute Description

1 Transaction Type This is the Transaction Type defined in the XML
Gateway Define Transactions form.

2 Transaction Subtype This is the Transaction Subtype defined in the XML
Gateway Define Transactions form.

3 Party Site ID This is the unique identifier for the Trading Partner
site defined in Oracle E–Business Suite.

4 Party ID This is the unique identifier for the Trading Partner
defined in Oracle E–Business Suite.

Transform XML

The Transform XML function is used for XML to XML transformation.
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The Transform XML function transforms a given Input XML document
into another XML document.  The input parameters to this activity are
the Map Code and the Input XML Document.  The output of the
activity is the transformed XML document.  The execution engine will
execute the transformation according to the Map Definition.

The attributes for the Transform XML function are shown in the
following table.  The Event Message In attribute stores the input XML
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information and the Event Message Out attribute stores the
transformed XML information.

Attribute Name Attribute Description

1 Map Code The Map Code associated with the Transaction as
defined in the Trading Partner Details form.

2 Event Message In The Input XML message.

3 Event Message Out The Transformed XML message.

Events

The XML Gateway Standard Item Type includes one Event to raise a
business event from an existing Workflow process.

An alternate approach is to raise the business event directly from
PL/SQL code.  Refer to the Oracle Workflow Guide for the details.

Raise Document Delivery Event

The Raise Document Delivery Event is used to raise a business event
from an existing Workflow process.  This allows you to seamlessly
integrate your existing Workflow process with Oracle XML Gateway to
create an outbound XML message.
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The attributes for the Raise Document Delivery Event are shown in the
following table.  The values for the attributes are provided by a
function activity or are set as constants.
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Attribute Name Attribute Description

1 Transaction Type This is the Transaction Type defined in the XML
Gateway Define Transactions form.

2 Transaction Subtype This is the Transaction Subtype defined in the XML
Gateway Define Transactions form.

3 Document ID This is the unique identifier for the business docu-
ment.  It can be the document number or its
associated database key, whichever is guaranteed to
be unique for the transaction.

4 Party Site ID This is the unique identifier for the Trading Partner
site defined in Oracle E–Business Suite.

5 Party ID This is the unique identifier for the Trading Partner
defined in Oracle E–Business Suite.

6 Parameter 1 Optional Variable.  This attribute is used if it is used
in the message map.

7 Parameter 2 Optional Variable.  This attribute is used if it is used
in the message map.

8 Parameter 3 Optional Variable.  This attribute is used if it is used
in the message map.

9 Parameter 4 Optional Variable.  This attribute is used if it is used
in the message map.

10 Parameter 5 Optional Variable.  This attribute is used if it is used
in the message map.

Lookup Types

The XML Gateway Standard Item Type supports the Send Mode
Lookup Type used in the Send Document function to indicate whether
the event subscription should be processed immediately or in deferred
mode.
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Send Mode

• Deferred

The Deferred mode informs the XML Gateway execution engine
to defer the message creation to the Workflow background
engine.  This is also known as asynchronous processing.

• Immediate

The Immediate mode informs the XML Gateway execution
engine to create and enqueue the XML message immediately
after the data has been entered into the Oracle E–Business Suite.
This is also known as synchronous processing.

Synchronous processing avoids the race condition where the
data may be changed between the time the event is raised and
before the data is extracted.
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XML Gateway Error Processing Item Type

The XML Gateway Error Processing Item Type contains error handling
processes to manage errors detected by Oracle Workflow Business
Event System or Oracle XML Gateway.

Oracle Workflow sends a notification to the Trading Partner contact for
data errors or to the XML Gateway system administrator for system or
process errors.  For errors that require collaboration between the
Trading Partner contact and XML Gateway system administrator, a
notification is sent to both parties to encourage discussion and to
expedite problem resolution.

The system administrator receiving a notification has the option to
retry, reprocess, or abort the failed process.  If the source of the error
can be corrected by the system administrator, the system administrator
will correct the error and retry or reprocess the failed process.

The term ”retry” is used for outbound messages.  The Workflow Retry
feature is used to support this requirement.  The retry feature resumes
from the point of failure.

The term ”reprocess” is used for inbound messages.  The ECX
Reprocess Inbound function is used to support the reprocess feature.
The function resumes using a copy of the inbound message stored in
the ECX_DOCLOGS table.

If the source of the error is in the accuracy of the message data received
from the Trading Partner, or of the data setup in the Trading Partner’s
application, the system administrator will abort the failed process and
wait for the Trading Partner to send the corrected message (in the case
of an inbound message) or to correct their data setup (in the case of an
outbound message).

Attributes

Attributes, also known as variables, are used to support the function,
event, notification, and process activities defined for the XML Gateway
Error Processing Item Type.

Processes

The XML Gateway Error Processing Item Type supports the following
error handling processes:
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• Default Error Process

• ECX Engine Notification Process

• ECX Main Error Process

• ECX Main Inbound Error Process

• ECX Main Outbound Error Process

• Error handling for Inbound Messages

• Error handling for Outbound Messages

The relationship of the error handling processes is shown below.  The
ECX Main Error Process calls the ECX Main Error Inbound process for
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inbound message errors or the ECX Main Error Outbound process for
outbound message errors.  If inbound, the ECX Main Error Inbound
process calls the Error Handling for Inbound Message process.  If
outbound, the ECX Main Error Outbound process calls the Error
Handling for Outbound Message process, which calls the Default Error
process.

The following is a description of each Process (listed in their functional
order above) supported by the XML Gateway Error Processing Item
Type:

ECX Main Error Process

The ECX Main Error Process is triggered by the Receive Error Event
(see illustration, node 1) for errors detected by the XML Gateway
execution engine or by Workflow (node 2) for errors involving the
Workflow processes created using the XML Gateway Standard Item
Type.

At node 3, the process determines whether the error relates to an
inbound or outbound message.  The ECX Main Error Process calls the
ECX Main Inbound Error Process (node 4) for errors related to an
inbound message.  For errors related to an outbound message, it calls
the ECX Main Outbound Error Process (node 5).
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ECX Main Inbound Error Process

As shown in the illustration below, ECX Main Inbound Error Process
gets the error information (node 1) from the XML Gateway execution
engine or Workflow engine and calls the Error Handling for Inbound
Messages process (node 2).

Error Handling for Inbound Messages

All errors detected by the XML Gateway execution engine or Workflow
engine trigger a notification to be sent to the XML Gateway system
administrator, the Trading Partner contact, or both depending on the
nature of the error.

Notifications can be e–mailed to the target recipient if the Workflow
mailer is enabled.  The system administrator’s e–mail address is
defined in the ECX: System Administrator Email Address system
profile.  The Trading Partner contact e–mail address is defined on the
Trading Partner form.
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The target recipient(s) of the notification are predefined for the error
message and cannot be changed.

The Error Handling for Inbound Messages process checks the type of
the error detected (shown below, node 1).  If the error type indicates
that the target recipient is the Trading Partner contact, a notification is
sent to the Trading Partner (node 2), the failed process ends, and the
error process ends.

If the check in node one did not indicate that the target recipient is
solely the Trading Partner contact, the process checks the error type
again (node 3).  If the target recipient is the XML Gateway system
administrator, the system administrator is notified (node 4) and has the
option to reprocess (node 5) or abort (node 6) the failed inbound
process.  Reprocessing resumes using a copy of the inbound message
stored in the ECX_DOCLOGS table.

If the target recipients are both the Trading Partner contact and the
XML Gateway system administrator, then two notifications are sent,
one to each party (nodes 7 and 8).

ECX Main Outbound Error Process

ECX Main Outbound Error Process initializes the error (shown below,
node 1) and gets the error information (node 2) from the XML Gateway
execution engine or Workflow engine and calls the Error Handling for
Outbound Messages process (node 3).
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Error Handling for Outbound Messages

All errors detected by the XML Gateway execution engine or Workflow
engine trigger a notification to be sent to the XML Gateway system
administrator, the Trading Partner contact, or both depending on the
nature of the error.

Notifications may be e–mailed to the target recipient if the Workflow
mailer is enabled.  The system administrator’s e–mail address is
defined in the ECX: System Administrator Email Address system
profile.  The Trading Partner contact e–mail address is defined on the
Trading Partner form.

The target recipient(s) of the notification are predefined for the error
message and cannot be changed.

The Error Handling for Outbound Messages process checks the error
type to determine if the target recipient is the Trading Partner Contact
(shown below, node 1).  If the target recipient is the Trading Partner
contact, a notification is sent to the Trading Partner (node 2) and the
failed process is aborted.

If the target recipient is the XML Gateway system administrator, the
Default Error Process is called (node 3).

If the target recipients are both the Trading Partner contact and the
XML Gateway system administrator, then notification is sent to the
Trading Partner contact and the Default Error Process is called.
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Default Error Process

The Default Error Process is called by the Error Handling for Outbound
Messages process when the error message notification is for the system
administrator.

The Workflow notification administrator delivers the notification
(shown below, node 1) to the system administrator and proceeds on
one of the following paths:

• Check for response from the system administrator and issue
time–out if no response received (node 2).

• Execute retry function (node 3) if the system administrator wants
to retry the failed outbound process.  The retry process resumes
from the point of failure.  Continue retry function until error is
resolved or failed process is aborted.

• Execute abort function (node 4) if the system administrator
wants to abort the failed outbound process.

• Resolve error and end process (node 5)
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ECX Engine Notification Process

The Receive Send Notification Event (shown below, node 1) triggers the
ECX Engine Notification Process.

The ECX Engine Notification Process checks the error type to
determine the target recipient (node 2).  If the target recipient is the
Trading Partner contact, notification is sent (node 3).  If the error type
does not indicate that the Trading Partner contact is the sole target
recipient, the process checks the error type (node 4) to determine if the
notification should be sent to the XML Gateway system administrator
(node 5), or both parties (node 6).
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Notifications

The following is a description of each Notification supported by the
XML Gateway Error Processing Item Type:

ECX Event Notification (FYI)

The ECX Event Notification [FYI] is used to send a notification to the
system administrator.

This notification is used by the ECX Engine Notification Process.

ECX External Event Notification 

The ECX External Event Notification is used to send a notification to
the system administrator.
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This notification is used by the Error Handling for Inbound Messages
process.

Trading Partner Inbound Error Notification 

The Trading Partner Inbound Error Notification is used to send a
notification to the Trading Partner contact.

This notification is used by the Error Handling for Inbound Message
and ECX Engine Notification processes.

Trading Partner Outbound Error Notification 

The Trading Partner Outbound Error Notification is used to send a
notification to the Trading Partner contact.

This notification is used by the Error Handling for Outbound Message
process.
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Functions

Several functions are provided in the XML Gateway Error Processing
Item Type to support the error handling process.

ECX Reprocess Inbound

The ECX Reprocess Inbound function is used if the XML Gateway
system administrator responded to the error notification by selecting
the ”reprocess” option.  The reprocess function will rerun the inbound
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process using a copy of the inbound message stored in the
ECX_DOCLOGS table.

The ”reprocess” function is not supported for external notifications to
the Trading Partner.

The attribute for the ECX Reprocess Inbound function is shown in the
following table:

Attribute Name Attribute Description

1 ECX Message ID This is a unique identifier provided by the XML Gateway
execution engine for each outbound message.

ECX Resend Outbound Message

The ECX Resend Outbound function is provided to support Oracle
Exchange only, it is not used in the XML Gateway Error Processing
Item Type.  The ECX Resend Outbound function resumes from a copy
of the outbound message stored in the ECX_DOCLOGS table.

The Oracle Workflow ”retry” function is used to rerun an outbound
process from the point of failure.  This is handled using the Default
Error Process.

The attribute for the ECX Resend Outbound function is shown in the
following table:

Attribute Name Attribute Description

1 ECX Message ID This is a unique identifier provided by the XML Gateway
execution engine for each outbound message.

Get ECX In Error Details

The Get ECX In Error Details function activity is used to get the details
regarding an inbound error to prepare the e–mail notification.  In
addition, required information is passed to the Error Handling for
Inbound Messages process activity.

Get ECX Out Error Details

The Get ECX Out Error Details function is used to get the details
regarding an outbound error to prepare the notification.  In addition,
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required information is passed to the Error Handling for Outbound
Messages process.

Get System Administrator Role

The Get System Administrator Role function is used to retrieve the
e–mail address for the system administrator stored in the ECX: System
Administrator Email Address system profile.

The e–mail address retrieved from the system profile is returned by the
function and stored in the ECX System Administrator Role
(ECX_SA_ROLE) item attribute.

A notification is sent to the XML Gateway system administrator for
system or process errors detected by Oracle XML Gateway or Oracle
Workflow Business Event System.

Get Trading Partner Role

The Get Trading Partner Role function is used to determine the e–mail
address for the Trading Partner contact that was provided when the
Trading Partner was defined.

The function uses the attribute values passed to it to uniquely identify
the Trading Partner.  The e–mail address associated with the Trading
Partner selected returned by the function is stored in the ECX Trading
Partner Role (ECX_TP_ROLE) item attribute.

A notification is sent to the Trading Partner contact for data errors
detected by Oracle XML Gateway.

The attributes for the Get Trading Partner Role Function are shown in
the following table:

Attribute Name Attribute Description

1 ECX Party ID This is the unique identifier for the Trading Partner defined in
Oracle E–Business Suite.  This field is optional.

2 ECX Party Site ID This is the unique identifier for the Trading Partner site defined
in Oracle E–Business Suite.

3 ECX Transaction
Type

This is the Transaction Type defined in the XML Gateway De-
fine Transactions form.

4 ECX Transaction
Sub Type

This is the Transaction Sub Type defined in the XML Gateway
Define Transactions form.
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Events

The XML Gateway Error Processing Item Type supports two event
activities as follows:

• Receive Error

• Receive Send Notification Event

Receive Error

The Receive Error event is used by XML Gateway to indicate that the
execution engine has detected an error.  Regardless of whether the error
was detected by Oracle XML Gateway or Oracle Workflow Business
Event System, the same ECX Main Error Process manages the error.
See: ECX Main Error Process: page 7 – 31 for the details.

Receive Send Notification Event

The Receive Send Notification Event is used by XML Gateway to
indicate that the execution engine has identified a need to send a
notification for errors related to an inbound process.  The ECX Engine
Notification Process manages the error.  See: ECX Engine Notification
Process: 7 – 36 for the details.

Messages

The XML Gateway Error Processing Item Type provides several
message templates used by the various notification activities to send a
notification to the XML Gateway system administrator or the Trading
Partner contact based on the nature of the error.
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Below is a description of each message template.  The message
template is displayed in the Body tab and Text Body subtab.

ECX Event Message (FYI)

The ECX Event Message [FYI] template is used by the ECX Event
Notification.  The template includes information regarding the
transaction, the type of error detected, and the associated error
message.

ECX External Event Message

The ECX External Event Message  template is used by the ECX
External Event Notification activity.  The template includes information
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regarding the transaction, the type of error detected, and the associated
error message.

Inbound Trading Partner Message

The Inbound Trading Partner Message template is used by the Trading
Partner Inbound Error Notification activity.  The template includes
information regarding the transaction, the type of error detected, and
the associated error message.

Outbound Trading Partner Message

The Outbound Trading Partner Message template is used by the
Trading Partner Outbound Error Notification activity.  The template
includes information regarding the transaction, the type of error
detected, and the associated error message.

Message Template Attributes

Each message template has the attributes listed in the following table.
The values for the attributes are provided by the Get ECX Out Error
Details and Get ECX In Error Details function.  The values are used to
replace the message tokens in the message template.
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Attribute Name Attribute Description

1 Event Key This is a unique identifier for an instance of an event.  The com-
bination of event name, event key, and event data fully de-
scribe what occurred in the event.

2 ECX Transaction
Type

This is the Transaction Type defined in the XML Gateway De-
fine Transactions form.

3 ECX Document ID This is the unique identifier for the business document.  It can
be the document number or its associated database key, which-
ever is guaranteed to be unique for the transaction.

4 ECX Error Message This is the error message text describing the error detected.

5 ECX Error Type This is the error type code.  The valid values are:
10 = Success
20 = Send error notification to Trading Partner contact
25 = Send error notification to both Trading Partner contact and
XML Gateway System Administrator
30 = Send error notification to XML Gateway System Adminis-
trator

6 ECX Return Code This is the return status code.  The valid values are:
0 = Success
1 = Warning
2 = Error

Lookup Types

The XML Gateway Error Processing Item Type supports several lookup
types for the error handling processes.
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ECX Inbound Error Actions

The ECX Inbound Error Actions lookups are used by the ECX External
Event Notification as a Result Type attribute.  The valid values are as
follows:

• Abort

Abort the failed inbound process.

• Reprocess

Reprocess the failed inbound process.

ECX Outbound Error Actions

The ECX Outbound Error Actions lookups is used by the Default Error
Process.  The valid value is as follows:

• Abort
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Abort the failed outbound process

The retry function is supported by the Default Error Process.

ECX Outbound Error Types

The ECX Outbound Error Types lookups are used by the Get ECX Error
Type function as a Result Type attribute.  The valid values are as
follows:

• Generate Error

The error was detected during the message creation process as
opposed to the message delivery process.

• Send Error

The error was detected during the message delivery process as
opposed to the message creation process.

• Trading Partner Setup Error

The error was based on incorrect Trading Partner setup.  Correct
the erroneous set up before proceeding further.
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Configure Oracle Prebuilt Inbound Messages

Seeded Business Event and Corresponding Event Subscription

Inbound messages that are prebuilt and delivered by Oracle E–Business
Suite application modules are delivered with the following:

• Message map containing an XML Gateway Procedure Call action
as the last activity.  This activity sets event details to indicate that
XML Gateway has successfully processed the inbound message.

• Seeded event subscription to consume the business event raised
in the message map.

The event subscription is seeded as an enabled subscription.  You
can disable the event subscription if necessary.

An event subscription is required for inbound messages from Trading
Partners (B2B) regardless of whether the application is interested in the
inbound message.  The seeded event subscription uses the Workflow
Default Rule Function but may be configured to use a rule function and
Workflow process relevant to the business requirement.

See the Message Designer: page 3 – 2 section for instructions on how to
create a new message map and how to modify an Oracle prebuilt
message map.

Configuration Options for Seeded Event Subscription

Use the Workflow Administrator to configure the seeded event
subscription for the prebuilt inbound message if necessary.

1. Register new event subscription

Use the Workflow Administrator Add Event Subscription window
to register the new event subscription if you defined a new
subscription instead of configuring the seeded subscription.

See Manage Workflow Processes: page 7 – 57 for instructions on
how to register new event subscriptions.

2. Configure Seeded Subscription

Use Oracle Workflow Administrator Add Event Subscription
window to configure the seeded event subscription to consume the
inbound message if your application is interested in it.  The
subscription will trigger the Oracle E–Business Suite to perform
some activity.  The actual activity performed by the event
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subscription will be based on the Workflow process defined for it.
Some examples are as follows:

• Integrate with existing Workflow process defined in the Oracle
E–Business Suite

• Call an application API to perform a specific function

See: Manage Workflow Processes: page 7 – 57 for instructions on
how to register new event subscriptions and configure a seeded
event subscription.
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Configure Oracle Prebuilt Outbound Messages

Seeded Business Event and Corresponding Event Subscription

Outbound messages that are prebuilt and delivered by Oracle
E–Business Suite application modules are delivered with the following:

• Calls in the application module to raise a business event to
indicate when something of interest has occurred.  This includes
event points indicating when a document was created, changed,
confirmed, or deleted.

• Seeded event subscription using the XML Gateway or Workflow
Default Rule Function to consume all the business events raised
in the application module.

The event subscription is seeded as an enabled subscription.  You
can disable the event subscription if necessary.

The seeded event subscription consumes all the seeded events but may
be configured to execute a specific Workflow process for the outbound
events it is interested in.

See the Message Designer: page 3 – 2 section for instructions on how to
create a new message map and how to modify an Oracle prebuilt
message map.

Configuration Options for Seeded Event Subscription

Use the Workflow Administrator to configure the seeded event
subscription for the prebuilt outbound message if necessary.

1. Register new event subscription

Use the Workflow Administrator Add Event Subscription window
to register the new event subscription if you defined a new
subscription instead of configuring the seeded subscription.

See Manage Workflow Processes: page 7 – 57 for instructions on
how to register new event subscriptions.

2. Configure Seeded Event Subscription

Use Oracle Workflow Administrator Add Event Subscription
window to configure the seeded event subscription to consume the
application business event of interest.  The subscription will trigger
the Oracle E–Business Suite to perform some activity.  The actual
activities performed by the event subscription will be based on the
Workflow process defined for it.
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There are three subscription options for the Business–to–Business
(B2B) integration scenario described below.  The function activities
outlined are supported by the XML Gateway Standard Item Type.

1. Send Document Function Using XML Gateway Rule Function

This option uses the XML Gateway Rule Function which has the
Transaction Delivery Required function embedded in it to
determine if the Trading Partner is enabled for the transaction
before the message is generated.

The ”Send Document” function can be configured to generate the
message in synchronous or asynchronous mode by setting the Send
Mode attribute to ”Immediate” or ”Deferred” respectively.

The following is an example of a Workflow process launched by the
XML Gateway Rule Function.  The Receive activity is followed by
the Send Document function activity, which proceeds to End.  The
Transaction Delivery Required Function is not modeled in the
Workflow process since it is already included in the rule function.

Note:  The first Workflow activity may be a Receive or a Start
activity.  Use Receive to continue an existing Workflow process.
Use Start to begin a new Workflow process.

2. Send Document Function Using Workflow Default Rule
Function

This option is used to first determine if the Trading Partner is
enabled for the transaction.  If the result of the Transaction Delivery
Required function activity returns TRUE, the ”Send Document”
function activity is executed.

The ”Send Document” function activity may be configured to send
the message in synchronous or asynchronous mode by setting the
Send Mode attribute to ”Immediate” or ”Deferred” respectively.

The following is an example of a Workflow process launched by the
Workflow Default Rule Function.  The Transaction Delivery
Required Function is modeled in the Workflow process since it is
not included in the Workflow Default Rule Function.
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Note:  The first Workflow step may be a Receive or a Start
activity.  Use Receive to continue an existing Workflow process.
Use Start to begin a new Workflow process.

3. Generate Trading Partner XML Document

This option is used to gather and return the message data in the
Event Message attribute without delivering it to the Trading
Partner.  The Event Message is then processed according to the
subsequent Workflow instruction.

The following is an example of a Workflow process using the
Generate Trading Partner XML Document function.  A Receive
activity is followed by the Transaction Delivery Required function
activity.  If it returns False, the process proceeds to End.  If True,
the Generate Trading Partner XML Document function activity is
executed and proceeds to End.  In a production Workflow process,
the Generate Trading Partner XML Document function activity
would be followed by an application–specific activity.
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Note:  The first Workflow step may be a Receive or a Start
activity.  Use Receive to continue an existing Workflow process.
Use Start to begin a new Workflow process.
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Application to Application Integration

The XML Gateway Standard Item Type provides function activities to
support A2A integration requirements.  Listed below are the options
for inbound and outbound transactions.

Inbound Option

Consume XML Document

This option is used to interact with Oracle XML Gateway to insert data
into the base application tables.  Depending on how the message map
was defined, the data may be inserted using an Application Open
Interface API or an Application API.  See: How to Map to an API: page
3 – 112.

The Consume XML Document function is used for A2A integration.  It
may be used in existing Workflow processes for which the Event
Message attribute is used to pass the message data.  This makes it
unnecessary to raise a business event or define an event subscription as
recommended in the B2B integration scenario.

The following is an example of a Workflow process using the Consume
XML Document function:

This Workflow process shows the Consume XML Document (2)
function activity completing and followed by an End function (3).  In a
production Workflow process, the Consume XML Document function
activity would be followed by an application–specific activity.

Note:  The first Workflow step (1) may be a Receive or a Start
activity.  Use Receive to continue an existing Workflow process.
Use Start to begin a new Workflow process.
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Outbound Option

Generate XML Message

This option is used to generate the XML message and forward it to the
subsequent Workflow process.   The Generate XML Document function
activity is used to gather the document data and return it in the Event
Message attribute.  The Event Message is then processed according to
the Workflow instructions which may be to send it to another Oracle
E–Business Suite application module.

The following is an example of a Workflow process using the Generate
XML Document function:

The Workflow process shows the Generate XML Document function
activity completing and followed by an End function.  In a production
Workflow process, the Generate XML Document function activity
would be followed by an application specific activity.

Note:  The first Workflow step may be a Receive or a Start
activity.  Use Receive to continue an existing Workflow process.
Use Start to begin a new Workflow process.
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Manage Workflow Processes

Use the following Oracle Workflow Administrator windows to help
manage your Workflow processes.

For more information about these windows see the Oracle Workflow
Guide.

Register New Business Events and Event Subscription

This process is necessary for new events and subscriptions added as a
result of creating a new XML message.  The seeded business events and
event subscriptions delivered by the Oracle E–Business Suite have
already been registered.  There is no need to register a seeded event
subscription that was configured during implementation.

Use the Add Events/Event Group window to add a new business
event.

Use the Add Event Subscription window to add a new subscription to
consume the new event.

Identify Seeded Item Types

Use the Item Type Definition window to view the seeded item types
delivered by Oracle Workflow Business Event System, Oracle XML
Gateway, and Oracle E–Business Suite modules.

Identify Seeded Business Events and Associated Event Subscriptions

Use the the Add Events/Event Group window to view the seeded
business events delivered by Oracle Workflow Business Event System,
Oracle XML Gateway, and Oracle E–Business Suite modules.

Select the business event and click on Edit Subscription to proceed to
the Event Subscription window to view the associated subscriptions.
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Configure or Delete Seeded Event Subscriptions

From the Event Subscription window, select the subscription and click
Edit to configure the subscription.  Click Delete to delete the
subscription.  You can modify the rule function or Workflow process
defined for the subscription.

Respond to Error Notifications or Find a Specific Notification

Use the Worklist window to respond to notifications awaiting your
attention.  Use the Find Notifications window to locate a specific
notification by notification ID.
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Monitor Workflow Processes

Identified below are several Oracle Workflow Administrator windows
to help monitor your Workflow processes:

Monitor Subscription Using Trace Function

Modify the event subscription and set the Action: Parameter field to
the trace level desired as shown in the following table:

Parameter Setting Description

ECX_DEBUG_LEVEL = 1 Process–level trace

ECX_DEBUG_LEVEL = 2 Process–level and subprocess–level trace

ECX_DEBUG_LEVEL = 3 Process–level, subprocess–level, and system–level trace

ECX_DEBUG_LEVEL of 0 (OFF) is the default setting.

Monitor Transaction Status

Use the Event Queue Summary window to monitor the status of a
transaction.  Select the Agent Listener and click the View Detail icon.
Once you enter the selection criteria to identify the transaction, the
detail information including status and an option to view the event
data in XML or text format, are presented.

Review XML Message Returned by Generate Functions

Modify the subscription for the Generate XML Document or Generate
Trading Partner XML Document function and set the Action: Out
Agent field to the WF_OUT.  The XML data gathered by the function is
directed to the WF_OUT agent.

For instructions on viewing the XML message directed to WF_OUT
see: Monitor Transaction Status.
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Enable/Disable Agent Listeners

There is one Agent Listener per agent.  The agents necessary to support
the integration between Oracle Workflow Business Event System and
Oracle XML Gateway are shown in the following table:

Agent Name Description

ECX_INBOUND Agent for inbound messages originating from outside the
enterprise for B2B integration.

ECX_TRANSACTION Agent for inbound messages originating from within the
enterprise for A2A integration.

WF_OUT Agent to stage outbound messages.  ECX_OUTBOUND is
the agent used to stage and deliver outbound XML mes-
sages to the Trading Partner.

WF_IN Agent to receive inbound messages sent to the Oracle
E–Business Suite.

WF_DEFERRED Agent for outbound messages sent in deferred mode.

WF_ERROR Agent for errors detected by Oracle Workflow Business
Event System or Oracle XML Gateway.

Use the Workflow Administrator: Add Agents window to enable the
required agents.  The same window can be used to disable an agent if
necessary.

Another option is to execute the System Administrator: Workflow
Agent Listener concurrent request to schedule the listeners to run
continuously.
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Development Guidelines for Custom Messages for B2B Integration

If you are using Oracle XML Gateway to create new inbound and
outbound messages, use the following guidelines to raise business
events and define event subscriptions.

A prerequisite to this process is a message map created using the XML
Gateway Message Designer.

See the Message Designer: page 3 – 2 section for instructions on how to
create a new message map and how to modify an Oracle prebuilt
message map.

Development Guidelines for Outbound Messages

1. Register the Business Event and Corresponding Event
Subscription

Register the business event and corresponding event subscription
defined in the Oracle E–Business Suite.

See: Manage Workflow Processes 7 – 57 for the instructions on
registering business events and event subscriptions.

2. Raise a Business Event in the Application

Use the Workflow function to raise business events in your
application at points indicating when a document has been created,
changed, confirmed, or deleted.  Business events may be raised in
PL/SQL code, by an existing Workflow process using the Raise
Document Delivery Event activity, or as the first activity of a new
Workflow process.

It is important to raise an event at all possible event points even
though you may not define a specific event subscription for it.  This
will allow you to define an event subscription for any event of
interest without having to modify the application code to raise the
event.

3. Define an Event Subscription

Add an event subscription for each business event of interest.  Use
the function and event activities provided in the XML Gateway
Standard Item Type to define the Workflow process associated with
the event subscription.

See: Configure Oracle Prebuilt Outbound Messages: page 7 – 51 for
the Workflow process configuration options.
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See: Manage Workflow Processes 7 – 57 for the instructions on
adding an event subscription.

There is no need to add an event subscription for business events
that you are not interested in.  These may be added at a later point
in time when the event becomes of interest to your implementation.

Development Guidelines for Inbound Messages

1. Register the Business Event and Corresponding Event
Subscription

Register the business event and corresponding event subscription
defined in the Oracle E–Business Suite.

See: Manage Workflow Processes 7 – 57 for the instructions on
registering business events and event subscriptions.

2. Setting Event Details in the Message Map

Make sure your message map includes a post process Procedure
Call action to call the Workflow function to set event details
indicating XML Gateway has successfully processed the inbound
message.

See: Procedure Call: Execute Procedure: page 3 – 100 for details
regarding the Procedure Call action.

3. Define an Event Subscription

An event subscription is required for inbound messages from
Trading Partners (B2B) regardless of whether the application is
interested in the inbound message.

Assuming your application is interested in the inbound message,
define an event subscription with a rule function and Workflow
process relevant to the business requirement.

If your application is not interested in the inbound message, define
an event subscription with the Workflow Default Rule Function
and no Workflow process.  The event subscription may be modified
when your application becomes interested in the inbound message.

See: Manage Workflow Processes 7 – 57 for the instructions on
adding an event subscription.
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Common Questions

The following are common implementation questions:

1. Is the combination of the Generate Trading Partner XML
Document and Send Document function activity valid?

No.  This combination of function activities is invalid.

The Generate Trading Partner XML Document function returns the
XML message in the Event Message attribute.  The Send Document
function gathers the data, creates the XML message, and enqueues
it onto the outbound queue.

The result of this combination of function activities is that the Send
Document function activity will complete successfully but the
Generate Trading Partner XML Document function activity will
have data in the Event Message attribute that is not sent anywhere
unless something is defined in the Out Agent attribute (associated
with the Event Subscription) which will enqueue the message.

2. Is the combination of the Generate XML Document and Send
Document function activity valid?

Same as answer 1.

3. Does the Generate Trading Partner XML Document function
activity require the Transaction Delivery Required function
activity to determine if the Trading Partner is defined to receive a
document?

Yes.  The Generate Trading Partner XML Document function
activity must be preceded by the Transaction Delivery Required
function activity.
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A – 1XML Gateway Seeded Code Categories

XML Gateway Seeded
Code Categories

his appendix provides you with a description of the seeded code
categories.
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XML Gateway Seeded Code Categories

The XML Gateway seeded code categories and their descriptions are
shown in the following table:

Category Code Description

ACTION_CODE Action Code (such as Add/Change/Delete)

AC_HANDL Allowance and Charge Handling Code

AC_SPEC_CHARGES Allowance and Charge Special Charges

AC_SPEC_SERVICES Allowance and Charge Special Services

AETC_REASON AETC Reason Code

AETC_RESPONSIBILITY AETC Responsibility Code

AGREEMENT Agreement Code

ALLOW_CHARGES_INDICATOR Allowance or Charge Indicator Code

ALLOW_METHOD_HANDLING Allowance or Charge Method of Handling Code

BARCODE Bar Code

BUYER_ITEM Buyer Item

CARRIER_CODE Freight Carrier Code

CHARGE_ALLOW_QUALIFIER Allowance or Charge Qualifier Code

CHARGE_TYPE Charge Type Code

COMMODITY_COD_QUALIFIER Commodity Code Qualifier Code

COMPANY_CODE Company Code

CONTAINER_CODE Container Code

CONTAINER_TYPE Container Type Code

COUNTRY Country Code

CURRENCY Currency

CURRENCY_CODE Currency Code

CURRENCY_CONV_TYPE Currency Conversion Type Code

CUSTOMER_BANK_ACCOUNT Customer Bank Account Code

CUSTOMER_BANK_ACCOUNT_TYPE Customer Bank Account Type Code
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DescriptionCategory Code

CUSTOMER_BANK_BRANCH Customer Bank Branch Code

CUSTOMER_BANK_BRANCH_ID Customer Bank Branch ID

CUSTOMER_BANK_BRANCH_TYPE Customer Bank Branch Type Code

CUSTOMER_BANK_LOCATION Customer Bank Location Code

CUSTOMER_BANK_ORG Customer Bank Org Code

CUSTOMER_BANK_SITE Customer Bank Site Code

CUSTOMER_CODE Customer Code

CUSTOMER_ITEM Customer Item

CUSTOMER_LOCATION_CODE Customer Location Code

CUSTOMER_NAME Customer Name

CUSTOMER_NUMBER Customer Number

CUSTOMER_ORG Customer Org Code

CUSTOMER_SITE Customer Site Code

CUSTOMER_SITE_ORG Customer Site Organization Code

DATE_TIME_QUALIFIER Date/Time Qualifier Code

DATE_TYPE Date Type Code

DESTINATION_CLASS Destination Class Code

DETAIL_SUBTYPE Detail Subtype Code

DETAIL_TYPE Detail Type Code

DOC_HANDLING_CODE Document Handling Code

DOC_PURPOSE_CODE Document Purpose Code

DOC_STATUS Document Status Code

DOC_SUBTYPE Document Subtype

DOC_TYPE Document Type

EAN European Article Number (EAN)

EQUIPMENT_CODE Equipment Code
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DescriptionCategory Code

EQUIPMENT_DESC Equipment Description Code

EXCESS_TRANS_REASON_CODE Excess Transportation Reason Code

EXCESS_TRANS_RESPONSIBILITY Excess Transportation Responsibility Code

EXPORT_DETAIL Export Detail Code

EXPORT_HEADER Export Header Code

FOB Freight Code

FOB_PAYMENT FOB Payment Code

FOB_POINT FOB Point Code

FREIGHT_TERMS Freight Terms Code

HAZ_CERTIFICATION Hazardous Certification Code

HAZ_CLASS Hazard Class Code

HAZ_MATERIAL Hazardous Material Code

HAZ_MATL_CODE_QUAL Hazardous Material Code Qualifier

HAZ_MATL_SHIPMENT_INFO_QUAL Hazardous Shipment Info Qualifier

INTL_DOMESTIC_CODE International/Domestic Code

INT_LOC_LOCATION_CODE Internal Location Code

INT_LOC_ORG Internal Location Org Code

INT_LOC_SITE Internal Location Site Code

INVENTORY_ITEM Inventory Item

INVOICE_TYPE Invoice Type Code

ISBN_CODE International Standard Book Number Code

ITEM_CATEGORY Item Category Code

ITEM_QUALIFIER Item Qualifier Code

ITEM_TYPE Item Type Code

LABEL_NAME Label Name Code

LADING_DESC_QUALIFIER Lading Description Qualifier
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DescriptionCategory Code

METHOD_OF_PAYMENT Method of Payment Code

NETWORKS Network Code

PACKAGING_CODE Packaging Code

PACKAGING_FROM Packaging From Code

PACK_CODE Pack Code

PAYMENT_FORMAT Payment Format Code

PAYMENT_METHOD Payment Method Code

PAYMENT_TERMS Payment Terms Code

PAYMENT_TYPE Payment Type Code

PRICE_BASIS Price Basis Code

PRICE_IDENTIFIER Price Identifier Code

PROVINCE Province Code

PURCHASE_ORDER_TYPE Purchase Order Type Code

QUALIFIER Qualifier Code

QUANTITY_TYPE Quantity Type Code

RATING CATEGORY Rating Category Code

RECORD_TYPE Record Type Code

REFERENCE_CODE Reference Code

REFERENCE_ID Reference ID

REGION1 Region 1 Code

REGION2 Region 2 Code

REGION3 Region 3 Code

SALES_ORDER_TYPE Sales Order Type Code

SCHEDULE_PURPOSE Schedule Purpose Code

SCHEDULE_TYPE Schedule Type Code

SEGMENT_DESC Segment Description Code
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DescriptionCategory Code

SERVICE_LEVEL Service Level Code

SHIPMENT_METHOD_PAYMENT Shipment Method of Payment Code

SHIPMENT_PRIORITY Shipment Priority Code

SHIPMENT_QUALIFIER Shipment Qualifier Code

SHIPMENT_STATUS Shipment Status Code

SHIP_DELIV_PATTERN Shipment Delivery Pattern Code

SITE_QUALIFIER Site Qualifier Code

SPECIAL_CHARGE_ALLOWANCE Special Charge or Allowance Code

SPECIAL_HANDLING Special Handling Code

SPECIAL_SERVICES Special Services Code

STATE State Code

SUPPLIER_BANK_ACCOUNT Supplier Bank Account Code

SUPPLIER_BANK_ACCOUNT_TYPE Supplier Bank Account Type Code

SUPPLIER_BANK_BRANCH Supplier Bank Branch Code

SUPPLIER_BANK_BRANCH_ID Supplier Bank Branch ID Code

SUPPLIER_BANK_BRANCH_TYPE Supplier Bank Branch Type Code

SUPPLIER_BANK_LOCATION Supplier Bank Location Code

SUPPLIER_BANK_ORG Supplier Bank Org Code

SUPPLIER_BANK_SITE Supplier Bank Site Code

SUPPLIER_CODE Supplier Code

SUPPLIER_ITEM Supplier Item Code

SUPPLIER_LOCATION_CODE Supplier Location Code (such as EDI Location Code)

SUPPLIER_NAME Supplier Name Code

SUPPLIER_NUMBER Supplier Number Code

SUPPLIER_ORG Supplier Organization Code

SUPPLIER_SCHEDULING_DESCRIPTOR Supplier Scheduling Descriptor Code
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DescriptionCategory Code

SUPPLIER_SITE Supplier Site Code

SUPPLIER_SITE_ORG Supplier Site Organization Code

TAX_CODE Tax Code

TAX_EXEMPT Tax Exempt Code

TAX_EXEMPT_REASON Tax Exempt Reason Code

TAX_JURISDICTION Tax Jurisdiction Code

TAX_NAME Tax Name Code

TERMS Terms Code

TERMS_BASIS_DATE_CODE Terms Basis Date Code

TERMS DUE DATE QUALIFIER Terms Due Date Qualifier

TERMS_TYPE Terms Type Code

TERRITORY Territory Code

TRADING_PARTNER Trading Partner Code

TRANSPORTATION_TERMS Transportation Terms Code

TRANSPORTATION_TERMS_QUALIFIER Transportation Terms Qualifier Code

UNIT_PRICE_BASIS Basis of Unit Price Code

UOM Unit of Measure Code

UPC Uniform Product Code (UPC) Code

VESSEL_REQUIREMENT Vessel Requirement Code

WAREHOUSE_CODE Warehouse Code

WAREHOUSE_LOCATION_CODE Warehouse Location Code

WAREHOUSE_NAME Warehouse Name Code

WAREHOUSE_NUMBER Warehouse Number Code

WAREHOUSE_ORG Warehouse Organization Code

WAREHOUSE_SITE Warehouse Site Code
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DescriptionCategory Code

WAREHOUSE_SITE_ORG Warehouse Site Organization

WAYBILL REQUEST Waybill Request Code
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XML Gateway
Supported Actions

his appendix provides a summary of the supported actions.
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XML Gateway Supported Actions

The following is a list of XML Gateway supported Actions.  For the
map analysis process, identify the required Action. For detailed
descriptions of each Action and instructions on how to define an
Action see Transaction Map –Actions: page 3 – 64.

Action Category Action Description

Assignments Assign variable value
Create global value

Database Functions Assign next sequence value
Append where clause
Insert into database table

Derivations Derive Address ID from Location Code
Derive Parent ID from Location Code

Function Call Execute function and assign function return value

Math Functions Add
Divide
Multiply
Subtract

OAG Standard Conversions Convert Oracle date to OAG date format
Convert Oracle operating amount to OAG operating
amount format
Convert Oracle quantity to OAG quantity format
Convert Oracle amount to OAG amount format
Convert OAG date to Oracle date format
Convert OAG operating amount to Oracle operating
amount
Convert OAG quantity to Oracle quantity format
Convert OAG amount to Oracle amount format

Other Exit program

Predefined Variable Get predefined variable value:
Code Conversion Return Status for (a specific
element)
Internal Control Number
Return Code
Return Message
Receiver Trading Partner ID
Sender Trading Partner ID
Organization ID

Procedure Call Execute procedure with send and return parameters

Return Error Message Send error message to trading partner or XML Gateway
system administrator contact
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Action DescriptionAction Category

String Functions Perform Concatenate
Perform Substring

XSLT Transformation Execute procedure to perform XSLT

Each ACTION may be based on a condition.   A condition consists of
two operands stated as a literal value or a variable.  If a condition is
defined, the ACTION is executed if the condition result is true. The
condition operators supported by XML Gateway are as follows:

Operator Description

null Null

not null Not Null

= Equal

!= Not Equal

< Less Than

> Greater Than

<= Less Than or Equal To

>= Greater Than or Equal To

Note:  Do not attempt to perform date comparisons unless
your dates are stated as Julian dates. Use database functions to
compare dates instead.
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XML Gateway Naming
Conventions Summary

his appendix summarizes the XML Gateway naming conventions.
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XML Gateway Naming Conventions Summary

There are several areas where naming conventions are defined to
facilitate recognition of data.  They are:

Message Designer

• Message Map Names

See Specify a Map Name: page 3 – 24.

• Data Definition Names

See Select/Create a Source/Target Data Definition: page 3 – 26.

• XGM File Names

See Transaction Map – Element Mapping: page 3 – 60.

Setup Forms

• Transaction Type and Transaction Subtype

See Define Transactions Form: page 4 – 12.

• External Transaction Type and External Transaction Subtype

See Define Transactions Form: page 4 – 12.

Processing

• Business Events

See Integrating Oracle XML Gateway with Oracle Workflow
Business Event System: page 7 – 2.
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Oracle Transport Agent

his appendix describes the Oracle Transport Agent.
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Oracle Transport Agent

The Transport Agent is responsible for delivery of messages via the
following protocols: HTTP, HTTPS, and SMTP (e–mail, outbound only).
The message transport method is included in the Trading Partner
Definition and the Hub Definition forms.

Oracle Transport Agent is a messaging platform that enables messages
to be sent  via HTTP, HTTPS and SMTP.  Oracle Transport Agent Server
is a Java–based servlet that uses the OTA messaging protocol on top of
the HTTP Application protocol to support the following requirements:

• Exact once delivery of a message over HTTP(S)

• A complete audit and history tracking of messages sent and
received

• Support outbound e–mail delivery of messages (SMTP)

• Support server certificate authentication (when using SSL mode)

• Provide built–in Application user authentication to Oracle
e–Business Suite and Oracle Exchange

Oracle Transport Agent uses Apache as the web listener for inbound
messages, Java Servlet Engine (JServ) to dispatch to a Java Virtual
Machine (JVM)  running the classes that will receive inbound messages
and enqueue them.  The same JVM will serve both inbound requests, as
well as outbound posts.

Oracle AQ serves as the queue for inbound and outbound messages.
The Oracle Transport Agent (OTA) servlet accesses the AQ queues
using standard SQL over Java Data Base Connectivity (JDBC).

Refer to the Oracle White Paper ”Understanding the Oracle
Transport Agent Messaging Protocol” and Configuring
Oracle Gateway Transport Agent (OTA) 1.0 for Oracle
Applications for more information.
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Glossary

Application–to–Application (A2A)  A type of
data exchange between ERP application
modules within your enterprise, such as
Oracle Inventory to Oracle General Ledger.

Business–to–Business (B2B)  A type of data
exchange between Oracle e–Business Suite
and a trading partner (for example, sending
a purchase order or receiving an invoice
from your supplier).

Document Type Definition (DTD)  The
statement of rules for an XML document
that specifies which elements (markup tags)
and attributes (values associated with the
tag) are allowed in your document.

Enterprise Application Integration (EAI)  A
type of data exchange between ERP
applications both within and outside your
your enterprise.  An inter–enterprise
example is Oracle Inventory
communicating with Oracle General
Ledger.  An intra–enterprise example is the
Oracle e–Business Suite communicating
with a legacy or other disparate system.

XML – Extensible Markup Language  A
system for defining, validating, and sharing
document formats.

XML Parser  A process that validates whether
an XML message is well–formed.  The
parser can optionally validate the XML
message against its DTD rules.  The XML
parser is a component of Oracle 8i.

XML Schema   A description of the data
model that defines the elements (for
objects), their attributes (for example, data
types), and the relationships between the
different elements.

XSL – Extensible Stylesheet Language 
Defines the specification for an XML
document’s presentation and appearance.

XSLT – XSL Transformation   An XSL
conversion tool that provides a set of rules
to convert documents described by one set
of tags to documents described by another
set of tags.
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Index
A
Actions, 3 – 64

append where clause, 3 – 76
assign next sequence value, 3 – 76
assign variable value, 3 – 74
convert from OAG amount, 3 – 95
convert from OAG datetime, 3 – 90
convert from OAG OPERAMT, 3 – 92
convert from OAG quantity, 3 – 93
convert to OAG amount, 3 – 89
convert to OAG datetime, 3 – 84
convert to OAG OPERAMT, 3 – 85
convert to OAG quantity, 3 – 87
create global variable, 3 – 75
derive target address ID from location code,

3 – 79
derive target parent ID from location code, 

3 – 81
execute function call, 3 – 82
execute procedure, 3 – 100
exit program, 3 – 96
get predefined variable value, 3 – 97
insert into database table, 3 – 79
math functions, 3 – 83
perform concatenation, 3 – 105
perform substring, 3 – 106
send error message, 3 – 104
XSLT transformation, 3 – 107

Add Child Button, 3 – 9
Add Sibling Button, 3 – 9

APIs, how to map to, 3 – 112
Application–to–Application, example, 7 – 10
Architecture, diagram, 1 – 4
ATTRIBUTE3, in dynamic routing, 4 – 37
ATTRIBUTE3 Field, 4 – 33

B
Business–to–Business, example, 7 – 10
Buttons, Message Designer, 3 – 9
Buttons, Message Designer Wizards, 3 – 17

C
Code Conversion, 4 – 40

inbound transaction table access, 4 – 46
one to multiple external codes, 4 – 48
outbound transaction table access, 4 – 45
Standard Code Conversion Form, 4 – 48
Trading Partner Code Conversion Form, 

4 – 52
Code Conversion Values

key access, 4 – 44
order of table search, 4 – 44

Conditional Node Mapping, 3 – 49
Confirmation Business Object Document

inbound, 3 – 113
outbound, 3 – 114

Consume XML Document Function, 7 – 11
Cross–Reference Transaction Identifiers, 4 – 12
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Custom Messages, considerations for, 2 – 26

D
Data Definition Creation Steps, specify data

definition name and type, 3 – 17
Default Error Process, 7 – 35
Define Look Values, 4 – 21
Define System Profile Values, 4 – 3
Define Transactions Form, 4 – 12
Define UTL_FILE_DIR Parameter, 4 – 5
Define XML Gateway Responsibility, 4 – 4
Define XML Standards Form, 4 – 10
Delete Button, 3 – 9
Document Confirmation, 4 – 32
Document Levels

collapsing levels, 2 – 21
expanding levels, 2 – 23
identifying source and target, 2 – 21

DTDs
how to extend, 3 – 109
loading, 3 – 118

Dynamic Routing, 4 – 37

E
E–Business Suite Application Module–Specific

Item Type, 7 – 7
ECX Engine Notification Process, 7 – 36
ECX Event Message (FYI), 7 – 44
ECX Event Notification (FYI), 7 – 38
ECX External Event Message (FYI), 7 – 44
ECX External Event Notification, 7 – 38
ECX Main Error Process, 7 – 31
ECX Main Inbound Error Process, 7 – 32
ECX Main Outbound Error Process, 7 – 33
ECX Reprocess Inbound Function, 7 – 40
ECX Resend Outbound Message Function, 

7 – 41
ECX_DOCLOGS table, 7 – 29, 7 – 33, 7 – 41
EDI Transactions, compared to XML messages,

1 – 11

Element Mapping, 3 – 60
applying actions, 3 – 63
icons, 3 – 62

Element Mapping Guidelines, 3 – 61
Envelope, components of, 5 – 6
Error Handling for Inbound Messages, 7 – 32
Error Handling for Outbound Messages, 7 – 34
Error Handling Processes, 7 – 29

relationship, 7 – 30
Events

XML Gateway Error Processing Item Type, 
7 – 43

Receive Error, 7 – 43
Receive Send Notification, 7 – 43

XML Gateway Standard Item Type, 7 – 25
Raise Document Delivery Event, 7 – 25

Execution Engine
functions, 1 – 10
process flow, 5 – 2
required setup, 5 – 3
trading partner validation for inbound

messages, 5 – 10
trading partner validation for outbound

messages, 5 – 14
Execution Engine Processing Sequence, 3 – 65

F
File Menu Properties Option, data definition

file properties, 3 – 5
Forms

Define Lookup Values, 4 – 21
Define Transactions, 4 – 12
Define XML Standards, 4 – 10
Hub Definitions, 4 – 7
Standard Code Conversion, 4 – 48
Trading Partner Code Conversion, 4 – 52
Trading Partner Setup, 4 – 24

Functions
XML Gateway Error Processing Item Type, 

7 – 40
ECX Reprocess Inbound, 7 – 40
ECX Resend Outbound Message, 7 – 41
Get ECX In Error Details, 7 – 41
Get ECX Out Error Details, 7 – 41
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Get System Administrator Role, 7 – 42
Get Trading Partner Role, 7 – 42

XML Gateway Standard Item Type, 7 – 9
Consume XML Document, 7 – 11
Generate Trading Partner XML Document,

7 – 16
Generate XML Document, 7 – 13
Send Document, 7 – 19
Transaction Delivery Required, 7 – 21

G
Generate Trading Partner XML Document, 

7 – 16
Generate XML Document Function, 7 – 13
Get ECX In Error Details Function, 7 – 41
Get ECX Out Error Details Function, 7 – 41
Get System Administrator Role Function, 

7 – 42
Get Trading Partner Role Function, 7 – 42

H
Hub Definitions Form, 4 – 7
Hub Entity Code, 4 – 8

I
Implementation Checklist, 4 – 2
Inbound Trading Partner Message, 7 – 45
Item Type, components of, 7 – 5
Item Types

E–Business Suite Application
Module–Specific Item Type, 7 – 7

XML Gateway Error Processing Item Type, 
7 – 6

XML Gateway Standard Item Type, 7 – 5, 
7 – 8

L
Level Mapping Guidelines

collapsing levels, 3 – 57
expanding levels, 3 – 58
OAG DTDs, 3 – 57

Level Mapping Tab, 3 – 56
Lookup Types

XML Gateway Error Processing Item Type
ECX Inbound Error Actions, 7 – 47
ECX Outbound Error Actions, 7 – 47
ECX Outbound Error Types, 7 – 48

XML Gateway Standard Item Type, send
mode, 7 – 28

M
Map Action Editor

action level and action stage combinations, 
3 – 70

invoking, 3 – 67
Map Analysis Guidelines

inbound messages, 2 – 12
outbound messages, 2 – 3

Menus, Message Designer, 3 – 2
file menu, 3 – 2

properties option, 3 – 4
help menu, 3 – 4
view menu, 3 – 3

Message Maps, loading, 3 – 118
Messages, XML Gateway Error Processing

Item Type, 7 – 43
ECX Event Message (FYI), 7 – 44
ECX External Event Message (FYI), 7 – 44
Inbound Trading Partner Message, 7 – 45
message template attributes, 7 – 45
Outbound Trading Partner Message, 7 – 45

Multi–Org Consideration, 4 – 24

N
Naming Conventions, transaction type and

transaction subtype, 4 – 16
Notifications, XML Gateway Error Processing

Item Type, 7 – 38
ECX Event Notification (FYI), 7 – 38
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ECX External Event Notification, 7 – 38
Trading Partner Inbound Error Notification,

7 – 39
Trading Partner Outbound Error

Notification, 7 – 39
Noun, setting in OAG standards, 4 – 19

O
OAG, recommending changes, 2 – 25
Outbound Trading Partner Message, 7 – 45

P
Pass–Through Messages, 5 – 11

how to map, 3 – 111
Processes, XML Gateway Error Processing

Item Type, 7 – 29
Properties Menu Option, 3 – 4

transaction map file properties, 3 – 6

Q
Queues

definition, 6 – 2
error, 6 – 4
inbound message, 6 – 3
inbound transaction, 6 – 4
outbound message, 6 – 3
used by XML Gateway, 6 – 2

R
Raise Document Delivery Event, 7 – 25
Receive Error Event, 7 – 43
Receive Send Notification Event, 7 – 43
Reprocess, 7 – 29
Retry, 7 – 29, 7 – 41
Routing, 4 – 32

dynamic, 4 – 37
static, 4 – 36
static and dynamic, 4 – 33

Rule Function, Workflow Default, 7 – 2 to 7 – 4
Rule Function, XML Gateway, 7 – 2 to 7 – 4

S
Send Document Function, 7 – 19
Source Definition Overview, 3 – 43
Source Definition Tab, 3 – 44
Standard Code Conversion Form, 4 – 48
Static and Dynamic Routing, 4 – 33
Static Routing, 4 – 36

T
Target Definition, 3 – 50
Target Definition Tab, 3 – 52
Toolbar, Message Designer, 3 – 8
Trading Partner Code Conversion Form, 4 – 52
Trading Partner Inbound Error Notification, 

7 – 39
Trading Partner Outbound Error Notification,

7 – 39
Trading Partner Setup Form, 4 – 24

data validation, 5 – 12
Trading Partner Validation

inbound messages, 5 – 10
outbound messages, 5 – 14

Transaction Delivery Required Function, 7 – 21

V
Verb, setting in OAG standards, 4 – 19

W
Workflow Builder

components of an item type, 7 – 5
E–Business Suite Application

Module–Specific Item Type, 7 – 7
item types, 7 – 5
XML Gateway Error Processing Item Type, 

7 – 6
XML Gateway Standard Item Type, 7 – 5, 

7 – 8
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X
XML Gateway Error Processing Item Type, 

7 – 6, 7 – 29
events, 7 – 43

Receive Error, 7 – 43
Receive Send Notification, 7 – 43

functions, 7 – 40
ECX Reprocess Inbound, 7 – 40
ECX Resend Outbound Message, 7 – 41
Get ECX In Error Details, 7 – 41
Get ECX Out Error Details, 7 – 41
Get System Administrator Role, 7 – 42
Get Trading Partner Role, 7 – 42

lookup types, 7 – 46
ECX Inbound Error Actions, 7 – 47
ECX Outbound Error Actions, 7 – 47
ECX Outbound Error Types, 7 – 48

message template attributes, 7 – 45
messages, 7 – 43

ECX Event Message (FYI), 7 – 44
ECX External Event Message (FYI), 7 – 44
Inbound Trading Partner Message, 7 – 45
Outbound Trading Partner Message, 7 – 45

notifications, 7 – 38
ECX Event Notification (FYI), 7 – 38
ECX External Event Notification, 7 – 38
Trading Partner Inbound Error

Notification, 7 – 39
Trading Partner Outbound Error

Notification, 7 – 39
processes

Default Error Process, 7 – 35
ECX Engine Notification Process, 7 – 36
ECX Main Error Process, 7 – 31
ECX Main Inbound Error Process, 7 – 32
ECX Main Outbound Error Process, 7 – 33
Error Handling for Inbound Messages, 

7 – 32
Error Handling for Outbound Messages, 

7 – 34
XML Gateway Standard Item Type, 7 – 5, 7 – 8

events, 7 – 25
Raise Document Delivery Event, 7 – 25

functions, 7 – 9
lookup types, 7 – 27

send mode, 7 – 28
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Reader’s Comment Form

Oracle XML Gateway User’s Guide, Release 11i
A90250–01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness
of this publication.  Your input is an important part of the information we use for revision.

• Did you find any errors?

• Is the information clearly presented?

• Do you need more information?  If so, where?

• Are the examples correct?  Do you need more examples?

• What features did you like most about this manual?  What did you like least about it?

If you find any errors or have any other suggestions for improvement, please indicate the topic, chapter,
and page number below:

Please send your comments to:

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
Phone: (650) 506–7000     Fax: (650) 506–7200

If you would like a reply, please give your name, address, and telephone number below:

Thank you for helping us improve our documentation.
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